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This section provides supporting information for the Oracle Financial Services Insurance IFRS
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*  Abbreviations
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Prerequisites for the Audience
Following are the prerequisites for administrators installing OFS Insurance IFRS 17 Analyzer:

This document assumes that you have experience in installing Enterprise components and basic
knowledge about the following are recommended:

e OFS Insurance IFRS 17 Analyzer components
»  OFSAA Architecture

*  UNIX Commands

» Database Concepts

*  Web Server/ Web Application Server
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1

About OFSAA and OFSAA Application Packs

This chapter includes the following topics:

» About Oracle Financial Services Analytical Applications (OFSAA)

» About Oracle Financial Services Analytical Applications (OFSAA) Application Packs
»  About Oracle Financial Services Insurance IFRS 17 Analyzer Application Pack

» About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)

About Oracle Financial Services Analytical Applications

(OFSAA)

In today's turbulent markets, financial institutions require a better understanding of their
risk-return, while strengthening competitive advantage and enhancing long-term customer
value. Oracle Financial Services Analytical Applications (OFSAA) enable financial institutions
to measure and meet risk-adjusted performance objectives, cultivate a risk management culture
through transparency, lower the costs of compliance and regulation, and improve insight into
customer behavior.

OFSAA uses industry-leading analytical methods, shared data models, and applications
architecture to enable integrated risk management, performance management, customer insight,
and compliance management. OFSAA actively incorporates risk into decision making, enables
to achieve a consistent view of performance, promote a transparent risk management culture,
and provide pervasive intelligence.

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of
financial services analytical applications for both banking and insurance domains.

About Oracle Financial Services Analytical Applications
(OFSAA) Application Packs

The following figure depicts the various application packs that are available across the OFSAA
Banking and Insurance domains:

About OFSAA and OFSAA Application Packs 1-1



About Oracle Financial Services Insurance IFRS 17 Analyzer Application Pack

Figure 1-1 OFSAA Application Packs
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About Oracle Financial Services Insurance IFRS 17 Analyzer
Application Pack
OFS I1A Pack includes the following applications:

e Oracle Financial Services Insurance IFRS 17 Analyzer: IFRS17 is an international
norm that supersedes the current reporting standards, IFRS 4. The new standards provide
the users of financial statements with a new perspective of the financial accounts of
insurance companies.

IFRS 17 requires Insurance companies to have consistent accounting standards for the
Insurance contracts which ensures timely recognition of losses in the book of accounts.

1-2 OFS Insurance IFRS 17 Analyzer Installation and Configuration Guide



About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)

Insurance companies are required to identify and report the Fulfillment Cash Flows and
Contractual Service Margin at every reporting date, based on the current market
conditions. Oracle Financial Services Insurance IFRS 17 Analyzer application helps the
organizations in arriving at the insurance obligations (Insurance Contract liabilities
reported on the balance sheet), using different methodologies for a set of portfolios, by
assessing the net liability for every insurance contract.

About Oracle Financial Services Analytical Applications
Infrastructure (OFS AAI)

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle
Financial Services Analytical Applications family of products to perform the processing,
categorizing, selection and manipulation of data and information required to analyze,
understand and report on specific performance, risk, compliance and customer insight issues by
providing a strong foundation for the entire family of Oracle Financial Services Analytical
Applications across the domains of Risk, Performance, Compliance and Customer Insight.

Components of OFSAAI

o Rl e T ot in

Framework

The OFSAA Infrastructure includes frameworks that operate on and with the Oracle Financial
Services Analytical Applications Data Model and forms the array of components within the
Infrastructure.

The OFSAA Infrastructure components/ frameworks are installed as two layers; primarily the
metadata server and Infrastructure services run on one layer, and the Ul and presentation logic
runs on the other. The Ul and presentation layer is deployed on any of the supported J2EE
Servers.

The following figure depicts the various frameworks and capabilities that make up the OFSAA
Infrastructure:

Figure 1-2 Components of OFSAAI
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About Oracle Financial Services Analytical Applications Infrastructure (OFS AAl)

OFSAA Infrastructure High Availability

The current release of the OFSAA Infrastructure supports only the "Single Instance™
installation for the Infrastructure components. However, the High Availability (HA) for the
Database Server and/ or the Web Application Server clustering and deployment is supported in
this release. This release supports the Active-Passive model of implementation for OFSAAI
components. For more information, see Configuration for High Availability- Best Practices
Guide.

About Data Security Configurations

Data Security refers to the protection of data against unauthorized access and data theft.
OFSAA ensures Data Security with the following features:

Multi-Factor Authentication
Transparent Data Encryption (TDE)
Data Redaction

Key Management

HTTPS

CSRF

Logging

For more details on the features in the previous list, see the relevant topics in this guide and the
Data Security and Data Privacy section in the Administration and Configuration Guide.
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Understanding OFS Insurance IFRS 17
Analyzer Pack Installation

This chapter includes the following topics:
» Installation Overview

e Deployment Topology

» Hardware and Software Requirements
»  Verifying System Environment

*  Understanding the Installation Modes

Installation Overview

This release of the OFS Insurance IFRS 17 Analyzer Application Pack (also referred to as 1A
in this document) bundles the upgrade patch set along with the base installer.
Users/Administrators who wish to install a new OFS Insurance IFRS 17 Analyzer Application
Pack 8.0.6.0.0 instance should download this installer. The following figure depicts the order of
procedures required to follow to install a new OFS 1A Pack 8.0.6.0.0 instance.
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Installation Overview

Figure 2-1 Installation Overview

Start
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Done

Table 2-1 provides additional information and links to the specific documentation for each task
in the flowchart.
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Hardware and Software Requirements

Table 2-1 OFS IIA Application Pack Installation Tasks and Descriptions

Tasks

Details and Documentation

Verify Systems Environment

Obtain the software
Configure and Execute the
Schema Creator Utility

Install OFS IIA Pack

Configure OFS I1A Pack

To verify that your system meets the minimum requirements for
installing and hosting the OFSAA Application Pack, see Verifying
System Environment.

To access and download the OFSAA Application Pack, see Obtaining
the Software.

To create the database schemas, see Configuring and Executing the
Schema Creator Utility.

To install the OFS I1A Application Pack, see Installing the OFS 1A
Application Pack.

To configure the OFS 11A Application Pack post-installation, see Post
Installation Configuration.

Deployment Topology

The following figure depicts the logical architecture implemented for the OFS 11A Application

Pack.

Figure 2-2 Deployment Topology
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Hardware and Software Requirements

This section describes the various Operating Systems, Database, Web Server, and Web
Application Server versions, and other variant details on which this release of the OFS 1A
Application Pack has been qualified.
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Hardware and Software Requirements

Note:

OFS 1A Application Pack installation can be performed on both Virtual and Physical
Servers.

The following tables show the minimum hardware and software requirements for installing
OFS I1A Application Pack:

Configurations supported for Java 8

Table 2-2 Configurations Supported for Java 8

Operating System

Oracle Linux / Red Hat *  Red Hat Enterprise Linux or Oracle Linux Server release 6
Enterprise Linux (x86-64 bit) updates 6 and above

*  Red Hat Enterprise Linux or Oracle Linux Server release 7
updates 1 and above

Shell «  KORN Shell (KSH)

Note:

. If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small,
configure the size parameter setting for “Large File Support”. Follow these steps:

Change the file size limit for the user that initiates the transfer on the AlX system. To change the
file size limit for a particular user, add or edit the fsize attribute for the user in the
[etc/security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or
size equal to the size of the file being transferred. This may require a restart of the AIX server to
pick up the new configuration. For more information refer to IBM Support.

»  Ifthe operating system is RHEL, install the package Isb_release using one of the following
commands by logging in as root user:

e yum install redhat-Isb-core

yum install redhat-1sb

Java Runtime Environment

Oracle Linux / Red Hat e Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit
Enterprise Linux

Oracle Database Server and Client

»  Oracle Database Server Enterprise Edition 12c Release 2 (12.2.0.1.0 +) - 64 bit RAC/ Non-RAC
with/ without partitioning option, Advanced Security Option**.

e Oracle Client 12c Release 2 (12.2.0.1.0+) - 64 bit
e Oracle 12C Release 2 (12.2.0.1+) JDBC driver (Oracle thin driver)

OLAP

Note: Oracle Hyperion Esshase is required only if you are using the OLAP feature of OFSAAL.

Web Server/ Web Application Server

Oracle Linux / Red Hat Apache Tomcat 8.5.0 (64 bit)
Enterprise Linux / 1BM AIX Oracle Weblogic Server 12.2.x with jersey 2.25 (64 bit)

OFS 1A application is compatible with WebLogic 12.2.x and does not
support WebLogic 12.1.3. If the WebLogic version is 12.1.3, upgrade
to WebLogic 12.2.x.
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Hardware and Software Requirements

Table 2-2 (Cont.) Configurations Supported for Java 8

Note:

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is
not supported.

Desktop Requirements

Operating SystemOFS <> Microsoft Windows 7/Windows 8 /Windows 10
application is compatible with
WebLogic 12.2.x and does not
support WebLogic 12.1.3. If
the WebLogic version is
12.1.3, upgrade to WebLogic
12.2.x.

Browser *  Microsoft Internet Browser 11.x
. Chrome 57.x
*  Firefox 52.x

Turn on Pop-up blocker settings. For more information, see
Configuring Internet Explorer Settings.

Office Tools *  MS Office 2007/2010/2013
*  Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280*1024

Other Software

Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and Oracle
Internet Directory v 11.1.1.3.0. However, it can be integrated with
other directory services software such as MS Active Directory.

Note:

»  Configuration of Directory services software for OFSAAI installation is optional. For more
information on configuration, see Setting Infrastructure LDAP Configuration.

e Open LDAP must be installed on the MS Windows Server machine.

Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, refer
Appendix P.

To configure the Oracle Database 19c¢ Server and Client on a
new installation, see MOS Doc ID: 2691006.1.

Following table provides the recommended software combinations for OFS 11A Applications
Pack deployment

Table 2-3 Recommended Software Combinations

Web Application

Operating System | Database Server Web Server

Oracle Linux 6/7 Oracle Database Oracle WebLogic Apache HTTP Server
Server/Apache Tomcat
Server
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Verifying System Environment

Verifying System Environment

To verify your system environment meets the minimum requirements for the installation, a
Pre-Install Check utility is available within the Install Kit archive file. This utility can also be
obtained separately by contacting Oracle Support.

Though the system environment verification is an integral and automated part of the installation
of this software product, Oracle strongly recommends running this utility before beginning the
installation as part of your organization's “Installation Readiness Verification Process”.

Note: For more details on download and usage of this utility, see Oracle
Financial Services Analytical Applications Infrastructure Environment Check
Utility Guide is given in the Related Documents section.

Understanding the Installation Modes
The following modes of installation are available for the OFS 11A Applications Pack.
e Installing in GUI Mode
e Installing in SILENT Mode

Installing in GUI Mode

This mode launches the product installation in a Graphical User Interface (GUI) mode. you
must enter the required information on various windows within the Ul in a user interactive
format at various stages.

Note: For more information on configuration required for GUI mode
installation, see Configuration for GUI Mode Installation.

Installing in SILENT Mode

This mode mandates updating the installation configuration files with required details and
installs in a “Silent” non-user interactive format.
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Preparing for Installation

This chapter provides the necessary information to review before installing the OFS 1A
v8.0.6.0.0. This chapter includes the following topics:

» Installer and Installation Prerequisites
»  Obtaining the Software

»  Performing Common Installation Tasks

Installer and Installation Prerequisites

Table 3-1 provides the list of prerequisites required before beginning the installation for the
OFS I1A application. The Installer/ Environment Check Utility notifies you if any requirements
are not met.
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Installer and Installation Prerequisites

Table 3-1 Prerequisite Information

Category Sub-Category Expected Value
Environment Java Settings *  PATH variable in the .profile file must be set to
Settings include the Java Runtime Environment absolute

path. The path should include the Java version (7 or
8) based on the configuration.

Note:

»  Ensure that the absolute path to JRE/bin is set at the
beginning of the PATH variable.
For example,
PATH=/usr/java/jrel.7/bin:$ORACLE_
HOME/bin:$PATH

e JAVA_HOME variable must be set in .profile file,
pointing to the appropriate Java Runtime
Environment Path.

For example, export JAVA_
HOME-=/usr/jdk/instances/jdk1.6.0

. Ensure that SYMBOLIC links to JAVA installation
are not set in the PATH variable.

»  Ensure that you set the Heap Size in .profile file,
using the following command:
export _JAVA_OPTIONS=""-Xms512m
-Xmx1024m**
Heap size is a validation to get the memory size for
Model Upload. If the Heap size is less than the ten
times as of the Model, then it returns an error.

Oracle Database Oracle Database Server

Settings *  TNS_ADMIN variable must be set in .profile file
pointing to appropriate tnsnames.ora file.

»  Enable Transparent Data Encryption (TDE) and/ or
Data Redaction**.

** Note: For more information, see Configuring
Transparent Data Encryption (TDE) and Data
Redaction in OFSAA.

Oracle Processing Server

*  ORACLE_HOME must be set in .profile file
pointing to appropriate Oracle DB Client
installation.

e PATH in .profile must be set to include appropriate
$ORACLE_HOME/bin path.

*  Ensure that an entry (with SID/SERVICE NAME) is
added in the tnsnames.ora file.

Oracle Essbase ARBORPATH, ESSBASEPATH, and HYPERION_
Settings HOME variables must be set in the .profile file,
pointing to an appropriate Oracle Esshase Client
installation.
Note:

These settings are required only if you want to use Oracle
Hyperion Esshbase OLAP features.
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Installer and Installation Prerequisites

Table 3-1 (Cont.) Prerequisite Information

Category

Sub-Category

Expected Value

OS/ File System
Settings

File Descriptor
Settings

*  Greater than 15000

Note: The value specified here is the minimum value to
be set for the installation process to go forward. For other
modules, this value may depend on the available
resources and the number of processes executed in
parallel.

Total Number of
Process Settings

. Greater than 4096

Note: The value specified here is the minimum value to
be set for the installation process to go forward. For other
modules, this value may depend on the available
resources and the number of processes executed in
parallel.

Port Settings

e Default port numbers to be enabled on the system
are 6500, 6501, 6505, 6507, 6509, 6510, 6666,
9999, and 10101.

.profile e User to have 755 permission on the .profile file.
permissions

Installation »  Adirectory where the product files will be installed.
Directory

e Assign 755 permission to this directory.
e This directory needs to be set as FIC_HOME.

Temporary Directory

Default temporary directory where installation files are
stored for a short period to support faster installation.

»  Forinstallation on UNIX OS, your UNIX
administrator must give you the required read-write
permissions for the /tmp directory and disable the
NOEXEC option.

*  Configure adequate space on the /tmp directory. It is
recommended that you allocate more than 10 GB of
space.

Note: If NOEXEC is enabled, the extraction of files by
the installer into the /tmp directory is prevented and the
binaries will not execute in the directory, which will fail
the installation.

Staging Area/
Metadata Repository

e Adirectory to hold the application metadata artifacts
and additionally act as a staging area for flat files.

e The directory should exist on the same system as the
OFSAA Installation. This directory can be
configured on a different mount or under a different
user profile. However, the owner of the installation
directory that is mentioned in the previous row, must
have RWX permissions on this folder.

e Assign 777 permission to this directory.

Note: This directory is also referred to as FTPSHARE
folder.

Download Directory

A directory where the product installer files will be
downloaded/ copied.

e Set 755 permission on this directory.

OS Locale

e Linux: en_US.utf8

e AIX:EN_US.UTF-8

e Solaris: en_US.UTF-8

To check the locale installed, execute the following
command:

locale -a | grep -i .en_usﬁﬁeparing for Installation  3-13




Installer and Installation Prerequisites

Table 3-1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value

Database Settings Database Instance e NLS_CHARACTERSET to be AL32UTF8
Settings «  NLS_LENGTH_SEMANTICS to be BYTE
OPEN CURSORS limit to be greater than 1000

Web Application WebLogic/Tomcat »  Web Application Server should be installed and the
Server profile or domain created.

e You will be prompted to enter the WebLogic
Domain path or Tomcat Deployment path during
OFSAAI installation.

Note:

See Configuring Web Server section for WebLogic
Domain Creation.

For deployment on Oracle WebLogic Server 12.1.3+ (64
bit) with Java 8, download and install patch 18729264
from http://support.oracle.com/.

Web Server Apache HTTP This is an optional requirement. HTTP Server Installation
Server/ Oracle to be present. You are prompted to enter the Web Server
HTTP Server/ IP/Hostname and Port details during installation.

IBM HTTP Server Note: See Configuring Web Server section for Web
Server installation.

OFS AAI One-off Download the following one-off patches from
http://support.oracle.com/:

e 28033370

The following step is applicable only if the existing OFSAA setup version is 8.0.5.x.x and
Configuration and Atomic Schema(s) were restored from exported dumps of other
environments:

Log in to Configuration Schema and execute the following SQL statements:

alter table AAI_AOM_APP_COMP_ATTR_MAPPING drop constraint AOM_
APP_COMP_ATTR_PK drop index

/

alter table AAI_AOM_APP_COMP_ATTR_MAPPING add constraint AOM_
APP_COMP_ATTR_PK primary key (APP_COMP_ATTR_MAP_ID)

/

Note: Ensure that the tablespace(s) used for the database user(s) is set to
AUTOEXTEND ON.

OFS I1A Application pack v8.0.6.0.0 installer download contains only the ERwin XML file that
is required for uploading the model. This file is sufficient to install the v8.0.6.0.0 Application
pack. However, this XML file cannot be opened in the ERwin Data modeler tool and hence
cannot be used for any data model customization. ERwin file is delivered as a patch and needs
to be downloaded separately. This ERwin file should be used for any customization of the data
model. To download the Data Model Erwin file, log in to https://support.oracle.com/ and search
for 26278531 under the Patches & Updates tab. If customization to the data model has been
done in the environment being upgraded, then before uploading the same, customizations need
to be applied again in the merged data model.
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Performing Common Installation Tasks

Obtaining the Software

The 8.0.6.0.0 release of OFS I1A Application Pack can be downloaded from My Oracle
Support (https://support.oracle.com/). You must have a valid Oracle account to download the
software.

Performing Common Installation Tasks

The common pre-installation activities that you must carry out before installing the OFS 1A
application pack are the following:

Configuration for GUI Mode Installation

Identifying the Installation, Download, and Metadata Repository Directories
Downloading and Copying the OFS I1A Applications Pack Installer
Extracting the Software

Setting Up the Web Application Server

Configuration for GUI Mode Installation

To install OFS I1A Application Pack in GUI mode, you need to ensure the below software and
configurations are available:

Install and configure any PC X Server software such as Open Text Exceed (formerly
Hummingbird Exceed) on the user desktop system from which the installation is triggered.

Configure the DISPLAY variable.

Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed,
to point to the user desktop system where the PC X Server software is installed.

Syntax:
export DISPLAY=hostname:n.nl

where hostname is the IP Address/ Host Name of the user desktop system
and n is the sequence number (usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Identifying the Installation, Download, and Metadata Repository

Directories

To install OFSAA Application Packs, create the following directories.

OFSAA Download Directory (Optional): Create a download directory and copy the
OFSAA Application Pack Installer File (archive). This is the directory where the
downloaded installer/ patches can be copied.

OFSAA Installation Directory (Mandatory): Create an installation directory where the
product binaries will be installed. Set the variable FIC_HOME in the .profile file to point
to the OFSAA Installation Directory.

OFSAA Staging/Metadata Directory (Mandatory): Create a Staging/Metadata
Repository Directory to copy data files, save data extracts, and so on. Additionally, this
directory also maintains the OFSAA metadata artifacts. This directory is also referred to as
"FTPSHARE". This directory must be created on the same host as the OFSAA Installation
Directory mentioned in the previous point in this list.
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Performing Common Installation Tasks

Note:
» Assign 755 user permission to the Installation Directory.

e Assign 775 user permission to the Staging Directory.

«  Ensure the OFSAA staging directory is not set to the same path as the OFSAA
installation directory and is not a sub-folder inside the OFSAA installation
directory.

Downloading and Copying the OFS IIA Applications Pack Installer
To download and copy the OFS 1A Applications Pack Installer, follow these steps:

e Todownload the OFS I1A Applications Pack, login to My Oracle Support
(https://support.oracle.com/). You need to have a valid Oracle account to download the
software.

e Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the
setup identified for OFS A installation.

» Download the mandatory installer one-off patch 28398331 from http://support.oracle.com/.

Extracting the Software

Once you obtain the installer, copy the installer (in BINARY maode) to the system on which the
OFSAA Infrastructure components will be installed.

Note: You must be logged in to the UNIX operating system as a non-root
user.

1. Download the unzip utility (OS-specific) unzip_<os>.Z and copy it in Binary mode to the
directory that is included in your PATH variable. If you already have the unzip utility to
extract the contents of the downloaded archive, skip this step.

2. Uncompress the unzip installer file using the command:

uncompress unzip_<os>.Z

Note: If an error message “uncompress: not found [No such file or
directory]” is displayed, contact your UNIX administrator.

3. Assign EXECUTE (751) permission to the file using the command:
chmod 751 unzip_<0S>
For example, chmod 751 unzip_sparc

4. Extract the contents of the OFS 11 A Application Pack 8.0.6.0.0 installer archive file in the
download directory with the following command:

unzip OFS_IIA_PACK.zip

5. Extract and apply the patch 28398331. Refer to the Readme.txt file packaged with the
patch for details on how to apply the patch.

6. Navigate to the download directory and assign execute (750) permission to the installer
folder with the following command:
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chmod -R 750 OFS_IIA_PACK

Setting Up the Web Application Server

For setting up the environment based on your selected Web Application Server, see
Configuring Web Server section.
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Installing the OFS IIA Application Pack

This chapter provides instructions to install the OFS 1A pack.
This chapter includes the following sections:

» About Schema Creator Utility

»  Configuring and Executing the Schema Creator Utility

» Installing the OFS 11A Application Pack

Note: The Schema Creator job needs to be run first if you are doing OFS
1A 8.0.6.0.0 fresh installation on an existing pack. This will append the new
artifacts in the existing instance.

About Schema Creator Utility

Creating database users/schemas is one of the primary steps in the complete OFS 1A
installation process. Schema Creator utility facilitates you to quickly get started with the
installation by creating Database User(s)/Schema(s), assigning the necessary GRANT(s),
creating the required entities in the schemas, and so on.

The schema creator utility must be configured and executed before the installation of any OFS
I1A Application Pack.

This section includes the following topics:
e About Schema Creator Utility
»  Selecting Execution Modes in Schema Creator Utility

»  Selecting Execution Options in Schema Creator Utility

About Schema Creator Utility

The schema creator utility should be configured and executed mandatorily every time before
the installation of any OFSAA Application Pack.

The following are the types of schemas that can be configured in the OFSAA:

» CONFIG - Denotes the unique OFSAA setup configuration schema. It contains entities
and other objects required for OFSAA setup information.

Note: There can be only one CONFIG schema per OFSAA instance.
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About Schema Creator Utility

« ATOMIC - Denotes the schema that contains the data model entities. One ATOMIC
schema is attached to one Information Domain.

Note:  There can be multiple ATOMIC schemas per OFSAA Instance if you have
multiple application packs being installed.

« SANDBOX - Denotes the schema that contains the data for all Sandbox executions. One
SANDBOX schema is attached to one Sandbox Information Domain.

Note: There can be multiple SANDBOX schemas per OFSAA Instance.

Selecting Execution Modes in Schema Creator Utility

Schema creator utility supports the following two modes of execution:
«  Online Mode: In this mode, the utility connects to the database and executes the Data
Definition

e Language (DDL) for User, Objects, and Grants. If you have the SYSDBA privileges you
can execute the Schema Creator Utility in Online mode and create Users, Objects, and
Grants during the execution process.

Note: To execute the utility in Online mode, you must connect as “<User>
AS SYSDBA”

«  Offline Mode: In this mode, the utility generates a SQL script with all the required DDLs
for User, Objects, and GRANTS. This script must be executed by the DBA on the
appropriate database identified for OFSAA usage. If you do not have SYSDBA privileges,
you can execute the Schema Creator Utility in Offline mode and generate the script file
that contains the Schemas, Objects, and GRANTS information. Subsequently, an SYSDBA
user must execute the script file manually.

Note: :

1. To execute the utility in Offline mode, you need to connect as any user with the
following grants (alternatively, you can also connect as a user with SYSDBA
privileges):

* SELECT ON DBA_ROLES

» SELECT ON DBA_USERS

» SELECT ON DBA_DIRECTORIES
» SELECT ON DBA_TABLESPACES
» CREATE SESSION

2. Ifthere are any errors during the script execution, reconfigure the OFS_T1A_
SCHEMA_IN. XML file and execute the utility. This regenerates the scripts with
corrected information.

For more information, see Configuring OFS_IIA_SCHEMA_IN.XML File.

3. Do not modify the OFS_ 1 IA_SCHEMA_OUT . XML file generated after the
execution of this utility.
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Selecting Execution Options in Schema Creator Utility

Depending on the option selected to run the OFSAA Application Pack Installer, you must select
the appropriate schema creator utility execution option. To run the OFSAA Application Pack
installer in Silent mode, it is mandatory to execute the schema creator utility with -s option.

Note: If the schema creator utility is executed without the option -s, it is
mandatory to run the OFSAA Application Pack Installer in GUI mode.

Configuring and Executing the Schema Creator Utility

This section includes the following topics:

Prerequisites

Prerequisites
Configuring the Schema Creator Utility
Executing the Schema Creator Utility

The prerequisites you must have before configuring the Schema Creator Utility are the
following:

Oracle User ID/Password with SYSDBA privileges.
JDBC Connection URL for RAC or Non-RAC database.
HOSTNAME/IP of the server on which OFSAA is being installed.

For enabling Transparent Data Encryption (TDE) in your OFSAA instance during
installation, perform the steps explained in the Configuring Transparent Data Encryption
(TDE) and Data Redaction in OFSAA.

Configuring the Schema Creator Utility
This section explains the steps to configure the Schema Creator Utility.

To configure the Schema Creator Utility, follow these steps:

1.

2
3.
4

Log in to the system as a non-root user.
Navigate to the following path: OFS_ITA_PACK/schema_creator/conf directory.
Edit the OFS_I1A_SCHEMA_IN.xml file in a text editor.

Configure the elements as described in the section Configuring OFS_IIA_SCHEMA _
IN.XML File.

Save the OFS_IIA_ SCHEMA_IN.xml file.

Note: On successful execution of the utility, the entered passwords in the
OFS_IIA_SCHEMA_IN.xml file is nullified.

Executing the Schema Creator Utility

You can execute the schema creator utility in Online or Offline mode. This section includes the
following topics:

Executing the Schema Creator Utility in Online Mode
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Executing the Schema Creator Utility in Offline Mode
Executing the Schema Creator Utility with -s Option

Executing the Schema Creator Utility while Installing Subsequent Applications Pack

Executing the Schema Creator Utility in Online Mode

In Online mode, the Schema Creator Utility creates all the Schemas, Schema Objects,
Tablespaces, Grants, and Roles in the database during the execution process.

To execute the Schema Creator Utility in Online mode, follow these steps:

1.
2.
3.

N oo o &

Log in to the system as a non-root user.
Navigate to the following path: OFS_IIA_PACK/schema_creator/bin/
Execute the osc. sh file using the following command:

./osc.sh
The following message is displayed:

You have chosen ONLINE mode. Triggering the utility in ONLINE mode will execute the
DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n).

Enter Y/ y to proceed with the script generation.

Enter the DB user name with SYSDBA Privileges. For example SYS as SYSDBA.
Enter the User Password.

The console runs the initial validation checks and then displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic
Schema>ATOMIC schema. Do you want to proceed? (Y/N).

Enter Y/y to proceed with the schema creation.
The following message is displayed.

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want
to proceed? (Y/N).

Figure 4-1 Schema Creation - Online Mode
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9. Enter Yly to start the schema creation.

Note:

»  On successful execution of schema creator utility, the console displays
the following status message:
Schema Creator executed successfully. Please proceed with the installation.

* See log file in OFS_IIA_PACK/schema_creator/logs directory for
execution status. If there are any errors, contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode

In Offline Mode, the Schema Creator Utility creates output in the SQL file format. This script
must be executed manually by logging as a database user with SYSDBA privileges. The SQL
file contains the creation of Schemas, Schema Objects, Tablespaces, Grants, and Roles.

Prerequisites:

To execute the utility in Offline mode, you must connect a database user with the following
grants (alternatively, you can also connect as a user with SYSDBA privileges):

i SELECT ON DBA_ROLES
i SELECT ON DBA_USERS
i SELECT ON DBA_DIRECTORIES
i SELECT ON DBA_TABLESPACES

e CREATE SESSION

Note: Explicit Grants to the user are required. Grants assigned through
Roles are not supported.

To execute the schema creator utility in Offline mode, follow these steps:
1. Log in to the system as a non-root user.
2. Navigate to the OFS_IIA_PACK/schema_creator/bin directory.
3. Execute the osc.sh file using the following command:
./osc.sh -o -s
4. The following message is displayed:

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate
the script. Do you wish to proceed? (Y/y or N/n).

5. EnterY /y to generate the script.
6. Enter the DB user name with SELECT privileges.

7. Enter the User Password.
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Figure 4-2 Schema Creation - Offline Mode

8. The console runs the initial validation checks and displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic
Schema>ATOMIC schema. Do you want to proceed? (Y/N).

9. Enter Yly to start the script generation.
The following message is displayed.

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want
to proceed? (Y/N)

Figure 4-3 Schema Creation - Offline Mode

10. Enter Y/y to start the script generation.
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Figure 4-4 Schema Creator Utility - Offline

11.

12.
13.

On successful execution of schema creator utility, the console displays the following status
message:

Schema Creator executed successfully. Please execute scratch/ofsaaapp/OFS_IA
PACK/schema_creator/sysdba_output_scripts.sql before proceeding with the installation.

Navigate to the directory:
OFS_IIA PACK/schema_creator
Log in to SQLPLUS with a user having SYSDBA Privileges.

Connect to the Oracle DB Server on which the Application Pack installation is to be
performed and execute the sysdba_output_scripts.sql file using the following command:

SQL>@sysdba_output_scripts.sqgl

Alternatively, you can copy the sysdba_output_scripts.sqgl file and SQLScripts directory
to a remote server and execute the sysdba_output_scripts.sql file.

Note: See log sysdba_output_scripts.log file for execution status. If
there are any errors, contact Oracle Support. If there are no errors in the
execution, the log file is empty.

Installing the OFS IIA Application Pack 4-25



Configuring and Executing the Schema Creator Utility

Executing the Schema Creator Utility with -s Option

If you intend to run the OFS I1A Application Pack Installer in Silent mode, it is mandatory to
execute the schema creator utility with -s option.

To execute the utility with -s option, follow these steps:

1. Editthe file OFS_IIA_ PACK/schema_creator/conf/OFS_IIA_SCHEMA_ IN.xml inthe
text editor.

2. Execute the utility with -s option.

For example . /osc.sh -s.

Figure 4-5 Schema Creator Utility with -s Option

Note:

e Ifthe utility is executed without the -s option, it is mandatory to launch the
OFSAA Applications Pack Installer in GUI mode.

»  To execute the utility in OFFLINE mode with the SILENT option, enter the
following command
./osc.sh -0 -s

3. Make a TNS entry for the new users created. For details, see Adding TNS entries in the
TNSNAMES.ORA File section.

Figure 4-6 Schema Creator Utility with -s Option

Executing the Schema Creator Utility while Installing Subsequent
Applications Pack

While executing the schema creator utility for subsequent Applications Pack, you can choose to
install the pack either on the same Information Domain/Atomic Schema or on a new
Information Domain/Atomic Schema. You can execute the Schema Creator Utility either in
Online or Offline Mode.

To execute the schema creator utility while installing OFS 11A Application Pack over an
existing Application Pack, follow these steps:

1. Repeat the steps 1 to 9 from the Executing the Schema Creator Utility section.
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Note: Ensure to use the same config schema user name as the previous
Application Pack.

2. The utility identifies the Application Packs that are already installed on the current OFSAA
setup and displays the following on the console:

«  Atomic schema of the Existing Application Pack
« Information Domain Name of the Existing Pack
«  List of Installed Application Packs
3. Enter Yly to start the schema creation.
If you enter N/n, the list of Atomic Users is displayed.
4. Select the Atomic User, on which you want to install the Application Pack.

5. Make a TNS entry for the new users created. For details, see Adding TNS entries in the
TNSNAMES.ORA File section.

On successful execution of schema creator utility, the console displays the following status
message:

Success. Please proceed with the installation.

Note:

e Referlog file in OFS_IIA_PACK/schema_creator/logs folder for execution
status.

e Refer log sysdba_output_scripts.log file for execution status, if executed in
offline mode. This log would be empty if there are no errors in the execution.

¢ Incase of any errors, contact Oracle Support.

Installing the OFS IIA Application Pack

This section provides instructions to install the OFS 11A Application Pack depending on the
mode of installation.

This section includes the following topics:
e Installing in SILENT Mode

« Installing in GUI Mode

«  Verifying the Log File

Installing in SILENT Mode

In the SILENT Mode Installation, you must configure the product XML files and follow
instructions in the command prompt.

To install OFS 1A in SILENT mode, follow these steps:
1. Log in to the system as a non-root user.
2. ldentify a directory for installation and set the same in the user .profile file as follows:

FIC_HOME=<OFSAA Installation Directory>
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export FIC_HOME
3. Execute the user .profile.
4. Navigate to OFS_ITIA_PACK directory.

5. (Applicable only for OEL) Perform this step, if you are installing this (8.0.6.0.0) release
of OFS 1A Application Pack on an existing instance where other OFSAA Application
Pack(s) are already installed and if the release number of those applications is NOT
8.0.6.0.0 or higher. If ANY of these OFSAA Application Pack(s) in this instance are
already on release 8.0.6.0.0 or higher, ignore this step and proceed with the next steps.

Note: You can verify the release number of already installed OFSAA
Application Pack(s) by querying the table INFODOM_PATCHES, from
CONFIG schema.

Copy the files atomic_8.0.6.0.0.sql and config_8.0.6.0.0.sql from the location <OFS_IIA _
PACK>/OFS_AAAI_PACK/SQLScripts/ to the location <OFS_IIA_PACK>/schema_
creator/SQLScripts, before proceeding with next steps.

6. Editthe OFS_IIA_PACK/conf/OFS_IIA_PACK.xml to enable the product licenses.

Note: <Ensure to enter Yes in ENABLE tag for OFS_AAI/APP_ID to install the
1A application.

«  See Configuring OFS_IIA_PACK.xml File for details on configuring this XML
file.

7. Editthe OFS_IIA_PACK/schema_creator/conf/OFS_IIA_SCHEMA_IN.xml file to set
the appropriate attribute values.

Include INFODOM = "<Infodom Name>" in OFS_ I 1A_SCHEMA IN.xml file

Note: <Refer Configuring OFS_IIA_SCHEMA_IN.XML File for details on
configuring this XML file.

»  Ensure to make a TNS entry for the new users created. For details, see Adding
TNS entries in the TNSNAMES.ORA File section.

8. Editthe OFS_IIA_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml file to set the
appropriate infrastructure installation attribute values.

Note: See Configuring OFSAAI_InstallConfig.xml file for details on
configuring this XML file.

9. Execute the schema creator utility.
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Note:

»  This step is mandatory and should be executed before every OFSAA
Application Pack installation.

»  Ensure to execute with -s option in Online/ Offline Mode.

»  For more information, see Executing the Schema Creator Utility.

10. Create a copy of the Silent.template file present in the installer folder OFS_I1A
PACK/OFS_I1IA/conf and rename it as Silent.props.

11. Edit the file Silent.props and specify the parameters as per the requirements.

SILENT installation is achieved via a properties file (Silent.props) that must be updated
with proper values, before attempting to install using the silent mode. The following table
lists all the properties that need to be specified.

Note:

e The values of Application and sources (ETL_APP_1 NAME, ETL _
SRC_1 1 NAME, and ETL_SRC_1 2 NAME) in silent.props file
should be the same in both OFS ALM (if installed) and OFS IIA.

Elements in Silent.props file

Table 4-1
Permissible
Property Name Description of Property Values Comments
LOG_MODE Specify Log Mode 1 = Debug Password will be printed in the
Mode log file
0= General Default is GENERAL
Mode
SEGMENT_1_ Specify the Common Segment  User Input
CODE for IA.
SEGMENT_2_ Specify the Transitional Matrix  User Input
CODE Segment Code
APPFTP_LOG_ Specify the Infodom User Input Do not ignore this property if
PATH Maintenance log path (existing the installation is being
or new) for the Infodom. performed on an existing
If new Infodom, the log path information domain.
will be created accordingly.
DBFTP_LOG_PATH Specify the Infodom User Input Do not ignore this property if

Maintenance log path (existing
or new) for the Infodom.

If new Infodom, the log path
will be created accordingly.

the installation is being
performed on an existing
information domain.

Installing the OFS IIA Application Pack 4-29



Installing the OFS IIA Application Pack

Table 4-1
Permissible
Property Name Description of Property Values Comments
UPLOAD_MODEL  Specify whether you wantto 0 =If you
perform Model Upload. have already
performed
Model Upload
and want to
skip the model
upload
process.
1=Ifyou
want to
perform
Model
Upload.
MODEL_TYPE Specify whether you want to #0 = If you
use the released data model or  want to upload
customized data model for the  the released
model upload process data model.
#1 =If you
want to upload
the
customized
data model.
DATAMODEL Specify the path (DM_ User Input
DIRECTORY) and file
DM_DIRECTORY (b ATAMODEL) name for the
customized data model.
Mandatory only if you want to
upload the customized data
model, that is you have
specified MODEL_TYPE=1.
OBI_HOST Specify the Host Name of the  User Input This field should NOT be left
OBIEE Server blank. If OBIEE is not
configured at the moment,
ensure that you provide
dummy value in this field.
OBI_PORT Specify the Port Number of the  User Input This field should NOT be left
OBIEE Server blank. If OBIEE is not
configured at the moment,
ensure that you provide
dummy value in this field.
OBI_CONTEXT Specify the Context Name of  User Input This field should NOT be left
the OBIEE Server blank. If OBIEE is not
configured at the moment,
ensure that you provide
dummy value in this field.
ETL_APPSRC_ Specify if you want to createa 0 =If you
TYPE new ETL App/Src pair or use  want to create
an existing one. anew ETL
app/src pair.
1=Ifyou
want to use an
existing pair
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Table 4-1
Permissible
Property Name Description of Property Values Comments
ETL_APP_1_DESC ETL IIA Application User Input Describe the ETL App/Src
description pair.

ETL_SRC_ 1 1_
DESC

ETL_SRC_1 2_
DESC

ETL_APP_1 NAME

ETL_ SRC_ 1 1_
NAME

ETL_SRC_1 2_
NAME

FV_SEGMENT

FV_APPSERVER_
FTP_LOGPATH

ETL Processing source
description

ETL Processing source
description

ETL FSAPPS Application
name

ETL Staging source name

ETL Processing source name

Specify the name of the
Segment for Fair Value
sandbox infodom

Specify the sandbox
Maintenance log path (to be
created) for the Fair Value
sandbox.

User Input

User Input

User Input

User Input

User Input

User Input

User Input

Mandatory if you want to
create a new ETL app/src pair.
That is, you have specified
ETL_APPSRC_TYPE=0.

Describe the ETL App/Src
pair.

Mandatory if you want to
create a new ETL app/src pair.
That is if you have specified
ETL_APPSRC_TYPE=0.

Describe the ETL App/Src
pair.

Mandatory if you want to
create a new ETL app/src pair.
i.e you have specified ETL _
APPSRC_TYPE=0

Specify the ETL Application
and Source Name into ETL
Area Definitions will be
deployed.

The value of this element in
silent.props file should be
the same in both OFS ALM
(if installed) and OFS I1A.

Specify the ETL Application
and Source Name into ETL
Area Definitions will be
deployed.

The value of this element in
silent.props file should be
the same in both OFS ALM
(if installed) and OFS IIA.

Specify the ETL Application
and Source Name into ETL
Area Definitions will be
deployed.

The value of this element in
silent.props file should be
the same in both OFS ALM
(if installed) and OFS IIA.
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Table 4-1
Permissible

Property Name Description of Property Values Comments
FV_DBSERVER_ Specify the sandbox User Input
FTP_LOGPATH Maintenance log path (to be

created) for the Fair Value

sandbox
HISTIRC_ Specify the name of the User Input
SEGMENT Segment for Historical Interest

Rates sandbox infodom
HISTIRC_ Specify the sandbox User Input
APPSERVER_FTP_ Maintenance log path (to be
LOGPATH created) for the Historical

Interest Rates sandbox.
HISTIRC_ Specify the sandbox User Input
DBSERVER_FTP_  Maintenance log path (to be
LOGPATH created) for the Historical

Interest Rates sandbox.
FCSTIRC_ Specify the name of the User Input
SEGMENT Segment for Forecast Interest

Rates sandbox infodom
FCSTIRC_ Specify the sandbox User Input
APPSERVER_FTP_ Maintenance log path (to be
LOGPATH created) for the Forecast

Interest Rates sandbox.
FCSTIRC_ Specify the sandbox User Input
DBSERVER_FTP_  Maintenance log path (to be
LOGPATH created) for the Forecast

Interest Rates sandbox.

12. Give a path for the installation log file in log4j.xml in OFS_IIA_PACK/OFS_Il1A/conf
location.

13. Navigate to OFS_IIA_PACK/bin/ directory, on the successful execution of the schema creator
utility.

14. Enter the following command in the console to execute the application pack installer with
the Silent option.

./setup.sh SILENT
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Figure 4-7 Silent Mode Installation

15. Enter the OFSAA Processing Tier FTP/SFTP password value, when prompted at the
command prompt

Figure 4-8 Silent Mode Installation
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Table 4-2 Console Prompts - Silent Mode installation

Console Prompts User Inputs

Please enter OFSAA Enter the password to access the processing tier directory in the
Processing Tier FTP/SFTP application server.

password

Note: In case the prompt reads as follows, enter the username/
password for accessing the product Staging/ Metadata Repository
FTPSHARE.

e Kerberos username [user]

e Kerberos password for user

16. Enter Always, when prompted to add host key fingerprint.
The OFSAAI License Agreement is displayed.

17. Enter Y/y to accept the License Agreement.

Note: The installation process continues on the console. Do not close the
console until the installation process is complete.

Once the platform is installed, it proceeds for the 1A PACK installation. After successful
I1A pack installation, the WAR file is generated and all the servers are verified.

18. The following message is displayed in the console:

Installation completed...
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19.

20.

21.

22.

23.

24.

On completion of the installation, see the installation log files.

For more information, see Verifying the Log File.

Install the OFS AAI 8.0.6.1.0 ML 28033370. Refer to the Readme available with the patch
for further instructions on installing the patch.

Replace the contents of the file RevLog4jConfig.xml with the contents of the file
RevLog4jConfig.xml_8061bkp. These files are present in the $FIC_WEB_
HOME/webroot/conf folder.

Update the “partition by” tag of the following script file with the necessary partition
values and execute them.

iia_create_table_partitions.sql
This script file is available in the folder OFSAHOME/scripts_ OFS_Il1A/atomic/create.

Install the one-off patch 25343603, if OFSAA is deployed on Oracle WebLogic Server
version 12.2.x. Refer to the Readme available with the patch for further instructions on
installing the patch.

Perform the steps mentioned in the Post Installation Configuration section.
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25. For enabling Transparent Data Encryption (TDE), see Configuring Transparent Data
Encryption (TDE) and Data Redaction in OFSAA section.

26. For enabling Data Redaction, see the Data Redaction section under Data Security and Data
Privacy chapter in OFS Analytical Applications Infrastructure Administration Guide
8.0.6.0.0.

Installing in GUI Mode

Note: 1.GUI mode of installation is supported only on the RDBMS database server.
For HDFS support of the installation, see section Installing in Silent Mode

2. Ensure that you have followed the steps as mentioned in the Configuration for
GUI Mode Installation section before proceeding with the next steps.

1. Log in to the system as a non-root user.

2. ldentify a directory for installation and set the same in the user .profile file like the
following:

FIC_HOME=<OFSAA Installation Directory>
export FIC_HOME
3. Execute the user .profile file.

4. Navigate to OFS_IIA_PACK directory.

5. (Applicable only for OEL) Perform this step, if you are installing this (8.0.6.0.0) release
of OFS I1A Application Pack on an existing instance where other OFSAA Application
Pack(s) are already installed and if the release number of those applications is NOT
8.0.6.0.0 or higher. If ANY of these OFSAA Application Pack(s) in this instance are
already on release 8.0.6.0.0 or higher, ignore this step and proceed with the next steps.

Note: You can verify the release number of already installed OFSAA
Application Pack(s) by querying the table INFODOM_PATCHES, from
CONFIG schema.

Copy the files atomic_8.0.6.0.0.sql and config_8.0.6.0.0.sgl from the location <OFS_IIA _
PACK>/OFS_AAAI_PACK/SQLScripts/ to the location <OFS_IIA_PACK>/schema_
creator/SQLScripts, before proceeding with next steps.

6. Editthe OFS_IIA PACK/schema_creator/conf/OFS_IIA SCHEMA_ IN.xml file to set
the appropriate attribute values.

Note: See Configuring OFS_IIA_SCHEMA_IN.XML File for details on
configuring this XML file.

7. Navigate to the path <OFS_IIA_PACK>/schema_creator/bin in the console and execute
the schema creator utility.

Note: This step is mandatory and should be executed before every OFSAA
Application Pack installation.

See Executing the Schema Creator Utility for more details.
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8. Navigate to OFS_IIA_PACK/bin directory.
9. Execute the following command in the console.

./setup.sh GUI

Note: Refer the console for any errors during Pre-install checks.

Figure 4-9 Initialization Window

Welcome to the OFSAA 8.0.6 Application Pack
Installation

ORACLE’
FINANCIAL SERVICES

Copyright @ 1993, 2018, Oracle and/or its affiliates. All rights reserved.

10. The general License Agreement is displayed.
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Figure 4-10 License Agreement

Welcome to the OFSAA Application Pack Installation

(2 Preinstall Setup This program will guide you through the installation of OFSAA Apglication Pack,

(O Installation
Copyright @ 1993, 2018, Oracle and [ or its affiliates. Al rights reserved
(D) Install Complete
This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual
property laws, Except as expresshy permitted in vour license agreement or allowed by law, vou may not use, copy, reproduce, translate, broadcast, modify, license,
transmit, distrigute, exhibit, perform, publish or display amy part, in amy form, or by any means. Reverse engineering, disassembly, or decompilation of this
software, unless required by law for interoperability, is prohigited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please repart them to us in writing.

If this software or related documentation is delfvered 10 the LS. Government or amyone licensing it on behalf of the LS. Gowernment, the following notice is
applicable:

1.5, GOVERNMENT END USERS: Oracle programs, including any operating systern, imegrated software, any programs installed on the harchware, and/or
documentation, delivered to LS. Government end users are "commercial computer software” pursuant to the applicable Federal Acguisition Regulation and
agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system,
integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the
programs. Mo other rights are granted to the LS. Government.

This software or hardware is deweloped for general use in a wariety of information management applications. It is not developed or intended for use in amy
inherently dangerous applications, including applications that may create a risk of personal injury. If vou use this software or hardware in dangerous applications,
then you shall be responsitle to take all approgriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates
disclaim ary liability for any damages caused by use of this software or hardware in dangerous applications.

This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and
its affiliates are not responsible for and expresshy disclaim all warranties of any kind with respect to third-party content, products, and senvices. Oracle Corporation
and its affiliates will not be responsible for any loss, costs, or darmages incurred due 10 your access 10 or use of third-party content, groducts, or services

ORACLE
FIANCILSERVIES

) | acceptthe terms of the License Agreement

@) | do NOT acceptthe terms of the License Agreement

e

11. Select I accept the terms of the License Agreement option.
12. Click Next.

The Financial Services Insurance IFRS 17 Analyzer Application Pack Details window is
displayed.
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Figure 4-11 OFS IIA Applications Pack Details

Oracle Insurance IFRS 17 Analyzer Pack

& Prelnsiall Setup
D Installation
(0) Install Complete

ORACLE
FAANCALSERVCES

Application Pack ID : OFS_IIA_PACK ORACI_E. -
Application Pack Name : Oracle Insurance IFRS 17 Analyzer Pack m
ANALYTICAL APPLICATIONS

Application Pack Version:  $.0.6.0.0

The following products are available in this application pack:

Financial Services Analytical Applications Infrastructure

[v] Oracle Insurance IFRS 17 Analyzer|

Motes:

1. Zelect the productis) you have licensed and click "Mext”to proceed.
2. Product Analytical Applications Infrastructure does not need to be selected explicithy. This product is the base infrastructure and gets installed automatically.

3. Product Enterprise Modeling Optionwould get enabled f installed automatically if other product(s) has dependent license.

13. Select the product(s) for which you have already obtained the license(s).
14. Click Next.

The Application Pack - License Agreement window is displayed.

Installing the OFS IIA Application Pack 4-39



Installing the OFS IIA Application Pack

Figure 4-12 Application Pack License Agreement page

Oracle Insurance IFRS 17 Analyzer Pack License Agreement

Installation and use of Oracle Insurance IFRS 17 Analyzer Pack Installer requires acceptance of the following license
S Prelnstall Setup OFsAL APPLICATION PACK LICENSE AGREEMENT
(O Installation..

(O Install Complete Oracle Financial Senvices Anakdical Applications (OFSA& application packs are groups of OFSAA products packaged together into a single installer. Each agplication
pack containg OFSAA applications that address specific functional domains

Ewery application pack also includes the following OFSAA infrastructure application options which are automatically installect by every application pack installer:
1. Oratle Financial Senvces Anakical Applications Infrastructure

2. Oracle Financial Serdces Enterprise Modeling

2. Oracle Financial Services In-line Processing Engine

4. Oracle Financial Services Big Data Processing
Oracle Financial Sendces Anahtical Applications Infrastructure (OFS AAJ) is the base infrastructure for all OFSAA applications and is therefore automatically installed
and enabled by the application pack installer,

The application pack installer always installs Oracle Financial Services Enterprise Modeling, Oracle Financial Serdces In-line Processing Engine and Oracle Financial
Services Big Dara Processing application options along with the application pack applications, but enables them only it any apglication that reguires their functionality
is enabled.

Any OFSA4 application that is enabled must be licensed for use. Oracle Financial Senvices Anahtical Applications Infrastructure, Oracle Financial Services Enterprise
Modeling, Oracle Financial Services In-line Processing Engine and Oracle Financial Services Big Data Processing are indiidually licensable application options.

Application products once enabled cannot ke disabled. Application products not enablec on installation, may later be enabled using the "Manage OFSAA Product
License(s)" feature of the platform.

ORACLE
FNANCAL SERVCES

() L acceptthe terms of the License Agreement

(@) | do NOT accept the terms of the License Agresment

15. Select | accept the terms of the License Agreement option.
16. Click Next.

The Pre-Installation Summary window is displayed.
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Figure 4-13 Pre-Installation Summary

Pre Installation Summary

Please reyiew the following before continuing:

&) Prelnstall Setup
(3 Installation. Application Pack ID
OFS_[1A_PACK
(O Install Complete
Application Pack Name

Oracle Insurance IFRS 17 Analyzer Pack

Application Pack Version
3.0.6.00

Below products are selected to be enabled:

Financial Services Analytical Applications Infrastructure
Qracle Insurance IFRS 17 Analyzer

ORACLE
FNANCILSERCE

17. Click Next.

The Manage Information Domains window is displayed.
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Figure 4-14 Manage Information Domains page

Manage Information Domains

¥, Information Domain Nami Application Name Information Domain Description Type DB Schema
& Prelnstall Setup Oracle Insurance IFRS 17 Information Domain for OFS_IlA
(O Installation OFSIAINFO Analyzer PRODUCTION fiaofsaaatmé

() Install Complete

ORACLE
FNACAL ERVCES

18. The default Information Domain Name for this Application Pack is OFSIIAINFO.

Double-click the Information Domain Name field to edit.

Note: For subsequent Application Pack installation on the same
Information Domain, the Information Domain Name is not editable.

Permissible length is 16 characters and only alphanumeric characters are
allowed. No special characters are allowed.

19. Click Next.

The User Installation Directory window is displayed.
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Figure 4-15 User Installation Directory

User Installation Directory

£ License User Installation Directory
3 Prelnstall Setup fscratch/ofsaebasfIFR517

) Installation
) Install Complete

ORACLE’
FINANCIAL SERVICES

[nstallarman

Note: The User Installation Directory path is auto-populated from the path
you have set in the user .profile file in Step 2.

20. Click Next.

The OFSAA Infrastructure Server Details window is displayed.
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Figure 4-16 OFSAA Infrastructure Server Details

OF5AA Infrastructure Server Details

License Enter requested information ;

} Prelnstall Setup
(D Installation Bate: If the |DBC_UEL is of RAC tyioe then DB Server IPfHostnhame
N field name should be MA
() Install Complete

OF5AAl Server IP / Hostname ;
|10.184.133.165

Database Server IP / Hosthame :
|10.184.154.12

ORACLE’
FINANCIAL SERVICES

21. Enter the IP address or hostname of the Database Server.

Note: The OFSAAI Server IP/Hostname is auto-populated by default.

22. Click Next.
The Web Application Server window is displayed.
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Figure 4-17 Web Application Server

Web Application Server

P License Choose the Wek Application Server tye
# Prelnstall setup

) Installation
) Install Complete

0 Tamcat
® hWebSphere
0 Wehlogic

ORACLE
FINANCIAL SERVICES

23. Select the appropriate Web Application Server. The options are Tomcat and WebLogic.

Note: This release of OFS I1A supports Tomcat and WebL ogic.

24. Click Next. Based on the selection, corresponding windows are displayed.
25. For Tomcat: The Absolute Tomcat Path window is displayed.
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Figure 4-18 Absolute Tomcat Path

Please Wait

Absolute Tomcat Path

& License
¥ Preinstad Setup

Enter absclute Tamcat nstallatian path where Oracle Financial
Services Anaiytical Appicalians Infrastructure 15 1o be
deployed
Example- fMomefdataltomecat.-7.015%webapps

& 2 mament

ORACLE
FINANCIAL SERVICES

ORACLE
FIANCIAL SERVES

a. Enter the Tomcat installation path (till/webapps) where OFSAAI is deployed.
26. For WebL ogic: The WebLogic Home window is displayed.

¢ Enter the WebLogic home directory path.

¢ Enter the path of the Weblogic domain directory and click Next.
27. The OLAP Details window is displayed.
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Figure 4-19

Licenze
=¥ Prelnstall Setup
() Installation,.
) Install Complate

ORACLE’
FINANCIAL SERVICES

OLAP Details

OLAP Details

Mote ;
1 = Enahled 0=Disahled
If walue is 1 then ARBORPATH, HYPERIOM_HOME & ESSBASERATH

wariables should be set in profile before installation.

CONFIGURE OF5AAI OLAP FEATURE :
0

Previous

28. Enter 1 if you want to configure the OFSAA OLAP feature using Oracle Hyperion
Essbase. By default, it is set to 0.

29. Click Next. The Web Server Details window is displayed.
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Figure 4-20 Web Server Details

Web Server Details

b License Maote : Context name will be used in wour Application LREL
=¥ Prelnstall Setup bt f f < WebserverlP > <5Senvet port s f<contexthame = flogin. jso

(3} Installation Example: - http: jf 10 80 .50 206 9080 /myapp/flogin. jsp
ad LI

) Install Complete

[ | EMAELE HTTPS

WEE SERVER PORT
| 9080

WEE SERVER IP
| 10.184.156.159

ORACLE’
FINANCIAL SERVICES Context name for deployment
|Iﬁprun

30. Select the ENABLE HTTPS checkbox to configure HTTPS if required, and enter the
WEBSERVER PORT (HTTP Server) PORT, Context name for deployment, and WEB
LOCAL PATH to any folder on the Web Application Server (Tomcat/WebLogic).

31. Click Next. The Database Details window is displayed.
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Figure 4-21 Database Details

Database Details

f License NOTE:
¥ Pralnstall Setup Specify the Database user name which is the user created for
(@ Installation configuration database schema. For example: configuser

} ’ Specify the Database driver path as <ORACLE_HOME > fidhbc/lik
[ Install Complete where < OFACLE_HOME> should be replaced with OFACLE_HOME

walue.
The ABSOLUTE DEMWEFR. PATH refers to the JDBC driver files path.

ORACLE SID / SERVICE_NAME :
| ORA114DE

JDEC URL:
| jdbcioracle:thin@lo, 184,154 12:152 1 0RAL14DE

: CONFIG SCHEMA USER ID :
ORACLE | dev_linBo6conf

FINANCIAL SERVICES

Oracle Configuration Schema Password
I

Installan

32. Enter Oracle SID or Service Name.

Note:

e« The JDBC URL, CONFIG SCHEMA USER ID, Oracle Configuration Schema
Password, and ABSOLUTE DRIVER PATH fields are auto-populated.

e ABSOLUTE DRIVER PATH can be the path where Oracle DB client is installed

or JDBC driver is installed. For example,
/scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/1ib

33. Click Next. The Ports Configuration window is displayed.
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Figure 4-22 Ports Configuration

Ports Configuration

License Enter required information
¥ Prelnstall setup Mote: Ports must have unigue walue.

=) Installation.
[} Install Complete

Java Port
16001

Mative Port
6002

Agent Port

ORACLE’ fsv02
FINANCIAL SERVICES

ICC Server Port
[

Note: The Java Port, Native Port, Agent Port, ICC Server Port, and ICC
Native Port fields are auto-populated. You can also modify the Ports settings.

34. Click Next. The Ports Configuration window is displayed.

4-50 OFS Insurance IFRS 17 Analyzer Installation and Configuration Guide



Installing the OFS IIA Application Pack

Figure 4-23 Ports Configuration

Ports Configuration

P License Enter requested information :
=¥ Prelnstall Setup Mote: Ports must hawve unigue walue,

) Installation,
() Install Complete

6007

Message Server Port
6008

Router Port
6009

ORACLE’

FINANCIAL SERVICES AM Port
6000

Note: The OLAP Port, Message Server Port, Router Port, and AM Port
fields are auto-populated. You can also configure the Ports settings.

35. Click Next. The SFTP Details window is displayed.
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Figure 4-24 SFTP Details

SFTP Details

CHOOSE FILE TRANSFER PROTOCOL :
® SFTP O FTP

License

¥ Frelnstall setup

(D Installation. FILE TRANSFER PORT :

22

) Install Completa

ORACLE
FINANCIAL SERVICES

Note:

¢ ENABLE SFTP and FILE TRANSFER PORT fields are auto-populated.

«  Ensure that the system, on which the OFSAA Infrastructure is installed, has FTP
or SFTP enabled.

¢ You can also modify the SFTP settings.

36. Click Next. The OFSAAI Post Install Details window is displayed.
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Figure 4-25 OFSAAI FTP/SFTP Details

OFSAAI FTP/SFTP Details

License FTPSHARE PATH
¥ Pralnstall Setup | fecratchfofsaadb fOFSAHOME/ftpshare

(D Installation. Eestore Default
L) Install Complete

FTF / SFTP USER ID
|nfzaadb

Please enter Infrastructure FTP/SFTP password:

ORACLE
FINANCIAL SERVICES

37. Enter the FTPSHARE path. This is the same as the OFSAA Staging/ Metadata directory.
38. Enter the FTP/SFTP User ID and Password for FTPSHARE directory access.

Note: The transfer of data (files) between the OFSAA Server and the Web
Application Server happens through FTP/ SFTP. Ensure the necessary host
configurations are made for a successful handshake. For more details, see
Adding FTP/SFTP Configuration for File Transfer.

39. Click Next. The Pre Installation Summary window is displayed.
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Figure 4-26 Pre Installation Summary

Pre-installation Summary

) License Please review the following before continuing:

=¥ Prelnstall Setup

) Installation, Product Name:

% | e i OFSAAINfrastructure
nstall Complete

Yersion
2.0.6.0.0

Installation Folder
FseratchfofsaebasfIFRS1Y

Required Space
930 MegaBytes

ORACLE Available Space
207395 MeqgaBytes
FINAMNCIAL SERVICES

Selorted | nrale

Prewvious Install

40. Click Install. The Installing OFSAA Infrastructure window is displayed.
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Figure 4-27 Installing OFSAA Infrastructure

Installing OFSAAlInfrastructure

License
Prelnstall Setup
=¥ Installation..
() Install Camplete

O

ORACLE Installation is in progress...
This process may take several minutes. Please Wait.
FINANCIAL SERVICES

Installing... ficweh

Cancel

Note:  Anytime during the installation, you can click Cancel to stop the
installation. Once completed, the INSTALLATION SUMMARY window is
displayed.

41. Once completed, the Installation Summary window is displayed.
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Figure 4-28 INSTALLATION SUMMARY

INSTALLATION SUMMARY

P License IMSTALLATICON SUMMARY:
Prelnstall Setup

£ nstallation. .
=% Install Complete

Flease see the installation log under
fecratchfofsaebasfInstaller/ OF5 _ILA_PACK fOFS_AAlflogs fOFSALIEZ 2
018 _08_24_0&_20_%8.log and
JfscratchfofsaebasfIFES 17 fOFsAaInfrastructure_Install. log for more
details.

Click on Mext to continue,

ORACLE
FINANCIAL SERVICES

The INSTALLATION SUMMARY window displays the number of Fatal Errors, Errors,
Debug Statements, Informations, and Warnings along with the location of log files.

42. Click Next. The Installation Complete window is displayed.
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Figure 4-29 Installation Complete

Installation Complete

f License Congratulations! Oracle Financial Services Anakgical Applications
Prelnstall Setup Infrastructure has been successfully installed.

Installation.. Click an "Dane" to exit the installer. Please do not close the consale.

¥ Install Complete Fost Install activites will bhe performed in console..

ORACLE
FINANCIAL SERVICES

Prewious

43. Click Done. The following message is displayed:

Please wait, pack_install is being configured for your system. This may take a moment.

Figure 4-30 Checking OFSAAI Services

Please Wait

¥ Preinstall Setup
(D installat

Please wait, f E Checking OFSAA Servce our system

ERSSSSSRRNN]

ORACLE
FINNCAL SERVIES

44. The Checking OFSAA Service window is displayed.
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Note: This step verifies the OFSAA services startup. In case of errors
during services check, an appropriate error message is displayed.

45. After checking the OFSAA services, installation proceeds with the OFS 11A Application
Pack Installation.

The Installing Oracle Financial Services Insurance IFRS 17 Analyzer Application Pack
window is displayed.

Figure 4-31 Installing Application Pack

"M, Solution Setup (o= =]

ORACLE
FINANCIAL SERVICES

Copyright ©1933, 2018, Oracle and/or its =ffiliates. All rights reserved.

46. Upon invoking the installer, the Introduction window is displayed with the prerequisites for
installation. Ensure that all the prerequisites are met before you proceed with the
installation.
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Figure 4-32 Installation Introduction

S Introduction This user interface will guide wou through the solution setup.Before proceeding

(@) Pre-Install Configuration with the installation, wou must ensure the following:
i Configur;

(.} Pre-Install Summary - The Oracle Financial Services Anaktical Applications Infrastructure (OFSAAD
() Installing. . must ke installed and configured on the machine.

(D Install Complete - The FICserver is running and all other OFSAAl servers are shut down prior to

start of the solution installation.
- Pleasze ensure the OFSAA wersion is 8.0.6.0.0

Maote: Ab amy point if sau wish to edit previously entered information, wvou may
access the previous screens by clicking on the Prevdous button.

ORACLE

FINANCIAL SERVICES

Previous

47. Click Next. Choose the log mode for this installer. If Debug is selected, the Passwords will
be printed in the log file. If General is selected then the general information will get
printed in the log file.
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P Introcuction Flease select the Log Made required for this Installation.

=¥ Pre-Install Configuration

Mote:

If wou select the Debug mode, the passwords will be printed in
[} Installing the log file. The log file will be written in the path specified in
the logdj. xml file of the installer.

) Pre-Installation Summary

) Past-Install Configuration

() Install Complete
® Debug
(1 General

ORACLE’
FINANCIAL SERVICES

48. Click Next. Segment Creation window is displayed. Enter the Data Management Segment,
Application Server ftpshare log path, and Database server ftpshare log path in the
Information Domain window and click Next.
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Introduction Flease enter the following entries required for new information
= Pre-Install Configuration dormain creation.
) Pre-Installation Summany
[} Installing

) Post-Install Canfiguration

() Install Complete

| IFRSSEG

Historical Transition Matrix Segment
| HTMSEG

Application Server FTPSHARE Logpath
ORACLE" |jStratth,fnfSaadbjOFSMOME,fftpshare,f,fOFSIFRSINFO,fIDQS |

FINANCIAL SERVICES Database Server FTPSHARE Logpath
|jStratth,fnfSaadbjOFSMOME,fftpshare;;OFSlFRSINFO,fIDgs | =

49. Click Next. Pre-Infodom Creation Summary window is displayed.

$ (ntroduction Please Review the Following Eefore Continuing:

Pre-Install Configuration

(L) Pre-Installation Summary Information Domain Name

) DOFSIFRSIMFS
[} Installing.

() Post-Install Configuration Infodom Description
(D Install Complete Information Domain for OFS_IFRS

Application S5chema user
dev_lin80&Gatm

Application Schema JDBEC url
Jdbecioracleithin:@10.154.154,12:1521:
ORALL4DE

ORACLE
Infodom Schema Database name
FINANCIAL SERVICES Gl

[ i
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50. Click Next. The Infodom Creation window is displayed.

Please Wait

B Pre-install Configueatio

D Pre.

wing configured for bké 3 moment,
ke a momant

-!i Creatng Infasam
EEERRERNEREERY

ORACLE
FINANGIAL SERVICES

ORACLE
FIANCIAL SERVIES

51. Enter the Tablespace name in the Pre-Setup Information window and click Next.

d Introduction Please specify the Tablespace name (nfodom database)
= Pre-Install Configuration Mame | USERS

() Pre-installation Summary

(@ Installing..

() Past-Install Configuration

) Install Complete

ORACLE’
FINANCIAL SERVICES

52. Enter the DB Name for Infodom Database, Application Schema User name, Application
Schema Password, and Application Schema JDBC URL for Fair Value Sandbox. Click
Next.
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Please Wait

= Premstall Setup

& intraductian Please enter the folawing entries requred for new
@ Fremstall Configuration infermation domain for Fas Vake Sandbox.

@ Pre-installaton Summa
) Installing
¥ Post-install Confiqueati

DB Hama for Infodom -
ofsashzldl

Ak & momant

ien Schema user name
afsashaldl

Application Schema password

ORACLE
FINANCIAL SERVICES

Application Schema JOBC UAL

ORACLE
FIVANCAL SERVES

53. Enter the Infodom name, Infodom Description, Segment Name, and Application Server
ftpshare log path for Fair Value Sandbox. Click Next.

Please Wait

H Prednstall Setup
5 instalia

" FPlease enter the following infarmations to create a new
& Pre-install Configuratio infermation demain for Fair Value Sandbox

Infodam name

OFSSRXFY bke o moment,,,

Infa

ORACLE
FINANCIAL SERVICES

ORACLE
FIANCAL SERVCES

54. Verify the details and click Next. The Pre-Installation window is displayed.

Installing the OFS IIA Application Pack 4-63



Installing the OFS IIA Application Pack

£ Introduction Please Review the Following Eefore Continuing:

# Pre-Install Configuratian

(D Pra-Installation Summary Information domain Name
CFSIFRSIMFC

(D Installing.
[} Post-Install Configuration Datamodel xml
) Install Complete path

Fseratch/ofsaadbflnstallerf OFS_IFRS _PACK fOFS_

Datamodel Xml file
OFS_IFRS_Datamodal.xml

ErwinXML
ORACLE Path

FINANCIAL SERVICES

Erewious

55. Click Next. The Creating Sandbox Infodom window is displayed.

Please Wait

G Pre-anstall Configuratio
D e " A
) instaling
(5 Fost

aing canfigured for
\ a Creating Sandbox Infodom ot bl hke a moment

EESSRNNRNR N NN

ORACLE
FINANCIAL SERVICES

ORACLE
FIANCIAL SERVES

Note: Similarly enter the details for HISTIRC Sandbox and FCSTIRC
Sandbox.
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56. Click Next. The Pre-Setup Information window is displayed. Select Yes, if you want to
perform the model upload.

[ntroduction Do you want to perform Model upload ??
¥ Pre-Install Configuration ® Yes
() Fre-Installation Summary () Mo, | have already done it.
(D Installing.
(D Post-Install Configuration
) Install Camplete

ORACLE’
FINANCIAL SERVICES

57. Select the data model type and click Next.
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) Introduction Do you want to upload Released Datamodel or

i ) i ?
=¥ Pre-Install Canfiguration L Ustalinizcl Hdl aarel {

) Pre-Installation Summary ® Feleased Datamodel

(D Installing. ) Customized Datamodel

() Post-Install Configuration

(D Install Complete

ORACLE’
FINANCIAL SERVICES

58. Click Next, to copy the data model to erwin.xml file.

Please Wait

For your system. This may

Cogndng Daa Mnced tn arsiniML craciony

FINANCIAL SERVICES

FINANCIAL SERVICES

59. Click Next, to upload the data model.
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£ Introduction
=¥ Pre-Install Configuration
) Pre-Installation Summary
) Installing...

() Post-Install Configuration
(D Install Complete °B SolutionSetup@aofss220213 =]

: configured for your
. a Uploading DataModel HOmeht...

S % . % % % %

ORACLE’
FINANCIAL SERVICES

60. Verify the Pre-Model Upload Summary and click Next.

61. Click Next. It will check for the Heap Memory Warning.
Model Heap Memory Warning Window:

(2 N =

Please check..
Insufficient heapsize settings in .profile file

Heapsize should be greater than or equal to 16080 MEB

62. Click Back, update your .profile entry with required heap memory size.

e Open anew session in Putty.

»  Shutdown OFSAAI server using $FIC_
HOME/ficapp/common/FICServer/bin/stopofsaai.sh.

¢ Update the X_ARGS_APP entry in .profile file as mentioned in the following
example:
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X_ARGS_APP=""-Xms2g -Xmx18g -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=1024M -XX:+UseParallelOldGC
-XX:+DisableExplicitGC"

Note: Ensure that, in an integrated environment for pack on pack
installation the memory size is 10 times the value of all the datamodel sizes
taken together.

¢ Execute the .profile file.

e Start OFSAAI services using $FIC_HOME/ficapp/common/FICServer/bin/
startofsaai.sh.

¢ Proceed for model Upload.

63. After Model Upload completion, ETL Application/ Source Pair is displayed. The following
window seeks input from the user on whether to create a new ETL application/source pair
or use an existing one.

Choose the desired option and click Next to continue.

P Introduction Please choose the desired option to proceed to the next step.

=¥ Pre-Install Caonfiguration

2} Fre-Installation Summary
) Installing.
[ Post-Install Configuration

3 Install Complete

Do you want to create new ETL source or use the existing
onhe ?

(@ Mew Src
{_ Existing 5rc

ORACLE
FINANCIAL SERVICES

If the option New application/source pair was chosen then the following window is
displayed seeking the application and source name for the creation of the same.
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f) Introduction

P Pre-Install Configuration
) Pre-Installation Sumrmary
[} Installing.

[ Post-Install Configuration
(D Install Complete

ORACLE
FINANCIAL SERVICES

ETL FSAPPS Source Details

Narne | STAGING

Description | STAGING

ETL Processing Source Details

Narne | PROCESSING

Description | PROCESSING

64. Specify all the details required for application and source creation.

65. If you have selected Existing Source, click the drop-down lists adjacent to ETL Staging
FSAPPS SRC Selection and ETL Processing SRC Selection fields and select the required

values.

These fields list the existing ETL Sources for Staging and Processing.
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[T TR R [ S RS E i Py T R L L Ty e Ry R L T

| imt Get User Input Dialog Previ
1
1

Intraductian ETL Source selection
I Pre-Install Configuration

[0} Pre-Installation Surmmary
) Installing. ..
() Post-Install Configuration

Select the target ETL Sources, into which the ETL Definitions will
he deployved

() Install Complete
ETL Staging F5APPS Src selection

ETL Processing SRC selection

ORACLE’
FINANCIAL SERVICES

_ancel Frewious Hext

66. Click Next to proceed.

This creates application and source within OFSAALI. This also generates a source model.
This process takes some time depending on the number of entities or attributes in the
atomic schema. This process cannot be rolled back.
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i Introduction Please Review the Following Eefore Continuing:

£ Pre-Install Configuration
3 Pre-Installation Summary Java VM to be Used by Installed
Product:

) Installing. Jscrateh/jdkl.7.0_65

() Post-Install Configuration

() Install Camplete
PLATFORM

Cracle Financial Services Analytical Applications
Infrastructure

PLATFORM YERSION
80,500

ORACLE PRODUCT NAME

Cracle Financial Services Hedge Management
FPELANGIAL SERVICES and IFRS valuations

Cancel Frenious Install

This window displays the pre-installation summary. Verify all details and proceed.

67. Click Install to proceed. A message appears asking for confirmation.
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£ Introduction Please Review the Following Eefore Continuing:

F T l
Pre-Install m fgﬂﬁ'ﬁ%ﬁwwﬁﬁgﬂﬁfﬁ_ @

= Pre-Install

2 Installing, & Are wou sure wou wish to proceed with Installation?
() Post-Insta -

) Install Cor

Cations

PLATFORM YERSIOMN
8.0.8.0,0

ORACLE PRODUCT NAME
FINANCIAL SERVICES Cracle Financial Sarvices Hedge Management

and IFES wvaluations

Prendous Install

68. Click Yes, Installation is initiated. The Installation Progress is displayed in the Installation
Progress window.

Anytime during the installation, you can click Cancel to stop the installation. Once
completed, the Installation Summary window is displayed.

Please Wait

& introduction
@D Pre-install Canfigurati
W Fre-instaliation Summa

Ingtallation is in progress...

ORACLE
This process may take several minutes, Ploase Wait.

FINANCIAL SERVICES

ORACLE
FIVANIAL SERVICES

69. Click Next. The Sandbox Summary window is displayed.
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¥ Preinstall Setup

@ irtroduction
@ Fre.instal Canfiguratio
@ #renstakation Summa,
¥ Instaling .

(2 Fast-nstal

ORACLE
FINANCIAL SERVICES

ORACLE
FIVANIAL SERVICES

Post - Installation Information

Clicking on Mext wil start Sandbox Creation Frocess.
Flease ensure FICServer is up and running before clicking

on next

Please Wait

ke a moment

70. Click Next to create a sandbox. The following message is displayed.

i Preinstall Setup

& intraduction

& Pre-install Configuratios
P Pre-installation Surnma.
¥ Installing..

() Post.inst

ORACLE
FIVANCIAL SERVIES

Flaase wait, ianse
your systam. This may take a momant..

Please Wait

i% bain

for Bk a mamant

71. Click Next. The Installing Financial Service Insurance IFRS 17 Analyzer Application

Pack window is displayed.
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Please Wait

= Premstall Setup

X a wnstaling Financial Services Intemational Financial Reporting Standards Applications . 13ke @ moment..
[ ]

ORACLE

FINANCIAL SERVICES

INSTALLATION SUMMARY

Prelnstall Setup
Installation

0
2 Install Complete #DEBUG STATEMENTS: O
HINFORMATIORNS.

Please see the installation log under /scratch/ofsaadbfinstaller/OFS _IFRS_PACKflogs fPack_Install.log
Click on Mext to continue.

ORACLE
FIANCIAL SERVCES
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Installation Complete

Cangratulations! Financial Services International Financial Reporting Standards Applications has been successfully installad
o) Freinstall Setup
P Installation Click on "Dange" 1o exit the installer. Please do not close the console. Post Install activites will be performed in console..

& Install Complete

ORACLE
FIVANCALSERVIES

Previous Done

73. Click Done.

Note: The installation process continues on the console. Do not close the
console until the installation process is complete.

The Post Install Health check results are displayed:
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74.

75.

76.

77.

78.
79.

80.

,1,0, Status 3 SUCCESS

<<<<< ouar
Lecho] Creating /ecrsteh/sFrouser /0FSH_HOME/F Loweb/of s1frs war frashly. .
Dwar] Bullding wart fecratehi frouserOFSA_HIME/T Lowsb/cf sifrs

BUILD SUCLESSFL
Teral ©

You have successfully installed the OFS 11A Application Pack.

Install the OFS AAI 8.0.6.1.0 ML 28033370. Refer to the Readme available with the patch
for further instructions on installing the patch.

Replace the contents of the file RevLog4jConfig.xml with the contents of the file
RevLog4jConfig.xml_8061bkp. These files are present in the $FIC_WEB _
HOME/webroot/conf folder.

Update the “partition by” tag of the following script file with the necessary partition
values and execute them.

iia_create_table_partitions.sql
This script file is available in the folder OFSAHOME/scripts_ OFS_IIA/atomic/create.

Install the one-off patch 25343603, if OFSAA is deployed on Oracle WebLogic Server
version 12.2.x. Refer to the Readme available with the patch for further instructions on
installing the patch.

Perform the steps mentioned in the Post Installation Configuration section.

For enabling Transparent Data Encryption (TDE), see Transparent Data Encryption (TDE)
section.

For enabling Data Redaction, see the Data Redaction section under Data Security and Data
Privacy chapter in OFS Analytical Applications Infrastructure Administration Guide
8.0.6.0.0.

Verifying the Log File

Verify the following logs files for more information:

See the Pack_TInstall.log file located at OFS_ITIA_PACK/logs/ directory for OFS I1A
Application Pack installation logs.

See the log file(s) located in the OFS_IIA_ PACK/OFS_AAI/logs/ directory for
Infrastructure installation logs.
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Installing the OFS IIA Application Pack

See the OFSAAInfrastucture_Install.log file located at $FIC_HOME directory for
Infrastructure installation logs.

See the OFS_1IA installation.log and OFS_IIA_Installation_debug.log log files located at
<OFS_IIA_PACK=>/OFS_l1A/logs directory.
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Post Installation Configuration

On the successful installation of the OFS I1A Application Pack, follow the post-installation
steps mentioned below.

This chapter includes the following sections:

Configuring Resource Reference

Configuring Work Manager in Web Application Server

Starting OFSAA Infrastructure Services

Adding TNS entries in the TNSNAMES.ORA File

Configuring Oracle Financial Services Inline Processing Engine (OFS IPE)
Updating OBIEE URL

Creating and Deploying the Application Pack Web Archive

Accessing the OFSAA Application

Performing Post Deployment Configurations

for OBIEE

Configurations to Enable DELETE Functionality in LOB and Geography Dimensions
Update the web.xml

Mapping Batches to User Groups

Note: Ensure to clear the application cache before the deployment of Applications
Pack Web Archive. This applies to all Web Servers (Tomcat/WebLogic). For more
information, see Clearing Application Cache section.

Note: While executing data loading batches for dimension tables, ensure that there are
no duplicate codes inserted into the tables with the latest record indicator as "Y" for a
given MIS Date.

Configuring Resource Reference

Configure the resource reference in the Web Application Server configured for OFSAA
Applications. See Configuring Resource Reference in Web Application Servers section for
details on configuring the resource reference in Tomcat and WebLogic Application Servers.
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Configuring Work Manager in Web Application Server

Process Modelling framework requires the creation of Work Manager and mapping it to
OFSAA instance. This configuration is required for WebLogic Web Application Server type.

This section covers the following topics:

Configuring Work Manager in Weblogic Application Server

Configuring Work Manager in Weblogic Application Server
This section is applicable only when the Web Application Server type is WebL ogic.

Creating a Work Manager

1.

w

© N o 0 &

Open the WebLogic admin console in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled).

The Welcome window is displayed.
Log in with the user ID that has admin rights.

From the Domain Structure menu in the LHS, expand Environment and select Work
Managers. The Summary of Work Managers window is displayed.

Click New to create a new work manager component.
Select the Work Manager and click Next.

Enter the Name as 'wm/WorkManager'.

Click Next.

Select the required deployment target and click Finish.

Starting OFSAA Infrastructure Services

Start the OFSAA Infrastructure Services before deployment or accessing the OFSAA
Applications. See to the Starting/ Stopping Infrastructure Services section for details on Start/
Stop OFSAA Services.

Adding TNS entries in the TNSNAMES.ORA File

Add TNS entries in the thsnames.ora file, for every schema created for the Application Pack.

To find the tnsname for the entries, follow these steps:

1.
2.
3.

Log in to the application using System Administrator privileges.
Navigate to System Configuration & Identity Management tab.

Click Administration and Configuration, select System Configuration, and click
Database Details.

Expand Name to get the list of TNS entry names.
Alternatively, you can connect to the CONFIG schema and execute the below query:

select dbname from db_master where dbname !="CONFIG"
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Configuring Oracle Financial Services Inline Processing
Engine (OFS IPE)

This section is applicable only if OFS Inline Processing Engine is licensed and enabled in your
OFSAA instance.

You should create an additional resource reference as JDBC/<INFODOMNAME> pointing to
the same infodom in which IPE is installed. For information on creating resource reference, see
Configuring Resource Reference in Web Application Servers section.

Follow the instructions in OFS IPE Configuration Guide to configure the OFSAA instance for
using OFS Inline Processing Engine. This step is mandatory if you have enabled the OFS Inline
Processing Engine during the installation.

Updating OBIEE URL

To access the respective Business Intelligence Analytics Application, you need to update the
OBIEE URL in the table '"AAlI_MENU_B', once the OBIEE environment is up and running.

Following statement needs to be executed in the config schema:

UPDATE AAI_MENU B SET V_MENU_
URL="http://whfO00btx.in.oracle.com:7001/analytics”, V_MENU_
TARGET ="NEW", V_EXTRA_PARAMS="DIRECTLAUNCH" WHERE V_MENU_ID
="0OFS_I1A_ANALYTICS";

Here V_MENU_URL is the URL to you OBIEE link

Creating and Deploying the Application Pack Web Archive

On the successful installation of the OFSAA Application Pack, the web archive file is
automatically generated. However, you need to deploy the generated web archive file on the
Web Application Server.

To identify the location of the generated web archive file and to generate and deploy the web
archive file, see Creating and Deploying EAR/ WAR File section.

Note: See the Oracle Financial Services Forms Manager User Guide for
instructions on Creating and Deploying the Forms Manager Web Archive.

Accessing the OFSAA Application

Before accessing the OFSAA application ensure the Configuring Internet Explorer Settings are
configured.

Refer to Accessing OFSAA Application section for details on accessing the OFSAA
Application on the successful deployment of the application web archive.

You can follow the Run Charts shared in My Oracle Support to populate the required data to
respective tables.

Performing Post Deployment Configurations

Before using the OFSAA Application perform the Post Deployment Configuration steps
detailed in the Post Deployment Configurations section.
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for OBIEE

for OBIEE

To create the global variables for OBIEE, in this release of 1A application, perform the
following procedure:

1. Hostthe RPD and Catalog for I1A solution as part of this release.
2. Login into OBIEE/analytics using the application URL.
3. Click Analytics link.

E new | B& Open ~ | Signed In As

is and Interactive Reporting
Analysis
5| Dashboard

S Filter

Dashboard Prompt
? Condition

4. Click and select the subject area as 11A 9.

Select Subject Area *
ﬁ Hedge Management

@ rrs o

ﬁ Loan Loss Forecasting and Provisioning

The subject area details are displayed.
5. Expand a folder and double click on any column from the subject area.

6. Click the Edit formula menu item.

5-82 OFS Insurance IFRS 17 Analyzer Installation and Configuration Guide



Configurations to Enable DELETE Functionality in LOB and Geography Dimensions

Criteria  Results  Prompts
Subject Areas
[ 1FrRs 9
N N -DIMENSIONS -
|:| Account

Advanced

Q e~ a » [NPLE

- Account Mumber

i3 Iil'i'g.'[:lim AccountDim
» [ZBands
» [[ZBaszel Customer Type
» [ZBasel Product Type
> 3 Country
» [ current IFRS% Stages
> [JDates
> [ Industry
» [JLine of Business
» [ Maturity Bands

m

Selected Columns

Double didk on column names in the Subject Areas pane to

Account
H Account Manager Code =

& zort L4
: [FER Edit formula
% Column Properties
Filters P Filter
Add filters to the analysis crit 3¢ Delete r

E Save Column As

7. Click the Variables tab and select the Global option from the menu.

Variable ~ +

Session...
Repositary...
Presentation...

Glabal. ..

Ok Cancel

8. Create a global variable with the following details:

e Variable Name: denomination

Value: case when '@{denomination}{in thousand}' = 'in thousand' then 1000 else

1000000 end
Type: Text

This variable is used to divide all amount values by thousand or million, depending on

the selected criteria.

9. Refresh the materialized by executing the following queries:
« EXECUTE DBMS_MVIEW.REFRESH(LIST=>'FCT_COLLECTIVE_

ASSESSMENT_MV');

Configurations to Enable DELETE Functionality in LOB and

Geography Dimensions

To enable DELETE functionality of members in LOB and Geography dimensions, perform the

following procedure:

1. Edit the file AMHMConfig.properties present in the conf/ folder of the deployed path.
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Update the web.xml

2. Add the following entries:
e MEMBER_DEL-<<INFODOM>>-<<Dimension id of Geography>>=Y
* MEMBER_DEL-<<INFODOM>>-<<Dimension id of LOB>>=Y
For example: MEMBER_DEL-0OFS081223INFO-2002=Y

Update the web.xml

Update the value /* in the following script, with a value which will not be present in a URL.
For example: <url-pattern>/xyz</url-pattern>

<Filter-mapping>
<fFilter-name>FilterServlet</filter-name>
<url-pattern>/*</url-pattern>

</Filter-mapping>

Mapping Batches to User Groups

You need to map the I1A Batches to corresponding User Groups, in which the user is mapped.
For more information, refer to the Batch Execution Rights section in Oracle Financial
Services Analytical Applications Infrastructure User Guide.
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Configuring Web Server

This section covers the following topics:
»  Configuring Web Server
»  Configuring Web Application Servers

Configuring Web Server
This step assumes the installation of a web server exists as per the prerequisites.

Refer to the product-specific installation guide to install and configure the webserver. If an
installation already exists, skip, and proceed to the next step.

Note: <Make a note of the IP Address/ Hostname and port of the webserver.
This information is required during the installation process.

» Refer to the Oracle Financial Services Analytical Applications
Infrastructure Security Guide mentioned in the Related Documents section
for additional information on securely configuring your web server.

«  Ensure to enable sticky session/affinity session configuration on the
webserver. Refer to the respective product-specific Configuration Guide
for more details. Additionally, you also need to enable the sticky
session/affinity session configuration at the Load Balancer level if you
have configured a Load Balancer in front of the webserver(s).

Configuring Web Application Servers

This step assumes that the installation of a web application server exists as per the
prerequisites. To configure the Web Application Server for OFSAA Deployment refer to the
following sections.

This section includes the following topics:
»  Configuring WebLogic for Application Deployment

»  Configuring Apache Tomcat Server for Application Deployment
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Note:

» Make a note of the IP Address/ Hostname and port of the web
application server. This information is required during the installation
process (required if the web server is not configured).

» Make a note of the IP Address/ Hostname and port of the web
application server. This information is required during the installation
process (required if the webserver is not configured).

«  Refer OFSAA Secure Configuration Guide/ Security Guide mentioned in the
Related Documents section for additional information on securely configuring
your Web Server.

Configuring WebLogic for Application Deployment

You can deploy multiple Infrastructure applications on different domains of a stand-alone
WebLogic application server. To create multiple WebLogic "Domains" in a stand-alone server
you can use the Domain Creation wizard. A domain is the set of files that define the runtime
environment. At least one domain must exist to run the WebLogic Application Server.

Note: OFS IIA application is compatible with WebL ogic 12.2.x and does
not support WebLogic 12.1.3. If the WebLogic version is 12.1.3, upgrade to
WebLogic 12.2.x.

Note: Download and install the one-off patch 25343603 from My Oracle
Support if OFSAA is deployed on Oracle WebLogic Server version 12.2.x.
See the Readme available with the patch for further instructions on installing
the patch.

This section covers the following topics:

e Creating Domain in WebLogic Server

»  Deleting Domain in WebLogic

»  Configuring WebLogic Memory Settings

»  Configuring WebL ogic for REST Services Authorization

Creating Domain in WebLogic Server
To create a new domain using Configuration Wizard in WebLogic, follow these steps:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the
command:

./config.sh
The Welcome window of the Configuration Wizard is displayed.
2. Select Create a new WebLogic domain option and click Next.
The Templates window is displayed.
3. Select the Create Domain Using Product Templates option and click Next.

The Administrator Account window is displayed.
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10.

11.

Enter the user name to be assigned to the administrator, the password, and confirm the
password. Click Next.

The Domain Mode and JDK window is displayed.
Select from the following options:
* Inthe Domain Mode section, select the required mode (Development or Production).

* Inthe JDK section, select the required option. If you select Other JDK Location, click
Browse, navigate to the JDK location, and select. Click Next.

The Advanced Configuration window is displayed.

Select the Administration Server. A WebLogic Server domain must have an
Administration Server. You can also select Manages Servers, Clusters, and Machines and
RDBMS Security Store if required. Click Next.

The Administration Server window is displayed.

Enter Administration Server details such as the Server Name, Listen address, Listen Port,
Enable SSL(for secure login using https, select this checkbox), and SSL listen port. Click
Next.

The Configuration Summary window is displayed

Note: Make a note of the Listen Port or SSL Listen Port value (for example
7007) since the same has to be re-entered in the Servlet port field during
Infrastructure installation.

Verify the configuration details of the WebLogic domain and click Create.

The Configuration Progress window is displayed with the status indication of the domain
creation process.

Click Next when 100% of the activity is complete.
The End of Configuration window is displayed

Click Finish. The domain server is created enabling the deployment of multiple
Infrastructure applications on a single WebLogic.

Note:

»  Note down the HTTPS port specified during this process and use the
same as a servlet port or webserver port during OFSAAI Installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_
ENABLE" in OFSAAI_InstallConfig.xml for silent mode OFSAAI
installation

Add a java option entry -DUseSunHt tpHandler=true in WLS_HOME/bin/
"setDomainEnv.sh" file (Required only if self signed certificate is used).

Deleting Domain in WebLogic
To delete a domain in WebL ogic, follow these steps:

1.

Navigate to the following directory:

Configuring Web Server A-3



Configuring Web Application Servers

<WebLogic Installation directory>/user_projects/domains/<domain
name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.
3. Delete the Weblogic domain.

Configuring WebLogic Memory Settings
To configure the WebLogic Memory Settings, follow these steps:

1. Change the memory setting for Java Heap t0 -Xms512m -Xmx3072m in setDomainEnv.sh
file, which resides in the folder <DOMAIN_HOME>/bin and CommEnv.sh file which resides
in the folder common/bin

2. Edit this file for customizing memory settings and garbage collector settings depending on
the available hardware configuration.

Example 1:
if [ "${JAVA_VENDOR}" = "Sun" ] ; then
WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_64BIT
WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_32BIT
else
WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_64BIT
WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_32BIT
Example 2:
JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring WebLogic for REST Services Authorization
To enable REST API authorization by OFSAA in WebL ogic, perform the following steps:

1. Open the config.xml file located in the domain where OFSAA is deployed, that is
<domain_home=>/config/config.xml.

2. Add the following in the security-configuration tag:

<enforce-valid-basic-auth-credentials>false</enforce-valid-ba
sic-auth-credentials>

Configuring Apache Tomcat Server for Application Deployment
This section is applicable only when the Web Application Server type is Tomcat.

This section includes the following topics:
»  Tomcat User Administration
«  Configuring Tomcat to use JAVA 64 bit Executables

»  Configuring Servlet Port
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Configuring SSL Port

Apache Tomcat Memory Settings
Configuration for Axis API
Uninstalling WAR Files in Tomcat

Tomcat User Administration

The Tomcat administration and manager application do not provide a default login. You are
required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed below.

This file contains an XML <user> for each user, which will display the user name and
password used by the admin to log on to Tomcat, and the role names to which the admin user is
associated with. For example, <user name="admin" password="admin"
roles="standard,manager" />

1.

Add the manager role to any one of the existing user name/password combinations as
shown in the preceding example.

Use the same user name/password to which the manager role has been assigned to access
the Tomcat Application Manager.

If the Tomcat server is already running, it requires a re-start after the aforementioned
configuration is done.

Configuring Tomcat to use JAVA 64 bit Executables
To configure Tomcat to use JAVA 64 bit, follow these steps:

1.
2.
3.

Navigate to the "$SCATALINA_HOME/bin" folder.

Edit the setclasspath.sh file as follows:

Replace the following block of text

# Set standard commands for invoking Java.
_RUNJAVA="S$JRE_HOME"/bin/java

if [ "$Sos400" != "true" ]; then
_RUNJDB="$JAVA_HOME"/bin/jdb

With:

# Set standard commands for invoking Java.
_RUNJAVA="S$JAVA BIN"/java

if [ "$Sos400" != "true" ]; then
_RUNJDB="$JAVA_BIN"/jdb

If the Tomcat server is already running, it requires a re-start after the aforementioned
configuration is done.
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Note: In case tomcat is installed under different Unix profile, set JAVA _
BIN environment variable in .profile to include the Java Runtime
Environment absolute path.

For example:
export JAVA_BIN /usr/java7_64/jre/bin

export JAVA_BIN = /usr/java7_64/jre/bin//sparcvd for Solaris
Sparc

Configuring Servlet Port

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if
you need to use the default port.

If you need to use a different port number, you must first configure the port in the server.xml
file in the conf directory of the Tomcat installation directory.

To configure the Servlet Port, follow these steps:
1. Navigate to SCATALINA_HOME/conf. Open server.xml and locate the tag:
2. "Define a non-SSL HTTP/1.1 Connector on port 8080 "

3. Against this tag, a parameter is specified 'Connector port = "8080" . Edit this value to
the new port number that was used during the Infrastructure installation process.

4. Save your changes in the server.xml file.

Note: Make a note of the servlet port configured. This information is
required during the installation of the OFSAA Application Pack.

Configuring SSL Port

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the
following connect tag under Define a SSL HTTP/1/1 Connector on port 8443 in <Tomcat_
installation_folder>/conf/server.xml file is uncommented for SSL Configuration. (By
default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note:

»  Make a note of the servlet port configured. This information would be
required during the installation of the OFSAA Application Pack.

» To enable https configuration on Infrastructure, assign value 1 to
"HTTPS_ENABLE" in OFSAAI_InstallConfig.xml file for SILENT
mode OFSAAI installation.

For more information related to SSL Configuration on Tomcat, see to
http://tomcat.apache.orgl.
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Apache Tomcat Memory Settings
To configure the Apache Tomcat Memory Settings, follow these steps:

1. Locate the catalina.sh file that resides in <CATALINA_HOME>/bin directory.

2. Edit this file for customizing the memory settings and garbage collector settings depending
on the available hardware configuration.

3. Add the memory setting for Java Heap t0 -Xms512m -Xmx1024m.

4. For example:
if [ -z "$SLOGGING_MANAGER" ]; then
JAVA_OPTS="S$JAVA_OPTS -Xms512m -Xmx1024m
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"
else
JAVA_OPTS="$JAVA_OPTS -Xmsb512m -Xmx1024m SLOGGING_MANAGER"

fi

Configuring Axis API

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_
4/webapps/axis/WEB-INF/lib and place it inside the <Tomcat Installation Directory>/lib folder
and restart the Tomcat Server.

Configuring Tomcat for User Group Authorization and Data Mapping

Users with system authorization roles can access User Group Authorization. However, to make
it available on the Tomcat web server, you have to perform the following configuration steps:

1. Navigate to the $SCATALINA_HOME/conf directory and open web.xml file.
2. Enter the following in the web.xml file.
<init-param>
<param-name>mappedfile</param-name>
<param-value>false</param-value>
</init-param>

3. Save and close the file.

Uninstalling WAR Files in Tomcat
To uninstall WAR files in tomcat, refer Uninstalling WAR Files in Tomcat.

Configuration for Axis API

Copy the jaxrpc.jar fromthe <OFSAA Installation Directory>/axis-1_
4 /webapps/axis/WEB-INF/1ib and place it in under <Tomcat Installation
Directory>/1ib and restart the Tomcat Server.
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Configuring Resource Reference in Web
Application Servers

This section covers the following topics:
»  Configuring Resource Reference in Weblogic Application Server

»  Configuring Resource Reference in Tomcat Application Server

Configuring Resource Reference in Weblogic Application
Server

This section is applicable only when the Web Application Server type is WebL ogic.This section
includes the following topics:

»  Creating Data Source

»  Creating GridLink Data Source

»  Configuring multi-data Sources

»  Configuring Advanced Settings for Data Source

»  Defining JDBC Connection Pooling

In WebL ogic, you can create "Data Source™ in the following ways:

* "For a Non-RAC Database instance, Generic Data Source has to be created. See Create
Data Source.

* "For a RAC Database instance, Gridlink Data Source has to be created. See Create
GridLink Data Source.

*  "When Load Balancing or Fail over is required, multi-data Source has to be created. See
Configure multi-data Sources.

Creating Data Source
The steps given below are applicable for both config and atomic data source creation.

1. Open the following URL in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is
enabled). The Welcome window is displayed.

2. Login with the Administrator User name and Password.
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Figure B-1 Welcome
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3. From the LHS menu (Domain Structure), click Services > Data Sources. The Summary of
JDBC Data Sources window is displayed.

Figure B-2 Summary of JDBC Data Sources
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4. Click New and select Generic Data Source option. The Create a New JDBC Data Source
window is displayed.

You can also select GridLink Data Source or multi-data Source while creating a Data

Source. For more information, see Creating Data Source or Configuring multi-data
Sources.
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Figure 5-1 Create a New JDBC Data Source
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5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the
drop-down list. Click Next.

Ensure the following:
e The JNDI Name field should be in the format "jdbc/informationdomain™

»  The same steps need to be followed to create a mandatory data source pointing to the
"configuration schema™ of infrastructure with jdbc/FICMASTER as JNDI name.

* JNDI Name is the same as mentioned in the web.xm1 file of OFSAAI Application.

*  Required "Database Type" and "Database Driver" should be selected.
Figure B—3 JDBC Data Source Properties
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6. Select the Database Driver from the drop-down list. You need to select the Database
Driver depending on database setup, that is, with or without RAC. Click Next.

Configuring Resource Reference in Web Application Servers B-11



Configuring Resource Reference in Weblogic Application Server

Figure B—4 Transaction Options
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7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.

8. Click Next. The Connection Properties window is displayed.

Figure B-5 Connection Properties
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9. Enter the required details such as the Database Name, Host Name, Port, Oracle User
Name, and Password.

10. Click Next. The Test Database Connection window is displayed.
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Figure B—6 Test Database Connection
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11. Verify the details and click Test Configuration and test the configuration settings.
A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source™ is displayed in the list of Data Sources.

Note:

e "User ID" is the Oracle user ID that is created for the respective
"Information Domain".

»  "User ID" to be specified for a data source with "FICMASTER" as
"JNDI" name should be the Oracle user ID created for the "configuration
schema”.

13. Select the new Data Source and click the Targets tab.
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Figure B—7 Select Targets
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14. Select the AdminServer option and click Finish.

Creating GridLink Data Source
If you have selected the option, New > GridLink Data Source while creating the "Data
Source", you can directly specify the JDBC URL as indicated.

Figure 5-2 Create a New JDBC GridLinkData Source

T

1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA
Driver checkbox is not selected. Click Next.
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Figure 5-3 JDBC GridLinkData Source- Connection Properties
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2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The
created "Data Source" is displayed in the list of Data Sources.

Configuring multi-data Sources

A JDBC multi-data source is an abstraction around a group of data sources that provides load
balancing and failover between data sources. As with data sources, multi-data sources are also
bound to the JNDI tree. Applications can look up a multi-data source on the JNDI tree and then
reserve a database connection from a data source. The multi-data source determines from which
data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle
Database to run across a set of clustered servers, the group of data sources can be created for
instances running on a set of clustered servers and a JDBC multi-data source can be created so
that applications can look up a multi-data source on the JNDI tree to reserve database
connection. If a clustered server fails, Oracle continues running on the remaining servers.

1. Open WebLogic Admin Console in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is
enabled). The Login window is displayed.

2. Login with the "User ID" that has admin rights.

3. Inthe LHS menu (Domain Structure), select Services > JDBC > multi-data Sources. The
Summary of JDBC multi-data Sources window is displayed.

Summary of JDBC multi-data Sources
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4. Click New. The New JDBC multi-data Source window is displayed.

Note: Ensure that the Data Sources which need to be added to the new
JDBC multi-data Source has been created.

Configure the multi-data Source
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5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the
drop-down list. Click Next.

Note:
e The JNDI name has to be specified in the format jdbc/infodomname.

* JNDI Name of the Data Sources that will be added to the new JDBC
multi-data source should be different from the JNDI name specified
during multi-data Source.

»  The same steps need to be followed to create a mandatory data source
pointing to the "configuration schema™ of infrastructure with
jdbc/FICMASTER as JNDI name for Data Source.

« JNDI Name provided in multi-data source should be the same name that
will be mentioned in the web.xm1 file of OFSAAI Application.

* You can select the Algorithm Type as Load-Balancing.
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Figure 5-4 Select Targets
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6. Select the AdminServer checkbox and click Next.

Figure 5-5 Select Data Source Type
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7. Select the type of data source which will be added to the new JDBC multi-data Source.
Click Next.

Figure 5-6 Add Data Sources

8. Map the required Data Source from the Available Data Sources. Click Finish.

The New JDBC multi-data Source is created with added data sources.

Configuring Advanced Settings for Data Source
Perform the following steps for advanced settings for Data Source:

1. Click the new Data Source from the Summary of JDBC Data Sources window. The
Settings for <Data Source Name> window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the window, and check the Test Connection
of Reserve checkbox (Enables Weblogic Server to test a connection before giving it to a
client).
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To verify if the data source is valid, select "Data Source name". For example,
FICMASTER.

Figure 5-7 Settings for <Data Source Name>
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4. Select the server and click Test Data Source.
A message is displayed indicating that the test was successful.

5. Once the "Data Source" is created successfully, the following messages are displayed:
> All changes have been activated. No restart is necessary.
- Settings updated successfully.

If not, follow the aforementioned steps to recreate the data source.

Defining JDBC Connection Pooling

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data
source to access the data from the database.

1. Click the newly created Data Source $SDATA_SOURCES$ and navigate to the path Home
>Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data
Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.

3. Click Save.

Configuring Resource Reference in Tomcat Application
Server
This section is applicable only when the Web Application Server type is Tomcat.
This section covers the following topics:
»  Creating Data Source
»  Defining JDBC Connection Pooling
»  Configuring Class Loader for Apache Tomcat

Copy the Oracle JDBC driver file, "ojdbc<version>.jar" from <Oracle Home>/jdbc/1ib and
place it in <Tomcat Home>/1lib.
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Note: Refer Appendix O for identifying the correct ojdbc<version>.jar
version to be copied.

Creating Data Source

To create a "data source" for Infrastructure application, navigate to <Tomcat Home>/conf and
edit the following block of text by replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the prefix of
setupinfo depending on the value set for PREFIX_SCHEMA_NAME in
<<APP Pack>>_ SCHEMA _IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the
schema name was mentioned as ofsaaconf, then the actual schema created in
the database would be DEV_ofsaaconf.

In the event, Oracle Wallet is configured in OFSAA server to store the database passwords, edit
the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the following
changes, which is required for connection pooling.

<Context path="/ $CONTEXTNAMES$" docBase=" $APP_DEPLOYED_PATH$ "
debug="0" reloadable=""true" crossContext=""true'>

<Resource auth="Container"
name="jdbc/ $INFODOM_NAMES$"
type=""javax.sql .DataSource"

driverClassName="oracle. jdbc.driver.OracleDriver"
url="$JDBC_CONNECTION_URL""

maxTotal="100"

maxldle="30"

maxWaitMillis="10000"

removeAbandoned=""true"
removeAbandonedTimeout="60"
logAbandoned=""true"/>
</Context>
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Note:

* $APP_DEPLOYED_PATHS should be replaced by the OFSAAI
application deployed path.

*  $INFODOM_NAMES$ should be replaced by Infodom Name.

e $ATOMICSCHEMA_ USERNAMES should be replaced by an Atomic schema
database user name.

¢ $ATOMICSCHEMA_PASSWORDS$ should be replaced by an Atomic schema
database password.

¢« $JDBC_CONNECTION_URL should be replaced by JDBC connection string
jdbc:Oracle:thin:/@<TNS STRING>. For example,
jdbc:oracle:thin:/@CONFIG

Note: If you use Oracle Wallet for database password configuration, see the
Creation of Oracle Wallet on OFSAA Server.

e The User-IDs for configuration/ atomic schemas have the prefix of setupinfo
depending on the value set for PREFIX_SCHEMA_NAME in <<APP Pack>>_
SCHEMA_IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the
schema name was mentioned as ofsaaconf, then the actual schema created in the
database would be DEV_ofsaaconf.

Defining JDBC Connection Pooling

To define the JDBC connection pooling, do the following:

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar tothe path $TOMCAT_
DIRECTORY/1ib/.

Note: Refer Appendix O section for identifying the correct
ojdbc<version>.jar version to be copied.

2. Editthe server.xml present under the path $STOMCAT DIRECTORY/conf/ with the below
changes, which is required for connection pooling.

<Context path="/ $CONTEXTNAMES" docBase=" S$APP_DEPLOYED_PATHS " debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/ $INFODOM_NAMES"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username=" S$SATOMICSCHEMA_USERNAMES"
password="$ATOMICSCHEMA_PASSWORDS"
url="$JDBC_CONNECTION_URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"
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</Context>

logAbandoned="true" />

Note the following:

Note:

$APP_DEPLOYED_PATHS should be replaced by the OFSAAI application
deployed path.

$INFODOM_NAMES should be replaced by Infodom Name.

SATOMICSCHEMA_USERNAMES should be replaced by an Atomic schema
database user name.

$SATOMICSCHEMA PASSWORDS should be replaced by an Atomic schema
database password.

$JDBC_CONNECTION_URL should be replaced by JDBC connection string
jdbc:0Oracle:thin:<IP>:<PORT>:<SID>. For example,
jdbc:oracle:thin 10.80.50.53:1521:s0luint

The User-1Ds for configuration/ atomic schemas have the prefix of setupinfo
depending on the value set for PREFIX_SCHEMA_NAME in <<APP Pack>>_
SCHEMA _IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the
schema name was mentioned as ofsaaconf, then the actual schema created in the
database would be DEV_ofsaaconf.

Configuring Class Loader for Apache Tomcat
Edit the server.xml available in STOMCAT HOME/conf/ folder.

1.
2.

Add tag <Loader delegate="true" /> withinthe <Context> tag, above the
<Resource> tag. This is applicable only when the web application server is Apache Tomcat

8.

Note: This configuration is required if the Apache Tomcat version is 8.
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Creating and Deploying EAR/ WAR File

This section covers the following topics:
» Creating EAR/WAR File
» Deploying EAR/WAR File

Creating EAR/WAR File
To create EAR/WAR File, follow these steps:
1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server.
2. Execute ./ant.sh to trigger the creation of the EAR or WAR file.

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken"
message is displayed and you will be returned to the prompt.

Figure C-1 Creating EAR/ WAR File

4. The EAR/ WAR file - <contextname>.ear/ .war - is created.
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Note: The <contextname> is the name given during installation. This
process overwrites any existing version of the EAR file that exists in the path.

In the case of OFSAA configured on Tomcat installation, <contextname>.war
is created.

ANT warning for tools. jar can be ignored while executing ./ant.sh

Deploying EAR/WAR File

This section covers the following topics:

Deploying EAR/WAR files for WebLogic
Deploying Tomcat WAR Files on Tomcat

Note: Ensure to clear the application cache before the deployment of
Applications Pack Web Archive. For more information, refer to the Clearing
Application Cache section.

Deploying EAR/WAR files for WebLogic
Following are the steps for deploying Infrastructure application that would be created during

installation:
1. Navigate to the path "<WebLogic Installation directory>/user_projects/domains/<domain
name>/bin" in the machine in which WebLogic is installed.
2. Start WebLogic by executing the command:
JstartWebL ogic.sh -d64 file
3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console.
(https if SSL is enabled). The the Sign-in window of the WebL ogic Server Administration
Console is displayed.
Note: Ensure that you have started Infrastructure Server by executing
"./startofsaai.sh" as mentioned in the Starting Infrastructure Services
section.
4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy
the EAR file.
5. From the Domain Structure LHS menu, click Deployments. The Summary of

Deployments window is displayed.
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Figure C-2 Summary of Deployments
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6. Click Install. The Install Application Assistant window is displayed.

7. Select the Exploded EAR directory after browsing to the directory where it is saved and

click Next.

Installing Application
To install the Application, follow these steps:

1. Open the Install Application Assistant.

Figure C-3 Install Application Assistant
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2. Click Next.
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Figure C—4 Install Application Assistant
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3. From the Choose targeting style section, select the Install this deployment as an
application option, and click Next.

The Optional Settings window is displayed.
Figure C-5 Optional Settings
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4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles and
policies that are defined in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location option
under the Source accessibility section.

7. Click Next to continue.

The Deployment Summary window is displayed.
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Figure C—6 Deployment Summary

Aaies gour chasss and ches Tmish

Cion Bogn 1 ToRtE R T TN e TR 8 R o opeTe
Aibbusis b 1w fofrasm s

i ey et P At S8y (eIt MStes 0rips rter. Ju M 8P I s T IEhe | aeigurten e ey Ba mes!

=i Vs tale me in the deploymest’ s configerslion screen.

i B il rarwvere e e g wie it

STy
Erplnymes e P11 e Mt e TSI, g T e g T T
s ]
AEaging mizde Jsa P safuity Srteed e Fa e rgen
Securify Fodet DO L oy ey o gmoet Bt e drteed ¢ Fe Sepiyerd S pton
Targed Smmmmny
Tampoaents - Turpets
oy i T At
Baci Firieh. o

8. Select the Yes, take me to the deployment's configuration screen option and click

Finish.

The Settings for <Deployment Name> window is displayed.
Figure C—7 Settings for <Deployment Name>
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9. Review the general configuration details of the deployment. You can also update the

configuration of the deployment in this window. In the Overview tab, you can view the
complete deployment configuration.
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10. Click Save to update the changes, if any.
11. From the LHS menu, click Deployments.

The Summary of Deployments window is displayed.

Figure C-8 Summary of Deployments
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12. Select the newly deployed Infrastructure application and click Start > Servicing all
requests. Ensure that the Infrastructure server is up and running.

Figure C-9 Summary of Deployments
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13. The State of the deployed application will be displayed as Active if started successfully.

Deploying Tomcat WAR Files on Tomcat
Before deploying the WAR files, ensure that the previously deployed applications of

Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for

the procedure to uninstall the previously deployed Infrastructure war files.
On the machine that hosts Tomcat, follow these steps to deploy Infrastructure application:

1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to
<Tomcat Installation Directory>/webapps/ directory.

2. Click Manager App. The Connect to dialog box is displayed.
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Enter the User Id and Password that has admin rights and click OK. (For user creation in
tomcat, see Tomcat User Administration. The Tomcat Web Application Manager window
is displayed with the list of all the applications deployed.

In the Deploy section, enter the Context Path provided during the installation as
"/<context-name>".

Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_
HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.

On successful application deployment, a confirmation message is displayed.

Start the Tomcat server. Refer to Starting Infrastructure Services for more details.
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Starting/ Stopping Infrastructure Services

This section details how to start and stop Infrastructure services. This appendix covers the
following topics:

Starting Infrastructure Services

Stopping Infrastructure Services

Starting Infrastructure Services

Once the installation of Infrastructure is completed successfully and the post-installation steps
are completed, the servers must be started. Log on to each machine and run the .profile file.
All servers mentioned must be started from the same shell encoding. The servers mentioned
below are dependent on each other. It is mandatory to maintain the order in which the servers
are started. Allow each of the servers to initialize completely before starting the next server.

1.

2.

On the machine in which Infrastructure Application components have been installed,
navigate to $FIC_APP_HOME/common/FICServer/bin, and execute the following
command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the
command "nohup ./ startofsaai.sh &". Starting the process using "nohup" and
"&" will return the command prompt without having to wait until the process
completes. However, this command cannot be used when you are starting the
server for the first time or starting after changing the user password in the
configuration database schema. You can also start the Infrastructure Server by
executing the command "nohup ./ startofsaai.sh &". Starting the process using
"nohup™ and "&" will return the command prompt without having to wait
until the process completes. However, this command cannot be used when
you are starting the server for the first time or starting after changing the user
password in the configuration database schema.

Start ICC server:

*  On the machine in which Infrastructure default Application components have been
installed, navigate to $FIC_HOME/ficapp/icc/bin

»  Execute the command:

./iccserver.sh
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Note: Only Infrastructure Default Application Server would hold the ICC
component.

3. Start Back-end Services:

*  On the machine on which Infrastructure Database components have been installed,
navigate to $FIC_DB_HOME/bin, and execute the command to start "Agent server":

./agentstartup.sh
Or
»  Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP data
server, and AM services.

Starting Web Application Servers
Start the Web Application Server depending on the type from the following table.

Table D-1 Webserver start up options

Startup Option Description

Starting WebLogic Domain On the machine in which WebLogic is installed, navigate to
<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin and execute the command:
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin
Console. Stop and start the application <context name>.ear

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_
Install_ Directory>/bin and execute the command:
./catalina.sh run

Stopping Infrastructure Services
To stop Infrastructure services, follow these steps:

1. On the machine in which Infrastructure Application components have been installed,
navigate to $FIC_APP_HOME/common/FICServer/bin, and execute the command:

./stopofsaai.sh

2. Tostop ICC server, on the machine in which Infrastructure default Application
components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and execute
the command:

./iccservershutdown.sh

Note: Only Infrastructure Default Application Server would hold the ICC
component.

3. To stop Back-end server, on the machine in which Infrastructure database components
have been installed, navigate to $FIC_DB_HOME/bin, and execute the command:
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. /agentshutdown.sh
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Accessing OFSAA Application

This section details the steps to be performed to access the OFSAA Application.

Access the OFSAA Application
1. From your desktop, open the browser and enter the URL in below format:
<scheme>://<IP address/ hosthame>:<port>/<context-name>/login.jsp
For example, https://111.222.333.444:5555/ofsaa/login.jsp
The OFSAA login window is displayed.

Figure E-1 OFSAA Login Window

ORACLE

Financial Services Analytical Applications

Language US-English EI
User ID

Password

Version 8.0.6.0.0

Copyright © 1993, 2017 Oracle and/or its affiliates. All rights
reserved.

2. With the installation of every OFSAA Application Pack, there are two seeded user-profiles
configured in the system:

"SYSADMN - System Administrator
"SYSAUTH - System Authorizer
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Note: For SYSADMN and SYSAUTH, the default password is
"password0".

3. Log in to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the
SYSADMN login USER ID). Enter the default password "password0". On the first login,
you will be prompted to change the password.
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Post Deployment Configurations

This section provides detailed information about the Post Deployment Configurations.

Post Deployment Configurations

This section lists the various configurations to be completed before you use the OFSAA
Applications.

» Logging as System Administrator
e Creating Application Users
*  Mapping Application User(s) to User Group

Logging as System Administrator

Post-installation, the first login into Infrastructure is possible only for a System Administrator
through user ID "sysadmn". This ID is created at the time of installation with the password
provided during installation. Enter login id "sysadmn™ and password that was provided during
installation. Click Login.

Creating Application Users
Create the application users in the OFSAA setup before use.

Note: This step may not be required if you have already set up users in the
OFSAA setup.

For more information, see the user creation section from the Oracle Financial
Services Analytical Applications Infrastructure User Guide.

Mapping Application User(s) to User Group

Starting the OFSAA 8.0 release, with the installation of every OFSAA Application Pack,
pre-configured application user groups are seeded. These user groups are unique to every
OFSAA Application Pack and have application roles pre-configured.

User Groups seeded with the OFS 1A Application Pack are listed in Table F-1, "Seeded User
Groups".
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Table F-1 Seeded User Groups

Name Description

Modeler Group A user mapped to this group has access to all the menu items for
Enterprise modeling but does not have authorization rights for sandbox
population, model deployment, and modeling technique authorization.

Modeling Administrator A user mapped to this group has access to all the menu items for

Group Enterprise modeling and has authorization rights for the sandbox
population, model deployment, and modeling technique authorization.

Inline Processing Admin A user mapped to this group has access to all the menu items and

Group actions for the Inline Processing module.

Business Administrator A user mapped to this group has access to all the menu items and

actions for the advanced operations of metadata objects.

Business Authorizer A user mapped to this group has access to all the menu items and
actions for authorization of changes to metadata objects.

Business Owner A user mapped to this group has access to all the menu items and
actions for the reading and writing of metadata objects

Business User A user mapped to this group has access to all the menu items and
actions for access and read of metadata objects.

Identity Administrator A user mapped to this group has access to all the menu items for
managing User entitlements, User Group Entitlements, and Access
Management configurations.

Identity Authorizer A user mapped to this group has access to all the menu items for
authorizing User entitlements, User Group Entitlements, and Access
Management configurations.

System Administrator A user mapped to this group has access to all menu items for
managing the setup configurations.

Object Administrator A user mapped to this group has access to all menu items for
managing object migration and metadata traceability using metadata
browser.

Guest Group A user mapped to this group has access to certain menu items with
only access privileges.

1A Analyst A user mapped to this group has limited access to the 11 A application.
This user cannot perform user creation and authorization.

IHA Admin A user mapped to this group has access to all the modules to the 1A
application.

Map the application user(s) to the respective Application User Group(s) and subsequently
authorize the entitlements by logging in as SYSAUTH (System Authorizer) user.

For more information, see the Mapping or Unmapping Users section from the Oracle Financial
Services Analytical Applications Infrastructure User Guide.

User Roles and Privileges
Following are the User Roles and corresponding privileges in 1A application:

Table F-2 User Roles and Privileges

User Role Privileges

Level of Aggregation

IHA Admin View
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Table F-2 User Roles and Privileges

User Role Privileges

Level of Aggregation

1A Analyst Add
Edit
View
Delete

Liability Calculation

1A Admin View
Run

1A Analyst Add
Edit
View
Delete
Run

Template

1A Admin Add
Edit
View
Delete

1A Analyst View
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Cloning OFSAA Instance

There is a consistent need for a faster and effective approach of replicating an existing OFSAA
instance for further project developments, that is, setting up OFSAA instances that are exact
copies of the current OFSAA instance. For more information on cloning, see the OFSAA
Cloning Reference Guide.

Cloning OFSAA Instance G-41


http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf

H

OFSAA Landing Window

This section includes the following topics:
» Installation Checklist

* OFSAA Landing Window

Installation Checklist

Before starting on the OFSAAI Installation Kit, ensure that the following pre-installation
activities checklist is completed successfully. It is recommended to take a print out of the

checklist and follow the checklist step by step.

Table H-1

Step No. Task Done
General

1 Check the OFS I1A Release

Notes and Read Me document
for any additional steps to be
performed on OFS I1A or
OFSAAL.

Note: For more details, contact
Oracle support.

Insurance IFRS 17 Analyzer Application Pack Pre Installation + During Installation

1

Before installation, ensure that
sufficient free temp space
(minimum 1 GB free) is
available in /tmp directory of
UNIX server hosting OFSAAI.

Insurance IFRS 17 Analyzer Application Pack Post Installation

1

Perform post-installation steps.
For more information, refer to
Post Installation

OFSAA Landing Window

On successful authentication, the OFSAA Landing window is displayed. This is a common
landing window for all users until a preferred application landing window is set by the user in

his preferences.
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The landing window includes multiple tabs and each tab has specific links to OFSAA
Infrastructure and/or Application modules. The tabs and links are displayed based on the
OFSAA Application accessed and the access roles mapped to the logged-in user.

Each tab contains the LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a
tree structure. The RHS Menu holds link(s) to modules in a navigational panel format.

The following tabs are available in the Landing window:
*  Applications Tab

»  Sandbox Tab

e Object Administration Tab

»  System Configuration and Identity Management Tab

Applications Tab

This tab lists the various OFSAA Applications that are installed in the setup.

The "<Select Application>" drop-down lists the OFSAA Applications based on the user logged
in and User Group(s) mapped to OFSAA Application. Selecting an Application from the
drop-down refreshes the menus/ links.

Sandbox Tab

This tab lists the various OFSAA Sandboxes created in the setup.

The "<Select Sandbox>" drop-down lists the OFSAA Sandboxes based on the user logged in
and User Group(s) mapped to OFSAA Application.

Selecting a Sandbox from the drop-down would refresh the menus/ links.

Object Administration Tab

This tab lists the various OFSAA Information Domains created in the setup.

The "<Select Information Domain>" drop-down lists the OFSAA Information Domains based
on the user logged in and User Group(s) mapped to OFSAA Application.

Selecting an Information Domain from the drop-down refreshes the menus/ links.

System Configuration and Identity Management Tab

H-44

This tab lists the OFSAA Infrastructure System Configuration and Identity Management
modules. These modules work across Applications/ Information Domains and hence there is no
Application/ Information Domain drop-down list in this tab.

Note: Refer the User Manual for more details on how to operate on each
tab.
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Additional Configuration

This section gives detailed information about the Additional Configuration regarding OFSAA
Installation.

Additional Configuration Topics

This section covers the following topics:

Configuring FTP/SFTP

Configure Infrastructure Server Memory

Configuring Internet Explorer Settings

Setting OLAP Data Server Configuration

Changing IP/ Hostname, Ports, and Deployed Paths of OFSAA Instance
Executing OFSAAI Setup Information Fetching Tool
Executing Encryption Changer

Setting Infrastructure LDAP Configuration

Configuring Message Details in Forms Designer

Clearing Application Cache

Configuring Password Changes

Configure Internal Service (Document Upload/Download)

Configurations to Deploy the I1ABI Application

Configuring FTP/SFTP
This section details the configurations required for FTP/SFTP.

Adding FTP/SFTP Configuration for File Transfer

In OFSAA, certain modules require the transfer of files from the web application server to the
OFSAA server over SSH.

Follow these steps to ensure the OFSAA server recognizes the web application server during
file transfers.

1.
2.
3.

Log in to the web application server.

Type sftp <user>@<OFSAA Server>.

Specify Yes when prompted for permission.
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Are you sure you want to continue connecting (Yes/No)?
This will add an entry into the "known_hosts" file.
4. A confirmation message is displayed:

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Setting Up SFTP Private Key

Log in to OFSAA Unix user using the Putty tool, where you plan for installation and generate a
pair of authentication keys using the ssh-keygen command. If required, set passphrase.
Otherwise, the OFSAAI_SFTP_PASSPHRASE tag in the OFSAAI _InstalIConfig.xml
file should be set to NA.

To generate a private key, enter the commands as shown:

ofsaapp@0FSASERVER:~> ssh-keygen -t rsa

Generating public/private rsa key pair.

Enter file in which to save the key (/home/ofsaapp/.ssh/id_rsa):
Created directory "/home/ofsaapp/.ssh®.

Enter passphrase (empty for no passphrase):

Enter same passphrase again:

Your identification has been saved in /home/ofsaapp/.ssh/id_rsa.
Your public key has been saved in /home/ofsaapp/.ssh/id_rsa.pub.
The key fingerprint is:
3e:41:05:79:3a:9f:96:7c:3b:ad:e9:58:37:bc:37:e4

ofsaapp@OFSASERVER:~> cat /home/ofsaapp/.ssh/id_rsa.pub >> /home/ofsaapp/.ssh/authorized_keys

In case, you are generating SFTP Private key for Hive server, append the content of
/home/ofsaapp/.ssh/id_rsa.pub to the Hive server authorized_keys file located at
$HOME_DIR_HIVE/.ssh folder.

Ensure the following permissions exist for the given folders:
*  Permission of .ssh should be 700

»  Permission of .ssh/authorized_keys should be 640
»  Permission of .ssh/id_rsa should be 400

»  Permission of Unix user created should be 755

Configure Infrastructure Server Memory

The memory settings for Infrastructure Application Server, Tomcat, and WebL ogic can be
edited for customizing memory settings and garbage collector settings depending on the
available hardware configuration as explained below. These settings are the base minimum and
have to be incremented considering the deployment metrics into account. The increments are
usually handled in multiples of 128 MB for heap and 64 MB for the stack.

Configuring Infrastructure Application Server Memory Settings
You can configure the Infrastructure Application Memory settings as follows:

1. Locate the .profile file.

2. Edit x_aRracs field in this file for customizing memory settings and garbage collector
settings depends on the hardware configuration.

This has a default value X_ARGS="-Xms200m"

X_ARGS=" "$X_ARGS" SDELIM -Xmx2048m"
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Note: Modify X_ARGS_APP variable inthe .profile file to customize
Java Memory Settings for Model Upload based on the Data Model size.

For Run and Rule executions, the following value is recommended:

X_ARGS_RNEXE="-Xmslg -Xmxlg -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=512M -XX:+UseParallel01dGC
-XX:+DisableExplicitGC"

X_ARGS_RLEXE="-Xmslg -Xmxlg -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=512M -XX:+UseParallel01dGC
-XX:+DisableExplicitGC"

Configuring Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet Explorer, that
is, 100%.
Cookies should be enabled.

The following browser settings must have specified at every client machine before accessing
the Infrastructure application.

1.

Open Internet Explorer. Select Tools > Internet Options. The Internet Options window
is displayed.

Click Settings. The Settings window is displayed.
Select Everytime | Visit the webpage option and click OK.
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Figure I-1 Internet Options - Website Data Settings

Internet Options ‘QS@ I Website Data Settings L _@
General |Set:|.||'it5-I I Privacy I Content I Connections I Programs I Advancedl Temporary Internet Files |His1:<:r\-I | Caches and daiabases|
Home page Internet Explorer stores copies of webpages, images, and media
for faster viewing later.
To create home page tabs, type each address on its own line.
lf'l - Check for newer versions of stored pages:
- about:blank -

(@) Every time I visit the webpage

- () Every time I start Internet Explorer

) Automatically
’ Use current ] [ Use default ] [ Use new tab ) Never
Startup Disk space to use (3-1024ME) 250 =
() Start with tabs from the last session (Recommended: 50-250ME)
@ Start with home page Current location:
Tabs C:\Users'anekuria\AppDataiLocalMicrosaft\Windows Temporary
Internet Files),
Change how webpages are displayed in tabs.
Browsing histary [ Move folder. .. ] [ View objects ] [ View files ]
Delete temporary files, history, cookies, saved passwords, and web
form information. [ aK ] [ Ganced

[T]Delete browsing history on exit L

’ Delete... ][ Settings ]

Appearance

Colors ]’ Languages ” Fonts ]’ Accessibility ]

[ oK ][ Cancel ] Apply

4. In the Internet Options window, select the Security tab and select the Internet option
under Select a zone to view or change the security settings.

5. Click Default Level under the Security level for this zone.
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Figure I-2 internet Options - Security

© © N o

11.

Internet Options L® EE |

General | Security |Pri\u'aquI | Content I Connections I Programs | Ad\rancedl

Select a zone to view or change security settings,

@ &« v O

Internet  Localintranet Trusted sites  Restricted
sites

Internet

Q This zone is for Internet websites,
except those listed in trusted and

restricted zones.

o)
i
w

Security level for this zone
Allowed levels for this zone: Medium to High
Medium-high
- Appropriate for most websites
=) - Prompts before downloading potentially unsafe
content
- Unsigned ActiveX controls will not be downloaded

Enable Protected Mode (requires restarting Internet Explorer)
Custom lewvel. .. Default leve

[ Reset all zones to default level ]

’ oK ] [ Cancel Apply

Click OK to save.

Click Internet Explorer, then Tools, and then click Compatibility View Settings.
Enter the OFSAA setup URL in the Add this website field.

Click Add.

Ensure the URL is listed under the Websites you've added to Compatibility View.

In the Internet Options window, select the Privacy tab and select the Turn on Pop-up
Blocker option under Pop-up Blocker settings.
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Internet Opticns | @ | %

i General i Security | Privacy iConhent | Connections I Programs | Advanced|

Settings
Select a setting for the Internet zone.

Medium

- Blocks third-party cookies that do not have a compact
privacy policy
- Blocks third-party cookies that save information that can

) be used to contact you without your explicit consent
- Restricts first-party cookies that save information that
can be used to contact you without your implicit consent
[ Sites ] l Import ] [ Advanced ] Default
Location -
| Neve_r allow '.i\_'ebsibes to request your Clear Sites
— physical location
Pop-up Blocker -
[¥] Turn on Pop-up Blocker Settings
InPrivate

[V] Disable toolbars and extensions when InPrivate Browsing starts

| OK H Cancel H Apply

l

Pop-up Blocker Settings

Exceptions

F
2!

Address of website to allow:

Pop-ups are cumently blocked. You can allow pop-ups from specific
websites by adding the site to the list below.

Allowed sites:

*oracle.com

* praclecorp.com
* oraclevpn.com

Remove all...

Motifications and blocking level:
Play a sound when a pop-up is blocked.
[¥] Show Motification bar when a pop-up is blocked.

Blocking level:

lMedium: Block most automatic pop-ups - |

Close

Leam more about Pop-up Blocker

g
—

12. Click Settings. The Pop-up Blocker Settings window is displayed.

13. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.

14. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

15. Click Close.

16. Click OK in the Internet Options window.

Retrieve Patch Information

To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.

Navigate to the Object Administration tab.

2

3. Click System Utilities.
4. Click Patch Information.
5

The window displays the list of patches installed on the OFSAA setup across Applications

or Platform.

Setting OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAAL.

The following parameters must be set to ensure that the system limitations are not exceeded at
any stage. The values for these OS parameters should be specified based on the expected load

at each implementation site.
For example:
Process Memory Limit

Max Thread Stack Size
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Max Number of Threads per Process

»  Sort Buffer settings: This must be set at the Essbase application-level appropriate to the
anticipated load.

»  Shutdown and Restart: During the shutdown of the OFSAAI Server that has an instance
of Data Services that is communicating with an OLAP Data Server, it is imperative to
ensure that the cleanup of the old instance is completed on the OLAP Data Server before
restarting the OFSAAI Server. Pause for a period based on the load the system was
subjected to, before restarting the Data Services subsystem.

Changing IP/ Hostname, Ports, and Deployed Paths of OFSAA Instance

For information on this section, see OFS Analytical Applications Infrastructure Administration
User Guide in OHC Documentation Library.

Executing OFSAAI Setup Information Fetching Tool

Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the
related information about the OFSAAI Set up such as Operating System Name and \ersion,
Database Type and Version, OFSAAI architecture, logfile locations and so on.

To execute "SetupInfo.jar" in console, follow these steps:
1. Navigate to the path $FIC_HOME.
2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Executing Encryption Changer

For more information on Encryption Changer, see the Key Management section in OFSAAI
Administration Guide.

Setting Infrastructure LDAP Configuration
For more information on LDAP configuration, see OFSAAI Administration Guide.

Enabling Parallel Execution of DML statements

A configuration file, OracleDB.conf has been introduced to accommodate any configurable

parameter related to operations on the oracle database. If you do not want to set a parameter to
a specific value, then the respective parameter entry can be removed/commented off form the

OracleDB.conf file which resides in the path $FIC_DB_HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML
operation if parallel DML is explicitly enabled in the session with the ENABLE PARALLEL
DML clause of the ALTER SESSION statement. The default mode of a session is DISABLE
PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not set, then the default degree,
as decided by Oracle will be used.

Configuring Message Details in Forms Designer

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries
module by updating the details of the mail server in the "NotificationConfig.cfg" file
which resides in the path $FIC_APP_HOME/common/FICServer/conf.
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Ensure that the "authorized User details™ for whom you need to configure the Message details
are included in Administration > Security Management > User Administrator > User
Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Table I-1 NotificationConfig.cfg File

Parameter Description

SMTP_SERVER_IP Specify the hostname or IP address of the SMTP Server.

SMTP_DEBUG_MODE To run the SMTP service in Debug mode, set value to
‘true’, otherwise set value to 'false’.

SMTP_AUTHORIZATION Set to 'true’ if the SMTP server requires the client to be
authenticated, otherwise set to ‘false’.

SMTP_USERNAME The username is required for logging into the SMTP
server, if authentication is not required use a dummy
value.

SMTP_PASSWORD The password is required for logging into the SMTP
server if authentication is not required to use a dummy
value.

SMTP_MAILID If the Messages have to go from a Particular ID that ID

needs to be added. The exchange server forces you to set
a valid ID that is there in the exchange server. (Based on
Security settings)

Ensure that the authorized User details are included in Administration > Security Management
> User Administrator > User Maintenance window.

Clearing Application Cache
This applies to all Web Servers (that is WebLogic and Tomcat).

Before the deployment of Infrastructure or Application Service Packs / One-off patches, clear
the cache. Navigate to the following path depending on the WebServer configured and delete
the files:

* WebLogic: <Weblogic installation location>/domains/<Domain
name>/servers/<Server name>/tmp/_WL_user/<Application name>/gaelce/Jjsp_
servlet

e Tomcat: <Tomcat installation
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

Configuring Password Changes

This section explains how to modify the OFSAA Infrastructure Config Schema and Atomic
Schema passwords.

Modifying OFSAA Infrastructure Config Schema Password
To change the Config Schema password, perform the following steps:

1. Change the Config schema User Password in the database.
2. Shutdown the OFSAAI App service:
cd S$FIC_APP_HOME/common/FICServer/bin

./stopofsaai.sh
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3. Start the Infrastructure Server in foreground directly on the server or through X-Windows
software using the command:

./startofsaai.sh

4. At the prompt, enter System Password. Enter the "new Config schema™ password. The
service will start and initialize itself if it can successfully connect to the DB.

5. Post successful startup of the service, if required, the Infrastructure server may be shut
down and restarted in the background using nohup mode.

Modifying OFSAA Infrastructure Atomic Schema Password
To change the Atomic Schema password, perform the following steps:

1. Change the Atomic schema User Password in the database.

2. Log in to the application from the browser using the SYSADMN account or any user id,
which has a System Administrator role mapped.

3. Navigate to System Configuration > Database Details window. Modify the password as
explained in the following steps:

a. From the Database Master window, select the connection whose password you want
to modify and click A button from the toolbar.

b. Click 3 button corresponding to the Alias Name. The Alias Details window is
displayed.

c. Modify the password in the Auth String field.

4. If you are using Apache Tomcat as a Web server, update the <Context> -> Resource
tag details in the Server.xml file from the $CATALINA_HOME/conf folder. (In case of
Tomcat only Atomic <Resource> will exist).

If you are using WebLogic as Web server:
a. Log in to the WebLogic Administration Console, from the left side menu

b. Under Domain Structure list box, expand the appropriate Domain and navigate to
Services > JDBC >Data Sources. A list of data sources will be populated on the right
side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both
Config and Atomic data sources need to be modified).

5. Restart the OFSAAI services.

Configuring Java Virtual Machine

While running several database-intensive tasks in parallel, fetching the database connection
from the connection pool may face an error. To ensure no such error is

encountered, add the line securerandom.source=file:/dev/./Jurandom in the java.security
configuration file available in $JAVA_HOME/jre/lib/security/ path.

This needs to be configured on all the machines or virtual machines where the

OFSAAI database components (ficdb layer) are installed.

Configure Internal Service (Document Upload/Download)

This step can be ignored if it has already been configured as part of any previous IR /ML
installation.
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The Document Upload /Download feature has changed and can now be configured to use
Internal service for document upload / download instead of the earlier ExeWebService.

To facilitate Internal service for document upload or download, perform the following
configurations:

1. Create the folders download, upload, TempDocument, and Temp in the local path of the
Web application server and provide Read or Write permission.

« To find the exact location, execute the following query in CONFIG schema:
select localpath from web_server_info

»  To create folders with Read or Write permission, execute the command:
mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write
permission.

» To find the exact location, execute the query in CONFIG schema:
select ftpdrive from app_server_info

» To create a folder with Read or Write permission, execute the command:
mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to FALSE
in the Configuration table in CONFIG schema and hence the application “ExeWebService” will
not be used. It is recommended that the value be set to FALSE and use the Internal service for
document upload/ downloads. If you intend to continue using the External ExeWebService, set
the value to TRUE.

Navigate to $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier
and type ./ant.sh. This triggers the creation of EAR/WAR file EXEWebService.ear/.war. The
EAR/WAR file EXEWebService.ear/.war will be created in $FIC_
HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier. Redeploy the
generated EAR/WAR file onto your configured web application server.

Configurations to Deploy the IIABI Application
The following are the steps to configure the 11ABI Analytics:

Before you begin this process, ensure that Oracle Business Intelligence (versions 11.1.1.9.5 and
12.2.1.3.0) installation is completed and is available.

Steps to Start the IIABI Analytics for OBIEE v11.1.1.9.5
1. Set the <Oracle BI Instance Home> directory.

For example: /u01/OBIEE11G/instances/instancel
2. Start WebLogic AdminServer.
1. Setthe <BI Domain Home> directory
For Example: /u01/OBIEE11G/user_projects/domains/bifoundation_domain
2. Navigate to <BI Domain Home >/bin and execute the following command:
nohup ./startWebLogic.sh &
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Note: Bringing up this service may take a few minutes depending on your
environment. Check the logs using the command:

tail -f nohup.out

3. Start Node Manager.
1. Setthe < WebLogic Server Home> directory.
For example: /Ju01/OBIEE11G/wlserver_10.3

2. Navigate to <WebLogic Server Home>/server/bin and execute the following
command:

nohup ./startNodeManager.sh &
4. Start WebLogic Managed Server (bi_serverl).

1. Login onto http://localhost:7001/console using your Administrator credentials created
during platform install (Replace the hostname based on your setup).

2. Under the Environment tab, click the Servers link.

Domain Structure
bifoundation_domain
EH-Environment
“Servers
r—-Virtual Hosts
---Migratable Targets
~--Machines
-Work Managers
“--Startup & Shutdown Classes
—-Deployments
Bt-Services
--Security Realms
F-Interoperability

B -Diagnostics

The bi_serverl displays the shutdown state at this point.

Server ¢ Machine State Status of Last Action

|

AdminServer(admin) lalivdap RUNMING Mone

bi_serveri lalivlap SHUTDOWN TASK COMPLETED

3. Click the Control tab.
4. Select the bi_serverl line by clicking on the left tick box.

5. Click the Start button at the top of the list and confirm starting this service.
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6.

The state will update to the "RUNNING" mode after a few minutes.

Servers (Filtered - More Columns Exist)

Start | | Resume | | Suspend v | | Shutdown v | | Restart SSL

[1 | server ¢ Machine State

[ | Adminserver(admin) laliv-lap RUNMNING

bi_server1 lalivap SHUTDOWN
_Start_ Resume | | Suspend v | | Shutdown v | | Restart SSL

5. Start OBIEE services and log in.

1.

Starting services From EM screen:

6. Deploy RPD and web catalog file(s).

7. Configure tnsnames.ora file.

1.
2.

3.

Open tnsnames.ora file under the folder - <Oracle Home>/network/admin.

Make sure that an entry is made in the tnsnames.ora to connect to the atomic schema
of the OFSAA application.

Save the tnsnames.ora file.

8. Configure the ODBC data source to connect to Oracle Bl Server.

1.

2
3.
4

6.

Navigate to Control Panel>Administrative Tools>Data Sources (ODBC).
Select the System DSN tab and click the Add button.
Select a driver specific to (Oracle Bl Server 11g) and click Finish.

Enter Name and Server details (specify the Host Name or IP Address of the Bl Server)
and click Next.

Enter Oracle Bl Server login id and password (Enter User Name and Password created
at the time of OBIEE installation). Click Next.

Click Finish.

9. Modify the connection pool and set the properties.

1.
2
3
4.
5
6

Open the OBI Administration tool.

Select Start > Programs > Oracle Business Intelligence > Bl Administration.
Select File > Open > Online and select IFRS17.rpd file.

In the Open dialog box, select and open IFRS17.rpd file.

Enter the Repository password as 'Admin123'.

In the Physical layer, double-click the Connect Pool. The properties of Connection
Pool 1A is displayed.

In the General tab, edit / check the following entries:
Call Interface: (OCI 10g/119).

Data source name: <tnsnames.ora entry created in the step 8.b connecting to OFSAA
atomic schema>.

User name: <enter atomic db user name>.

Password: <enter atomic db user password>.
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Confirm password and Click OK to close the window.

Similarly, configure the connection pools for '1IABI'.

Note: Repeat similar steps from (g) above for connection pool 'Connection
Pool MR' under Database 'Market Risk'.

Click Save to save the RPD file.
Click No for the Global Consistency Message.
Close the RPD file (File / Exit).

10. Login into IIABI Application using the URL: http://localhost:<port

number>/analytics.(Replace the port number based on your setup).

Steps to Start the IIABI Analytics for OBIEE v12.2.1.3.0

1.

Set the <Bl Domain Home> directory
For Example: /Ju01/OBIEE11G/user_projects/domains/bifoundation_domain
Navigate to <BI Domain Home>/bitools/bin and execute the following command:

JStart.sh

Navigate to <BI Domain Home>/bitools/bin and execute the following command to check

the status of the services:

Jstatus.sh

Starting Services from EM Screen (For OBIEE v11.1.1.9.5 or
v12.2.1.3.0)

1.

3.
4.

Log in to the EM administration screen using the URL.: http://localhost:7001/em
(Replace the hostname and port number based on your setup).
Use the login you created in the OBIEE installation to log in.

Expand the 'Business Intelligence' node on the left and choose coreapplication.
= % Farm_bifoundation_domain
[ Application Deployments
3 weblogic Domain

@ coreapplication
[ Metadata Repositories

Click the Overview Tab.

Click Restart (or Start) under the Manage System section.
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5. Click Yes on the dialog box to confirm the action. Wait for the message that confirms the
successful restart.

Change Center: éfj Lock and Edit Configuration

Overview Capadty Management Diagnostics Security Deployment

System Shutdown & Startup

)

Up
G
System Components
System Status Manage System
fﬁ All components are available @ start O stop [ Restart

6. If the start process using EM is not successful and returning an error about OPMNCTL not
up, follow the starting process with OPMNCTL.

1. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.

2. Execute the command .Jopmnctl status. This displays the status of all the OBIEE core
services.

3. Execute the command .Jopmnctl startall or ./opmnctl stopall depending on your
requirement.

Deploy RPD File (For OBIEE v11.1.1.9.5)

1. Navigate to folder $FIC_HOME/IIABI/ which contains IFRS17.rpd file and
IFRS17.catalog file.

2. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em).
3. Click on coreapplication from the Business Intelligence tab on the left-hand side.

4. Under coreapplication, select the Deployment tab and click Lock and Edit
Configuration button. The following screen is displayed:

Lt eomrapplication |

v o .
e iteboerer rates - g S iy B 1o M T

TP ] b ey g e Comligurmion i s sy el ey B

Overves  Capacky Mawigeeént  Dagweics  Secs®y  Dephiyest

rrmeipen  Hepemesy | Siwdee  Mwkewy e

B Server Reposiony Fecy Apply Button
Mo mwciion e e Carerd rutaked B0 Fw con e Smowcton 5 ondgue s vaned 357 oo
o e AR barges 105 L

lipioad & Serve Repost ory

e 7 W 1 Lt T FPD S b oy B ST SO Yo MY NS LS 9T SACONT ST £ Semmre 8 martabl S A 0T (WL sl

taton Cat
e P e it of a ¥ > R Rt o vt pte, s e S
Cataleg location
ERACLE P S i oy O el g - R p—

5. Select Browse button available under Upload Bl Server Repository section and select
IFRS17.rpd file from the local folder. Enter the Repository password Admin123.
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Deploy RPD File (for OBIEE v12.2.1.3.0)

Ca'.ains':cav:r',-_mu:;'

1. Navigate to folder $FIC_HOME/IIABI/ which contains IFRS17.rpd file and save the file
to a local folder.

2. Copy the IFRS17.rpd file from the local folder to the folder <BI Domain
Home>/bitools/bin folder.

3. Execute the following command in the same directory as in the preceding step:
Jdatamodel.sh uploadrpd -1 <RPD_FILE_NAME.rpd> -Sl ssi -U <WEBLOGIC_
USERNAME>
-P <WEBLOGIC_PASSWORD>
For example:

Jdatamodel.sh uploadrpd -1 1FRS17.rpd -Sl ssi -U weblogic -P weblogic123

4. Login to OBIEE - Enterprise Manager URL - (http://<ip address>:<port>/em).

5. Expand the Business Intelligence node on the left and choose coreapplication.

6. Select the Deployment tab and click Lock and Edit configuration button. The following
screen is displayed:

Activate Changes 'r—r.g_nmgrb B st Owges | Ty Athane T N L a—pry— E

rrmeipen  Hepemesy | Siwdee  Mwkewy e

lipiad &l Server Reposaory

2o 1 Lt e FPD Tt 3 camE Y 13 B ST S, YO MY D L S SRCONT T N Smrt ) Wk S S0 o PTVELE Lt

B Presemitabon Cotalog

7.

Select Browse button available under Upload Bl Server Repository section and select
IFRS17.rpd file from the local folder.

Web Catalog Deployment (for v11.1.1.9.5)

1.

Create a new web catalog folder for the 11ABI application through the Enterprise Manager
of OBIEE.

Set the Catalog Location available under Bl Presentation Catalog as follows:

$ORACLE_
INSTANCE/bifoundation/OracleBIPresentationServicesComponent/$SCOMPONENT _
NAME/catalog/I1ABI

Click Apply and then click Activate changes. A pop up is displayed after successful
activation.

Click Close and switch to the Capacity management tab.

Restart the Presentation services. Under the System Components Availability, select
Presentation Services and click on Restart Selected option.

Once the Presentation Service is restarted, it displays the pop up notifying the successful
restart.
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Click Close.
Verify that the new folder structure is created in the system.
It can be found under the following folder:

<Oracle BI Instance
Home>\bifoundation\OracleBIPresentationServicesComponent\coreapplication_
obips1\catalog\lIABI

Catalog File Deployment (for OBIEE v11.1.1.9.5 and 12.2.1.3.0)

1.

Open the Catalog Manager from the OBIEE client. Navigate to File menu and open the
catalog online (File->Open catalog) by giving the necessary credentials based on the setup
(Type - (online), URL - (http://<ipaddress>:<port>/analytics/saw.dll).

Once the catalog is opened, it displays a folder structure on left-hand side. Select the
shared folder in the LHS tree structure.

Go to the File menu and select Unarchive. It asks for the path for a file.

Browse the path of the archived catalog file saved in the local folder using the Browse
button in the pop-up.

Click OK.

The catalog is unarchived in a specified location. A pop up confirming the successful
operation is displayed.

Restart the presentation services again.

Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) and login with
credentials based on the setup. Verify the availability of the catalog.

Configure tnsnames.ora file (for OBIEE v11.1.1.9.5 and 12.2.1.3.0)

1.
2.

Open tnsnames.ora file present under the folder <Oracle Home>/network/admin.

An entry should be made in the tnsnames.ora to connect to the atomic schema of the
OFSAA application.

Save the tnsnames.ora file.

Configure ODBC Data Source to Connect to Oracle Bl Server (for
OBIEE v11.1.1.9.5 and 12.2.1.3.0)

1.

From your local machine, navigate to Control Panel>Administrative Tools>Data Sources
(ODBC).

Select the System DSN tab and click Add.
Select a driver specific to (Oracle Bl Server 11g) and click Finish.

Enter Name and Server details (specify the Host Name or IP Address of the BI Server) and
click Next.

Enter Oracle BI Server login ID and password (enter the User Name and Password created
at the time of OBIEE installation).

Click Next.
Click Finish.
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Modify Connection Pool and Set the Properties (for OBIEE v11.1.1.9.5
and 12.2.1.3.0)

1.
2.
3
4.
5
6

10.
11.

12.

13.

Open the OBI Administration tool.

Navigate to Start > Programs > Oracle Business Intelligence > Bl Administration.
Select File > Open > Online and select IFRS17.rpd file.

In the Open dialog box, select and open IFRS17.rpd file.

Enter the Repository password as Admin123.

In the Physical layer, double-click the Connect Pool.

The properties of Connection Pool I1A is displayed.

In the General tab, edit and check the following entries:

e Call Interface: (OCI 10g/11g)

» Data source name: <tnsnames.ora entry created in the step 8.b connecting to OFSAA
atomic schema>

e User name: <enter atomic db user name>
e Password: <enter atomic db user password>

Confirm password and Click OK to close the window.

Note: Similarly, configure the connection pools for [1ABI.

Click Save to save the RPD file.
Close the RPD file (File/Exit).

Login into 11ABI Application using the following URL.:
http://localhost: <portnumber>/analytics.

Replace the port number based on the setup.

Navigate to Administration link and click Reload Files and Metadata to load the
metadata in the reports and clear the cache.

Navigate to Manage Sessions and click Close All Cursors to clear cursor cache.
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Patching OFSAA Infrastructure Installation

Patching Your OFSAA Infrastructure Installation

Oracle strongly recommends installing the latest available patch to be up to date with the
various releases of the OFSAA product.

Refer http://support.oracle.com for more information on the latest release.
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Grants for Atomic/ Config Schema

This section mentions about the various grants required for the CONFIG and ATOMIC

schemas.

This section discusses the following sections:

»  Configuring Grants for Atomic Schema

»  Configuring Grants for Config Schema

»  Configuring Grants for Config Schema Entities for Atomic Users

Configuring Grants for Atomic Schema

Atomic Schema creation requires certain grants for object creation. This can be located in the
SFIC_HOME/privileges_atomic_user.sgl file.

The following are the Grants for Atomic Schema:

grant create
/
grant create
/
grant create
/
grant create
/
grant create
/
grant create
/
grant create
/
grant select
/
grant create

/

SESSION to &database_username

PROCEDURE to &database_username

SEQUENCE to &database_username

TABLE to &database_username

TRIGGER to &database_username

VIEW to &database_username

MATERIALIZED VIEW to &database_username

on SYS.V_S$PARAMETER to &database_username

SYNONYM to &database_username

Grants for Atomic/ Config Schema K-65



Configuring Grants for Config Schema

Note: If you intend to use Oracle OLAP feature, execute the below grant
on all ATOMIC schema(s) grant olap_user to &database_username

Configuring Grants for Config Schema

Config Schema creation requires certain grants for object creation. This can be located in
$SFIC_HOME/privileges_config user.sql file.

The following are the Grants for Config Schema:

grant create SESSION to &database_username

/

grant create PROCEDURE to &database_username

/

grant create SEQUENCE to &database_username

/

grant create TABLE to &database_username

/

grant create TRIGGER to &database_username

/

grant create VIEW to &database_username

/

grant create MATERIALIZED VIEW to &database_username
/

grant select on SYS.V_S$PARAMETER to &database_username
/

grant create SYNONYM to &database_username

/

Configuring Grants for Config Schema Entities for Atomic
Users

Atomic Schema creation requires certain grants for config schema object access. This can be
located in $FIC_HOME/config_table_privileges_for_atomic_user.sqgl file.
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Configuring Application Pack XML Files

This section explains the configuration of OFS_IIA_PACK.xml and OFS_ IIA_SCHEMA _
IN.xml files.

This section includes the following topics:
»  Configuring OFS_IIA_PACK.xml File
»  Configuring OFS_IIA_SCHEMA_IN.XML File

Configuring OFS_IIA_PACK.xml File

The OFS_IIA_PACK.xml file holds details on the various OFSAA products that are packaged
in a particular Application Pack.

The following table gives details about the various tags/parameters available in the file and the
values that need to be updated. Before installing the OFSAA Application Pack in SILENT
mode, it is mandatory to update this file.

Note:
updated.

If you are installing in the GUI mode, then this file need not be

Table L-1 OFS_IIA_PACK.xml Parameters

Tag Name/ Attribute
Name

Description

Mandatory (Y/N)

Default Value/
Permissible Value

Comments

APP_PACK_ID

Unique
Application Pack
Identifier

Y

Unique Seeded Value

DO NOT modify this
value.

APP_PACK_NAME Unique Y Unique Seeded Value | DO NOT modify this
Application Pack value.
Name

APP_PACK_ Unique Y Unique Seeded Value | DO NOT modify this

DESCRIPTION Application Pack value.
Description

VERSION Unique release Y Unique Seeded Value | DO NOT modify this
version value.

APP Unique Y Unique Seeded Value | DO NOT remove
Application these tags.
Entries

APP_ID Unique Y Unique Seeded Value | DO NOT modify this
Application value.
Identifier
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Table L-1 OFS_IIA_PACK.xml Parameters

Tag Name/ Attribute
Name

Description

Mandatory (Y/N)

Default Value/
Permissible Value

Comments

APP_ID/ PREREQ

Prerequisite
Application/
Product

Y

Unique Seeded Value

For most applications
Infrastructure would
be the prerequisite set.
For certain other
applications, an
appropriate
Application 1D would
be set.

DO NOT modify this
value.

DO NOT modify this
value.

APP_ID/ DEF_SEL_FLAG | Default Selected Y Default - YES In all Application
Flag Packs, Infrastructure
would have this value
setto "YES". DO
NOT modify this
value.
APP_ID/ ENABLE Enable YES if installing in Default - Set this attribute-value
Application/ SILENT mode. to YES against ever
Pr%%uct YES for Infrastructure APP_ID ?/vhich is y
NO for Others licensed and should be
Permissible - YES or enabled for use.
NO Note: Application/
Product once enabled
cannot be disabled.
However,
Application/ Product
not enabled during
installation can be
enabled later through
the Administration Ul.
APP_NAME Unique Y Unique Seeded Value | DO NOT modify this
Application/ value.
Product Name
APP_DESCRIPTION Unique Y Unique Seeded Value | DO NOT modify this
Application/ value.
Product Name
VERSION Unique release Y Unique Seeded Value | DO NOT modify this

version

value.

Configuring OFS_IIA_SCHEMA_IN.XML File

Creating database schemas, objects within schemas, and assigning appropriate grants are the
primary steps in the installation process of OFSAA Applications. The OFS_IIA_SCHEMA _
IN.xml file contains details on the various application schemas that should be created before the
Application Pack installation.

The following table gives details about the various tags/ parameters available in the file and the
values that need to be updated. before executing the schema creator utility, it is mandatory to
update this file.
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Table L-2 OFS_IIA_SCHEMA_IN.xm| Parameters

Tag Name/ Attribute
Name

Description

Mandatory (Y/N)

Default Value/
Permissible Value

Comments

<APP_PACK_ID>

Unique
Application Pack
Identifier

Y

Unique Seeded Value

DO NOT modify this
value.

<JDBC_URL> Enter the JDBC Y Ensure to add an entry
URL. jdbc:oracle:thi | (with SID/SERVICE
Note: You can n:@< DBSERVER NAME) in the_
enter'RAC and IP/HOST>:<PORT> | tnsnames.ora file on
:<SID> the OFSAA server.
NON-RAC
enabled database or The entry should
connectivity URL. i i match with the SID/
jdbc:oracle:thi | SERVICE NAME
n:@<HOST/IP>:<P | used in the JDBC
ORT>:<SID> URL.
or
jdbc:oracle:thi
n:@//[HOST][:PO
RT]/SERVICE
or
Jjdbc:oracle:thi
n:@(DESCRIPTION
=(ADDRESS_
L1ST=CADDRESS=(
PROTOCOL=TCP) (H
OST=[HOST]) (por
t=[PORT])) (ADDR
ESS=(PROTOCOL=T
CP) (HOST=[HOST]
) (PORT=[PORT]))
(LOAD_
BALANCE=yes) (FA
ILOVER=yes)) (CO
NNECT _
DATA=(SERVICE_
NAME=[SERVICE])
))
<JDBC_DRIVER> By default, this Y Example: Only JDBC Thin
gg:e\:ieerds name is oracle.jdbe.driver.Ora Driver is supported.
’ cleDriver DO NOT modify this
Note: Do not edit value.
this attribute
value.
<HOST> Enter the Y Host Name/ IP
Hostname/ IP Address
Address of the

system on which
you are installing
the OFSAA
components.
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Table L-2 OFS_IIA_SCHEMA_IN.xm| Parameters

Tag Name/ Attribute

Default Value/

Name Description Mandatory (Y/N) Permissible Value | Comments
<SETUPINFO>/ NAME Enter the acronym | Y Accepts strings with a | This name would
for the type of minimum length of appear in the OFSAA

implementation.
This information

two and the maximum
of four.

Landing window as
"Connected To:

will be displayed XXXX™.
in the OFSAA Example, .
Home window. DEV, SIT, PROD The schemas being
created would get this
Note: On prefix. For example,
executing the dev_ofsaaconf, uat_
schema creator ofsaaconf, and so on.
utility, this value
will be prefixed
with each schema
name. For
example dev_
ofsaaconf, uat_
ofsaaatm.
<SETUPINFO>/ PREFIX_ | Identifies if the N YorN The default value is
SCHEMA_NAME value specified in N.
<SETUPINFO>/
NAME attribute
should be prefixed
to the schema
name.
<PASSWORD DEFAULT>/ | EnterasYifyou |Y Default - N Note: Setting this

APPLYSAMEFORALL

want to apply the
password
specified in
DEFAULT
attribute for all the
schemas.

If you enter as N,
you need to
provide individual
passwords for all
schemas.

Note: In case you
have entered Y in
APPLYSAMEFO
RALL attribute
and also have
specified
individual
passwords for all
the schemas, then
the specified
individual
passwords will
take precedence.

Permissible - Y or N

attribute value is
mandatory if the
DEFAULT attribute is
set.
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Table L-2 OFS_IIA_SCHEMA_IN.xm| Parameters

Tag Name/ Attribute
Name

Description

Mandatory (Y/N)

Default Value/
Permissible Value

Comments

<SCHEMA>/ TYPE The different Y ATOMIC/CONFIG/S | Only One CONFIG
types of schemas ANDBOX/ADDON schema can exist in
h ile.
et suppor vow sanvgox | TERE
ATOMIC and AND ADDON This schema identifies
CONFIG. sche_mas are not as the
applicable for OFS CONFIGURATION
By default, the I1A Application Pack. | schema that holds the
schemas types are OFSAA setup details
seeded based on and other metadata
the Application information.
Pack. Multi
ultiple ATOMIC/
Note: Do not edit SANDBOX/ ADDON
this attribute schemas can exist in
value. the file.
ATOMIC schema
refers to the
Information Domain
schema. SANDBOX
schema refers to the
SANDBOX schema.
ADDON schema
refers to other
miscellaneous schema
(not applicable for this
Application Pack).
<SCHEMA>/ NAME By default, the Y The permissible SETUPINFO/ NAME

schema’s names
are seeded based
on the Application
Pack.

You can edit the
schema names if
required.

Note: The Schema
Name will have a
prefix of the
SETUPINFO/
NAME attribute.

SCHEMA NAME
must be the same
for all the
ATOMIC
Schemas of
applications
within an
Application Pack.

Important: Itis
mandatory to pass
the atomic schema
user names
separately.

length is 15 characters
and only
alphanumeric
characters are
allowed. No special
characters allowed
except underscore

attribute value would
be prefixed to the
schema name being
created.

For E.g. if the name is
set as 'ofsaaatm’ and
setupinfo as 'uat’ then
schema being created
would be ‘uat_
ofsaaatm’.

NAME should be the
same where APP_
GRP=1 for all
SCHEMA tags (Not
applicable for this
Application Pack).
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Table L-2 OFS_IIA_SCHEMA_IN.xm| Parameters

Tag Name/ Attribute Default Value/

Name Description Mandatory (Y/N) Permissible Value | Comments

<SCHEMA>/ PASSWORD* | Enter the N The maximum length | Note: You need to
password of the allowed is 30 mandatorily enter the
schema to be characters. Special password if you have
created. characters are not set the
Note: If this allowed. <PASSWORD>/

APPLYSAMEFORAL

attribute is left L attribute as N.

blank, then the
password
specified in the
<PASSWORD>/D
EFAULT attribute
is applied as the
Schema Password.

<SCHEMA>/ APP_ID By default, the Y Unique Seeded Value | Identifies the
Application ID is Application/ Product
seeded based on for which the schema
the Application is being created.
Pack. DO NOT modify this
Note: Do not edit value.
this attribute
value.

<SCHEMA>/ Enter the available | N Default - USERS Modify this value to

DEFAULTTABLESPACE default tablespace associate any valid

Permissible - Any

for DB User. tablespace with the

existing valid schema
Note: If this tablespace name. '
attribute is left
blank, then
USERS is set as
the default
tablespace.
<SCHEMA>/ Enter the available | N Default - TEMP Modify this value to
TEMPTABLESPACE temporary il associate any valid
tablespace for the zjirsr.]tqilrfgl\?zlji dAny tablespace with the
DB User. temporary tablespace schema.
Note: If this name.
attribute is left
blank, then TEMP
is set as the
default tablespace.
<SCHEMA>/ QUOTA Enter the quotato | N Example: Modify this value to
be set on grant the specified
DEFAULTTABL 600M/m quota on the
ESPACE attribute 20G/g mentioned tablespace
for the schema/ UNLIMITED/unlimit to the user.
user. By default, ed
the quota size is
set to
500M.Minimum:
500M or
Unlimited on

default Tablespace

L-72 OFS Insurance IFRS 17 Analyzer Installation and Configuration Guide



Configuring OFS_IIA_SCHEMA_IN.XML File

Table L-2 OFS_IIA_SCHEMA_IN.xm| Parameters

Tag Name/ Attribute
Name

Description

Mandatory (Y/N)

Default Value/
Permissible Value

Comments

<SCHEMA>/ INFODOM

Enter the name of
the Information
Domain to
associate this
schema.

The schema
creator utility
automatically
derives an
Information
Domain Name
based on the
Application Pack
if no value is
specified for this
attribute.

Optional for Atomic
and mandatory for
sandbox

Permissible length is
16 characters and only
alphanumeric
characters are
allowed. No special
characters allowed.

<ADV_SEC_OPTIONS> Parent tag to hold | N Uncomment the tag
Advance Security and edit if you want to
Options. add security options.
For example, TDE
and Data Redact.
For details, see the
example following the
table.
<ADV_SEC_ Tag to N The default is FALSE. | Ensure this tag is not
OPTIONS>/TDE enable/disable To enable TDE, set commented if you
TDE. this to TRUE. have uncommented
<ADV_SEC_
OPTIONS>
<ADV_SEC_OPTIONS>/ Tag to N The default is FALSE. | Ensure this tag is not
DATA_REDACT enable/disable To enable DATA _ commented if you
Data Redaction REDACT, set this to have uncommented
feature. TRUE <ADV_SEC_
OPTIONS>/
<TABLESPACES> Parent tag to hold | N NA Uncomment the tag
<TABLESPACE> and edit. ONLY if
elements tablespaces are to be

created as part of the
installation.

For details, see the
example following the
table.

Note: When TDE is
TRUE in ADV_SEC_
OPTIONS, then it is
mandatory for the
<TABLESPACES>
tag to be present in the
XML file.
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Table L-2 OFS_IIA_SCHEMA_IN.xm| Parameters

Tag Name/ Attribute
Name

Description

Mandatory (Y/N)

Default Value/
Permissible Value

Comments

<TABLESPACE>/ NAME Logical Name of | Y Name if specified
the tablespace to should be referred in
be created. the <SCHEMA
DEFAULTTABLESP
ACE=
"HHENAME##">
attribute.
Note the ## syntax.
<TABLESPACE>/ VALUE | Physical Name of |Y NA Value if specified will
the tablespace to be the actual name of
be created the TABLESPACE.
<TABLESPACE>/ Specifies the Y NA Enter the absolute
DATAFILE location of the path of the file to be
data file on the created.
server
<TABLESPACE>/ Specifies if the Y ON or OFF Set to ON to ensure
AUTOEXTEND tablespace should that the tablespace
be extensible or does not run out of
have a hard limit space when full.
<TABLESPACE>/ Specifies if the Y ON or OFF Set to ON to ensure
ENCRYPT tablespace(s) that the tablespaces

should be
encrypted using
TDE.

when created are
encrypted using TDE.

Note:

Encryption of tablespaces requires enabling Transparent Data

Encryption (TDE) on the Database Server.

Example: (The following snippet shows that TDE is enabled and hence the tablespace has been
shown with encryption ON.)

<ADV_SEC_OPTIONS>
<OPTION NAME="TDE" VALUE="FALSE"/>

<OPTION NAME="DATA_REDACT" VALUE="FALSE" />
</ADV_SEC_OPTIONS>

<TABLESPACES>

<TABLESPACE NAME="'OFS_AAIl_TBSP_1" VALUE="TS_ USERS1"
DATAFILE="/scratch/oral2c/app/oracle/oradata/OFSPQA12CDB/ts
usersl.dbf" SIZE="500M" AUTOEXTEND="'ON" ENCRYPT="'ON"" />

<TABLESPACE NAME="'OFS_AAIl_TBSP_2" VALUE="TS_ USERS2"
DATAFILE="/scratch/oral2c/app/oracle/oradata/OFSPQA12CDB/ts
users2.dbf" SIZE="500M" AUTOEXTEND=""ON" ENCRYPT="'ON"" />

</TABLESPACES>
<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="'" APP_ID="0OFS_
AAI'" DEFAULTTABLESPACE=""##0FS_AAIl_TBSP_1##"
TEMPTABLESPACE=""TEMP" QUOTA="unlimited"/>
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<SCHEMA TYPE="ATOMIC' NAME="ofsaaatm' PASSWORD=""' APP_ID=""0FS_
AAAI" DEFAULTTABLESPACE=""##0FS_AAI_TBSP_2##"
TEMPTABLESPACE=""TEMP" QUOTA="unlimited”™ INFODOM=""OFSAAAIINFO"/>

</SCHEMAS>
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Configuring OFSAAI_InstallConfig.xml File

This section gives details about the OFSAAI_InstallConfig.xml file.

Configuring OFSAAI_InstallConfig.xml file
To configure the OFSAAI_InstallConfig.xml file, follow these steps.
1. Navigate to OFS_IIA_PACK/OFS_AAl/conf/ directory.

2. Open the file OFSAA

I_InstallConfig.xml in the text editor.

3. Configure the OFSAAI_InstallConfig.xml as mentioned in Table M-1, " OFSAA

Infrastructure Installat

ion Tasks and Descriptions".

4. You must manually set the InteractionVariable parameter values as mentioned in the table.
If a value is not applicable, enter NA and ensure that the value is not entered as NULL.

Table M—1 OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable
Name

Significance and Expected Value

Mandatory

InteractionGroup name="WebServerType"

WEBAPPSERVERTYPE

Identifies the web application server on which the
OFSAA Infrastructure web components would be
deployed.

The below numeric value should be set depending on
the type:

e Apache Tomcat =1
*  Oracle WebLogic Server =3

For example, <InteractionVariable
name="WEBAPPSERVERTYPE">3</InteractionVari
able>

Yes

InteractionGroup name="0

FSAA Infrastructure Server Details"

DBSERVER_IP

Identifies the hostname or IP address of the system on
which the Database Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable
name="DBSERVER_
IP">14.15.16.17</InteractionVariable> Or
<InteractionVariable name="DBSERVER_
IP">dbhost.server.com</InteractionVariable
>

Yes
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Table M-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable
Name

Significance and Expected Value

Mandatory

InteractionGroup name="D

atabase Details"

ORACLE_SID/SERVICE_
NAME

Identifies the Oracle DB Instance SID or SERVICE_
NAME

Note: The Oracle_SID value should be the same as it
is mentioned in JDBC_URL.

For example, <InteractionVariable
name="ORACLE_SID/SERVICE_
NAME">ofsaser</InteractionVariable>

Yes

ABS_DRIVER_PATH

Identifies the directory where the JDBC driver
(ojdbc<version>. jar) exists. This would typically
be the SORACLE_HOME/jdbc/1lib

For example, <InteractionVariable name="ABS_
DRIVER_PATH">">/oradatab/revwb7/oracle
</InteractionVariable>

Note: Refer to Appendix O section for identifying the
correct "ojdbc<version>.jar" version to be copied.

Yes

InteractionGroup name="0

LAP Detail"

OLAP_SERVER_
IMPLEMENTATION

Identifies if the OFSAA Infrastructure OLAP
component needs to be configured depending on
whether you intend to use the OLAP feature. The
below numeric value should be set depending on the
choice:

* YES-1
* NO-0

No

variables are set in.profile:
ARBORPATH, HYPERION HOM

E, and ESSBASEPATH.

Note: If the value for OLAP_SERVER IMPLEMENTATION is Set to 1, it checks for following environment

InteractionGroup name="SFTP Details"

SFTP_ENABLE

Identifies if the SFTP (Secure File Transfer Protocol)
feature is to be enabled. The below numeric value
should be set depending on the choice:

. For SFTP, set this field to 1 or -1.
e For FTP, set this fieldto -0

Yes

change this selection later by

OFSAAI server.

using the OFSAAI administration interface.

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle
recommends using SFTP instead of FTP because SFTP is considered more secure. However, a client
may choose to ignore this recommendation and to use FTP by setting SFTP_ENABLE to 0. You can

Set SFTP_ENABLE to -1 to configure ftpshare and web local path as local path mounted for the

FILE_TRANSFER_PORT

Identifies the port used for the file transfer service.
The default value specified is 22 (SFTP). Specify
default value as 21 (FTP) if SFTP_ENABLE is 0.
Alternatively, this value can be any Port configured by
System Administrators to support SFTP/FTP.

For example, <InteractionVariable
name="FILE_TRANSFER_
PORT">21</InteractionVariable>

Yes

InteractionGroup name="Locale Detail"
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Table M-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable
Name

Significance and Expected Value

Mandatory

LOCALE

Identifies the locale information to be used during the
installation. This release of the OFSAA Infrastructure
supports only US English.

For example, <InteractionVariable
name="LOCALE">en_US</InteractionVariable>

Yes

respective port is enabled.

InteractionGroup name="OFSAA Infrastructure Communicating ports"

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default
values mentioned below are set in the installation. If you intend to specify a different value, update the
parameter value accordingly, and ensure this port value is in the range of 1025 to 65535 and the

JAVAPORT 9999 Yes
NATIVEPORT 6666 Yes
AGENTPORT 6510 Yes
ICCPORT 6507 Yes
ICCNATIVEPORT 6509 Yes
OLAPPORT 10101 Yes
MSGPORT 6501 Yes
ROUTERPORT 6500 Yes
AMPORT 6505 Yes

InteractionGroup name="Web Details"

Note: If the value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a
trusted CA, and the same is configured on your web application server.

Application Server IP/ Hostname, to be used for
accessing the UI. This IP would typically be the
HTTP Server IP.

If no separate HTTP Server is available, the value
should be Web Application Server IP/Hostname.

For example, <InteractionVariable name="WEB_
SERVER_
IP">10.11.12.13</InteractionVariable>

or

<InteractionVariable name="WEB_SERVER_
IP">myweb.server.com</InteractionVariable>

HTTPS_ENABLE Identifies if the Ul should be accessed using HTTP or  |Yes
HTTPS scheme. The default value set is 0. The below
numeric value should be set depending on the choice:

e YES-1

« NO-O0

For example, <InteractionVariable

name="HTTPS_

ENABLE">0</InteractionVariable>
WEB_SERVER_IP Identifies the HTTP Server IP/ Hostname or Web No
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Table M-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable
Name

Significance and Expected Value

Mandatory

WEB_SERVER_PORT

Identifies the Web Server Port. This would typically
be 80 for non SSL and 443 for SSL. If no separate
HTTP Server exists, the value should be the port
configured for Web Server.

Note: The port value will not be accepted as 80 if

For example, <InteractionVariable name="WEB_
SERVER_PORT">80</InteractionVariable>

HTTPS_ENABLE is 1 and as 443, if HTTPS_ENABLE is 0.

No

CONTEXT_NAME

Identifies the web application context name which
will be used to built the URL to access the OFSAA
applications. The context name can be identified from
a URL as below:

<scheme>://<host>:<port>/<context-name>/lo
gin.jsp

Sample URL:
https://myweb:443/ofsaadev/login.jsp

For example, <InteractionVariable
name="CONTEXT_
NAME'">ofsaadev</InteractionVariable>

Yes

WEBAPP_CONTEXT_
PATH

Identifies the absolute path of the exploded .ear file on
the web application server.

For Tomcat, specify the Tomcat directory path till
/webapps, such as
/oradatab/revwb7/tomcat /webapps/.

For WebLogic, provide the WebLogic home directory
path as /<WebLogic home directory
path>/bea/wlserver_10.3

Yes

WEB_LOCAL_PATH

Identifies the absolute path to any directory on the
web application server that can hold temporary files
being uploaded as part of the applications used.

Note: In case of a clustered deployment, ensure this
path and directory is the same on all the nodes.

Yes

InteractionGroup name="

leblogic Setup Details"

WEBLOGIC_DOMAIN_
HOME

Identifies the WebLogic Domain Home.

For example, <InteractionVariable
name="WEBLOGIC_DOMAIN_

HOME">/home/weblogic/bea/user_
projects/domains/mydomain

</InteractionVariable>

Yes Specify the
value only if
WEBSERVERT
YPE issetas 3
(WebLogic)

InteractionGroup name="OFSAAI FTP Details"
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Table M-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable
Name

Significance and Expected Value

Mandatory

OFSAAI_FTPSHARE_
PATH

Identifies the absolute path to the directory identified
as the file system stage area.

Note:

e The directory should exist on the same system on
which the OFSAA Infrastructure is being
installed (can be on a separate mount).

e The user mentioned in the APP_SFTP_USER_
ID parameter below should have RWX
permission on the directory.

For example, <InteractionVariable name="APP_
FTPSHARE_
PATH">">/oradata6/revwh7/ftpshare</Interactio
nVariable>

Yes

OFSAAI_SFTP_USER_ID

Identifies the user who has RWX permissions on the
directory identified under the aforementioned
parameter APP_FTPSHARE_PATH.

Yes

OFSAAI_SFTP_
PRIVATE_KEY

Identifies the SFTP private key for OFSAAL.
For example,

<InteractionVariable name="OFSAAI_SFTP_
PRIVATE_KEY">/home/ofsaapp/.ssh/id_
rsa</InteractionVariable>

By default, the value is NA, which indicates password
will be prompted for the user <OFSAAI_SFTP_
USER _ ID> for authentication.

For more information on generating SFTP Private key,
see the Setting Up SFTP Private Key section.

No

OFSAAI_SFTP_
PASSPHRASE

Identifies the passphrase for the SFTP private key for
OFSAAL.

For example,

InteractionVariable name="OFSAAI_SFTP_
PASSPHRASE">enter a pass phrase
here</InteractionVariable>

By default, the value is NA.

No

InteractionGroup name="Hive Details"

The default value set for the interaction variables under this group is set as NA. These are required only

for Hive Configuration.

HIVE_SERVER_PORT

Identifies the port used for the file transfer service. The
default value set is 22 (SFTP). Set this value as 21 for
FTP.

For example,

InteractionVariable name="HIVE_SERVER _
PORT">22</InteractionVariable>

Yes, only for
HIVE
Configuration

HIVE_SERVER_
FTPDRIVE

Identifies the absolute path to the directory identified
as the file system stage area of the HIVE server.

For example,

InteractionVariable name="HIVE_SERVER _
FTPDRIVE">/scratch/ofsaa/ftpshare</InteractionVari
able>

Yes, only for
HIVE
Configuration
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Table M-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable

HIVE_SERVER_FTPDRIVE.
For example,

InteractionVariable name="HIVE_SERVER_FTP_
USERID">ofsaa</InteractionVariable>

Name Significance and Expected Value Mandatory
HIVE_SERVER_FTP_ Identifies the user who has RWX permissions on the  |Yes, only for
USERID directory identified under the preceding parameter HIVE

Configuration

HIVE_SERVER_FTP_
PROTOCOL

If the HIVE_SERVER_PORT is 21, then set the value
as FTP, else set it as SFTP.

For example,

InteractionVariable name="HIVE_SERVER_FTP_
PROTOCOL">SFTP</InteractionVariable>

Yes, only for
HIVE
Configuration

HIVE.
For example,

<InteractionVariable name="HIVE_SFTP_
PASSPHRASE">NA</InteractionVariable>

By default, the value is NA.

If HIVE_SFTP_PRIVATE_KEY value is given and
this is kept as NA, then it is assumed as an empty
passphrase.

HIVE_SFTP_PRIVATE_ Identifies the SFTP private key for the HIVE server. Yes, only for
KEY For example HIVE
pie, Configuration

<InteractionVariable name="HIVE_SFTP_PRIVATE_

KEY">/scratch/testuser/.ssh/id_

rsa</InteractionVariable>

By default, the value is NA, which indicates password

will be prompted for the user <HIVE_SERVER_

FTP_USERID> for authentication.

For more information on generating SFTP Private key,

see the Setting Up SFTP Private Key section.
HIVE_SFTP_ Identifies the passphrase for the SFTP private key for | Yes, only for
PASSPHRASE HIVE

Configuration
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Migrating Excel Upload Functionality

This section provides detailed instructions to migrate excel upload functionality.

Prerequisites

The following are the prerequisites for migration.

The data model in ATOMIC schemas should be the same on the source and target setups.

OFS AAI (platform) patch level version should be the same on the source and target
setups.

PL/SQL Developer to connect and query the database.

WinSCP to connect and access the server file system.

Migrating Excel Upload

To migrate, follow these steps:

1.

Open PL/SQL Developer and logon to the source setup's configuration (CONFIG) schema
by entering the appropriate username and password.

In a new SQL window query the data of table EXCEL_MAPPING_MASTER.

Open a new session in the PL or SQL developer and log on to the target setup's
configuration (CONFIG) schema by entering the appropriate username and password.

Insert the records from the aforementioned Step 1 into this table.

In the v_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name
with the target infodom name.

Note: If all the mappings can work out of the single target Infodom, update
the same Infodom value across all rows. If only a few mappings will work
out of the target infodom, update the infodom value for selective records.
Kindly note, excel upload mappings will work only if the target infodom has
the same data model entities as used in the mappings defined on source setup.

Update the v_CREATED_BY column with the name of any user present in the target setup
that has appropriate roles to perform Excel Upload tasks.
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10.

11.

12.

13.

Note: It is mandatory to update values for v_INFODOM and V_CREATED_
BY columns.

Open WInSCP and log in a new session by entering the hostname, port number, user name,
and password to access the source setup.

Navigate to the folder referred to as FTPSHARE.

Copy the excel-entity mapping XML file(s) which are located in this folder according to
their folder structure on to your desktop. For example: /ftpshare
/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME. xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME
column of the EXCEL_MAPPING_MASTER table.

Copy the excel templates (.xls/ .xlIsx) file(s) which are located in this folder according to
their folder structure on to your desktop. For example:
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.x1ls or *.xlsx

Note: Ignore this step if files are not present at the location.

Log in a new session in WinSCP by entering the hostname, port number, user name, and
password to access the target setup.

Copy the xml file(s) from Step3 to the below location in the target setup. For example:
/ftpshare/STAGE/ExcelUpload/$TARGET INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: $TARGET INFODOM_NAME should be the target setup infodom in
which you have uploaded the appropriate data model and the name should be
the same as the v_INFODOM column value updated in EXCEL_MAPPING_
MASTER table.

Copy the xls/ xlIsx file(s) from Step 3 to the below location in target setup. For example:
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.x1ls or *.xlsx

Note: Ignore this step if files are not present at the location.
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JDBC Jar Files

The ojdbc<version>. jar file should be copied based on the Database version and the
supported Java (JDK/JRE) version. See the the following table for details.

Table O-1 JDBC Jar files version details

Oracle Database
Version

JDK/JRE Version
Supported

JDBC Jar files specific to the
release

12.2 or 12cR2

JDK 8

ojdbc8.jar for JIDK 8
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Upgrading an Existing OFSAA 8.0.x Java 7
Instance to Java 8

This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7
instance to Java 8. It consists of the following topics:

*  Prerequisites

e Upgrading OFSAA 8.0.x Java 7 instance to Java 8

e Configuring Web Application Server Configurations

»  OFSAA Generic Configurations

»  Configuring OFSAA for New Web Application Server Installation

Prerequisites
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:

» Java 8 should be installed on the OFSAA server and Web Application Server.

Upgrading OFSAA 8.0.x Java 7 instance to Java 8
To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web Application Server to Java 8. For more information, refer Configuring Web
Application Server Configurations.

2. Configure the OFSAA instance to Java 8. For more information, refer to OFSAA Generic
Configurations. For a newly installed Web Application Server, refer Configuring OFSAA
for New Web Application Server Installation

3. Restart the OFSAA services. For more information, refer the Start/Stop Infrastructure
Services section in Appendix D

4. Generate the application EAR/WAR file and redeploy the application onto your configured
web application server. For more information on generating and deploying EAR or WAR
file, refer to Appendix C.

Configuring Web Application Server Configurations

This section describes the changes to be made in the Web Application Server. Following are the
two options to perform Web Application Server Configurations which are listed as follows:

»  Upgrade the existing Web Application Server installation to Java 8

« Install a new instance of the Web Application Server with Java 8
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This section consists of the following topics:

Upgrading Oracle WebLogic Server Updates
Upgrading Apache Tomcat Server Updates

Upgrading Oracle WebLogic Server Updates

Perform the following configurations to upgrade the existing WebL ogic server instance to Java

8:
1.
2.

Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.

Edit the product.properties file. Set JAVA_HOME, WLS JAVA HOME,
JAVAHOME properties to the new Java path and java.vm.version to the new Java
version. For example,

JAVA HOME=/usr/java/jrel.8.0 45
WLS_JAVA HOME=/usr/java/jrel.8.0_45
JAVAHOME=/usr/java/jrel.8.0_45
jJava.vm.version=1.8.0 45

Navigate to <WLS_HOME>/Middleware/Oracle_Home/user__
projects/domains/<domain>/bin. Update SUN_JAVA HOME, DEFAULT _
JAVA HOME, JAVA_HOME in the setDomainEnv. sh file to point to the new Java
path. For example,

SUN_JAVA_HOME="/usr/java/jrel.8.0_45"
DEFAULT_SUN_JAVA_ HOME="/usr/java/jrel.8.0_45"
JAVA_HOME="/usr/java/jrel.8.0_45"

Clear the Application cache. Navigate to the following path and delete the files:

<Weblogic installation location>/domains/<Domain name>/servers/<Server
name>/tmp/_WL_user/<Application name>/gaelce/jsp_servlet

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps:

1.
2.

Install Oracle WebLogic Server on Java 8.

Perform the configurations for the newly installed WebLogic server. For more information
refer Configuring Resource Reference in Weblogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be set the
same as that of the existing Domain.

Note down the new Domain path to perform OFSAA Configurations.

Upgrading Apache Tomcat Server Updates

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java
7 to Java 8:

1.
2.

Log in to the Apache Tomcat Server as a non-root user.

Edit the user - profi le. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For
Example,
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JAVA HOME=/usr/java/jrel.8.0_45
Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application
name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1.
2.

Install Apache Tomcat Server 8 with Java 8.

Perform the configurations for the newly installed Tomcat server. For more information
refer Configuring Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in
/apache-tomcat-8.0.21/conf/server.xml file to that of the
existing Tomcat instance.

Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations

This section consists of the following topics:

Configuring User .profile Settings
Configuring Java 8

Configuring User .profile Settings

Perform the following configurations:

1.
2.

Login to the OFSAA Server as a non-root user.

Edit the user . profi le. Update the value for the PATH variable from JRE 1.7 to JRE
1.8. For Example,

PATH=/usr/java/jrel.8.0_45/jre
JAVA BIN=/usr/java/jrel.8.0_45/jre/bin

LD_LIBRARY_PATH=$LD_ LIBRARY_PATH:/usr/java/jrel.8.0_
45/jre/lib/amd64/server

Configuring Java 8

This section is applicable only if you upgrade the OFSAA instance from 8.x to 8.0.6.0.0. Refer
to the following instructions to extract and apply the patch.

1.

If the Oracle Database version is 12¢, copy ojdbc7.jar from $ORACLE_HOME/jdbc/lib to
the following locations:

e $FIC_HOME/utility/OFSAAGenerateRepository/lib/

»  $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/
¢ $FIC_HOME/ficdb/lib/

e $FIC_HOME/ficapp/icc/lib/

*  $FIC_HOME/ficapp/common/FICServer/lib/
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» $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/
*  $FIC_HOME/ficweb/webroot/WEB-INF/lib/
e $FIC_HOME/ficdb/etl/classes/

Note: If ojdbc6.jar is already present in any of the aforementioned folders,
you need to remove it.

2. If the Oracle Database version is 11g, copy ojdbc6.jar from $ORACLE_HOME/jdbc/lib to
the following locations:

e $FIC_HOME/utility/OFSAAGenerateRepository/lib/

*  $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/
¢ $FIC_HOME/ficdb/lib/

e S$FIC_HOME/ficapp/icc/lib/

*  $FIC_HOME/ficapp/common/FICServer/lib/

* $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

*  $FIC_HOME/ficweb/webroot/WEB-INF/lib/

«  S$FIC_HOME/ficdb/etl/classes/

Configuring OFSAA for New Web Application Server
Installation

This configuration is required only if you have freshly installed Oracle WebLogic or Apache
Tomcat Server. Follow these steps:

1. Modify the following parameters in the Configuration table present in the Config Schema
with the new deployment path in case of WebLogic or Tomcat:

» DeFiHome
« REV_IMG_PATH
« EMBEDDED_JSP_JS_PATH
2. Login to the OFSAA Server as a non-root user.

3. Navigate to $FIC_HOME/Fficweb/webroot/WEB_ INF and update the following
parameters in the web . xm1 file with the new Domain path in case of WebLogic or with
the new deployment path in case of Tomcat:

«  FIC_PHYSICAL_HOME_LOC
- FIC_HOME
« ICC_SERVLET_LOG_FILE

4. Navigate to $F1C_HOME/ficweb/webroot/conT and update the Domain path in
case of WebLogic or with the new deployment path in case of Tomcat:

* OFSAALogger .xml
 MDBLogger .xml
* RevLog4jConfig.xml
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RFDLogger .xml
ExportLog4jConfig.xml
RFDLogger .xml
PR2Logger .xml
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Removing OFSAA

This chapter includes the following sections:
» Uninstalling OFSAA Infrastructure

» Uninstalling EAR Files in WebLogic

»  Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure

This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure
product.

Before you start the uninstallation process, ensure that no open connections exist to the OFSAA
Infrastructure Config and Atomic Schemas and Infrastructure services are brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as a non-root user.

2. Navigate to the $FIC_HOME directory and execute the command:
./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the
following figure.

Figure 5-8 Uninstalling OFSAA Infrastructure

faoratechdof2aadb OFSAAT:, Aninstall ., sh

Uninstallation Started [time 3 Tue Jun 10 14:20:27 IST 2014 1]
0 G o
#%% Iriver loaded with Driver oracle,jdbc,driver,Oraclelriver

Pleaze enter Configuration schema Password @
Connected to Config Schema
Cleaning config schema ...
config schema cleaned ...
Cleaning up Infrastructure Home Dir |
Pleaze wait .,
Uninztallation Completed | Thank You [time 3 Tue Jun 10 14:21:53 IST 2014 1
A R R R R R R R R
#zcratoh/of zaadbAOFSRAT ]
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Note:

»  Uninstallation does not remove the Infrastructure application from the
Web Application Server. This has to be done manually.

« Theentries in the .profile file will have to be removed manually.

«  The files/ folders under the file system staging area (ftpshare) have to be
deleted manually.

»  All the Database objects from Atomic Schemas have to be dropped
manually.

Uninstalling EAR Files in WebLogic

On the machine that hosts WebL ogic, perform the following steps to uninstall any previously
deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<admin server
port>/console (https if SSL is enabled). The Login window of the WebLogic Server
Administration Console is displayed.

2. Log in with the WebLogic user credentials having administrator privileges.

3. From the Domain Structure LHS menu, click Deployments. The Summary of
Deployments window is displayed.

Figure 5-9 Summary of Deployments
Summary of Deployments
Control | Monitorng

This page dispiays a list of Java EE appications and stand-alone application modules that have besn instaled to thic domain, Instaled applications and modules can be started, stoppead, updated
(redepioyed), or deleted from the domain by first seCtng the apDiiaton Name an: controls on this page.

To install a new appication or module for deployment to targets in this domain, dick the Install button.

W Customize this table

Deployments
instal | | Update | | Delete | Start v Showing 1o 16f 1 Previous | Next
When work completes
Hame & S ow State Health Type Deployment Order
E‘ 3 "‘ upg7273 Stop, but continue servicing administration requests Active & oK Enterprise Application 100
ingtal | Update Delete | Startv || Stop v Showing 1to Lof 1 Previous | Next

4. Select the checkbox adjacent to the application to be uninstalled and click Stop> Force
Stop Now.

5. Click Yes in the confirmation dialog to stop the selected deployment.
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Figure 5-10 Summary of Deployments- Messages
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6. Select the checkbox adjacent to the application and click Delete to delete the selected
deployment.

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain
configuration.

Uninstalling WAR Files in Tomcat

On the machine that hosts Tomcat, perform the following steps to uninstall any previously
deployed application:

1. Comment out the Context path section from server.xml file in $CATALINA_HOME/conf
directory to avoid conflict during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:
<l--

<Context path ="/pr2test"
docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"

name="7jdbc/PR2ATM"

type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="pr2atm"

password="pr2atm"
url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"
maxActive="100"

maxIdle="30"

maxWait="10000"/>
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</Context>

-=>

Restart the Tomcat service by doing the following:

d. Log in to the "Unix server" through a terminal emulator.

e. Navigate to $catalina_home/bin directory.

f.  Stop the tomcat services using the command . /shutdown. sh
g. Start the tomcat services using the command . /startup.sh

2. Openthe URL in a browser window: http://<IP address>:<Tomcat server port>.
(https if SSL is enabled). The Tomcat home window is displayed.

3. Click the Manager App. The Connect to window is displayed.

4. Log in with the user credentials having admin rights. The Tomcat Web Application
Manager window is displayed with the list of all applications deployed in Tomcat.

Figure 5-11 Tomcat Web Application Manager
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5. Click the Undeploy link against the deployed Infrastructure application. A confirmation
message is displayed on the application /Infrastructure being uninstalled.
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Configuring Transparent Data Encryption
(TDE) and Data Redaction in OFSAA

Two features comprise Oracle Advanced Security: Transparent Data Encryption and Oracle
Data Redaction.

This section details the configurations required in case you want to enable TDE or Data
Redaction in OFSAA applications.

Transparent Data Encryption (TDE)

Transparent Data Encryption (TDE) enables you to encrypt sensitive data, such as Personally
Identifiable Information (PII), that you store in tables and tablespaces. After the data is
encrypted, this data is transparently decrypted for authorized users or applications when they
access this data. To prevent unauthorized decryption, TDE stores the encryption keys in a
security module external to the database, called a Keystore. For more details on TDE, see the
Database Advanced Security Guide.

TDE tablespace encryption enables you to encrypt all of the data stored in a tablespace. To
control the encryption, you use a Keystore and TDE master encryption key. Oracle Database
supports both software keystores and hardware, or HSM-based, keystores. A software keystore
is a container for the TDE master encryption key, and it resides in the software file system.

Configuring TDE During OFS IlA Installation Using Full Installer

This section provides information on how to enable TDE (Transparent Data Encryption) in the
database. This section consists of the following sub-sections:

»  Configuring Software Keystore and Encrypted Tablespace Creation
*  Running the Schema Creator Utility
»  Testing the Encryption

Configuring a Software Keystore and Encrypted Tablespace Creation

A software keystore is a container for the TDE master encryption key, and it resides in the
software file system. You must define a location for the key in the sqlnet.ora file so that the
database locates the keystore (one per database) by checking the keystore location in the
sglnet.ora file. After defining the location, create the keystore and open it. Set the TDE master
key after opening it and then encrypt the data.

To find whether a wallet is already existing, check the following entries:

1. The location is specified by the ENCRYPTION_WALLET_LOCATION parameter in the
sglnet.ora file.
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2. The location is specified by the WALLET_LOCATION parameter in the sglnet.ora file.

Encrypted tablespaces can share the default database wallet. However, Oracle recommends that
you use a separate wallet for transparent data encryption functionality by specifying the
ENCRYPTION_WALLET_LOCATION parameter in the sqlnet.ora file.

Note: You should have the proper privileges to perform the following
actions.

For details to configure the software keystore, perform the following steps:
1. Set the Software keystore location in the sqlnet.ora file.

The first step is to designate a location for the software keystore in the sqlnet.ora file. The
Oracle Database will check the sqglnet.ora file for the directory location of the keystore to
determine whether it is a software keystore or a hardware module security (HSM) keystore.

Note: Ensure that the directory location which you want to set for software
keystore exists beforehand. Preferably, this directory should be empty.

In a multitenant environment, the keystore location is set for the entire
multitenant container database (CDB), not for individual pluggable databases
(PDBs).

By default, the sglnet.ora file is located in the ORACLE_
HOME/network/admin directory or the location set by the TNS_ADMIN
environment variable. Ensure that you have properly set the TNS_ADMIN
environment variable to point to the correct sqlnet.ora file.

To create a software keystore on a regular file system, use the following format when you
edit the sglnet.ora file:

ENCRYPTION_WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=
(DIRECTORY=<<path to keystore>>)))
Examples:
For a regular file system in which the database name is orclb:
ENCRYPTION_WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=
(DIRECTORY=/etc/ORACLE/WALLETS/orcl)))
When multiple databases share the sqlnet.ora file:
ENCRYPTION_WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
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(METHOD_DATA=

(DIRECTORY=/etc/ORACLE/WALLETS/orcl)))

When Oracle Automatic Storage Management (ASM) is configured:
ENCRYPTION_WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=

(DIRECTORY=+disk1/mydb/wal let)))

For ASM Diskgroup:
ENCRYPTION_WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=

(DIRECTORY=+ASM_Tfile_path_of_ the_diskgroup)))

2. Create the Software Keystore.

There are three different types of Software Keystores:

Password-based Software Keystores
Auto-login Software Keystores

Local Auto-login Software Keystores

Perform the following steps to create a software keystore:

1.

Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM
privilege.

Use the following command to create password-based software keystore:
CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE "keystore_
location™ IDENTIFIED BY software_keystore_password;

keystore_location is the path of the keystore directory you want to create.
software_keystore_password is the password of the keystore that you want to create.
For example, to create the keystore in the /etc/ORACLE/WALLETS/orcl directory:

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE
*/etc/ORACLE/WALLETS/orcl™ IDENTIFIED BY password;

After you run this statement, the e-wallet.p12 file, which is the keystore, appears in the
keystore location.

Alternatively, you can create an Auto-Login or Local-Login Keystore to avoid opening
the Keystore manually every time. Use the following command:

ADMINISTER KEY MANAGEMENT CREATE [LOCAL] AUTO_LOGIN
KEYSTORE FROM KEYSTORE 'keystore_location' IDENTIFIED BY keystore_
password,;

LOCAL enables you to create a local auto-login software keystore. Otherwise, omit
this clause if you want the keystore to be accessible by other computers.
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3.

After you run this statement, the cwallet.sso file appears in the keystore location.

Note: It is important to remember the master key password (<keystore_
password>) used during the creation of the keystore. There are no ways to
retrieve the password if forgotten.

Open the Software Keystore

Depending on the type of keystore you create, you must manually open the keystore before
you can use it.

You do not need to manually open auto-login or local auto-login software keystores. This
keystore is automatically opened when it is required, that is, when an encryption operation
must access the key. If necessary, you can explicitly close any of these types of keystores.
You can check the status of whether a keystore is open, closed, open but with no master
key, or open but with an unknown master key by querying the STATUS column of the
V$ENCRYPTION_WALLET view.

Note: After you open a keystore, it remains open until you manually close
it. Each time you restart a database instance, you must manually open the
password keystore to re-enable encryption and decryption operations.

Perform the following steps to open the software wallet:

1. Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM
privilege.

2. Use the following command to open password-based software keystore:
CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY
software_keystore_password [CONTAINER = ALL | CURRENT];

software_keystore_password is the same password that you used to create the
keystore in "Step 2: Create the Software Keystore".

CONTAINER is for use in a multitenant environment. Enter ALL to set the keystore
in all of the PDBs in this CDB, or CURRENT for the current PDB.

Note: Ina CDB, open the Keystore in the ROOT (CDB$ROOT) container
and in all the associated PDBs, where TDE is enabled.

You do not need to manually open auto-login or local auto-login software
Keystores.

Set the Software TDE Master Encryption Key

Once the keystore is open, you can set a TDE master encryption key for it. The TDE
master encryption key is stored in the keystore. This key protects the TDE table keys and
tablespace encryption keys. By default, the TDE master encryption key is a key that
Transparent Data Encryption (TDE) generates.

In a multitenant environment, you can create and manage the TDE master encryption key
from either the root or the PDB.
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5.

Ensure that the database OPEN_MODE is set as READ WRITE. To find the status for a
non-multitenant environment, query the OPEN_MODE column of the VSDATABASE
dynamic view. If you are using a multitenant environment, then query the V$PDBS view.
(If you cannot access these views, then connect as SYSDBA and try the query again. In
order to connect as SYSKM for this type of query, you must create a password file for it.
See Oracle Database Administrator's Guide for more information.)

Perform the following steps to set the encryption key:

1. Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM
privilege.

2. Use the following command to set the encryption key:
CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT SET KEY [USING TAG "tag"]
IDENTIFIED BY password [WITH BACKUP [USING "backup_
identifier ]] [CONTAINER = ALL | CURRENT];:

tag is the associated attributes and information that you define. Enclose this setting in
single quotation marks (* ).

password is the mandatory keystore password that you created when you created the
keystore in "Step 2: Create the Software Keystore".

WITH BACKUP creates a backup of the keystore. You must use this option for
password-based keystores. Optionally, you can use the USING clause to add a brief
description of the backup. Enclose this description in single quotation marks (* *). This
identifier is appended to the named keystore file (for example, ewallet_time_stamp_
emp_key_backup.p12, with emp_key backup being the backup identifier). Follow the
file naming conventions that your operating system uses.

CONTAINER is for use in a multitenant environment. Enter ALL to set the key in all
of the PDBs in this CDB, or CURRENT for the current PDB.

For example,

ADMINISTER KEY MANAGEMENT SET KEY IDENTIFIED BY password
WITH BACKUP USING “emp_key backup®;

Encrypting your Data

After completing the keystore configuration, encrypt the data. You can encrypt individual
columns in a table or entire tablespaces. OFSAA recommends encrypting entire
tablespaces and the description in this section covers encrypting entire tablespaces.

Note the following restrictions on using Transparent Data Encryption when you encrypt a
tablespace:

» Transparent Data Encryption (TDE) tablespace encryption encrypts or decrypts data
during read and write operations, as compared to TDE column encryption, which
encrypts and decrypts data at the SQL layer. This means that most restrictions that
apply to TDE column encryption, such as data type restrictions and index type
restrictions, do not apply to TDE tablespace encryption.

»  To perform import and export operations, use Oracle Data Pump.

Encrypting data involves the following steps:

Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption.
Step 2: Setting the tablespace TDE master encryption key.

Step 3: Creating the Encrypted Tablespace.
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»  Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption

Prerequisite- You must set the COMPATIBLE initialization parameter for the database
to 11.2.0.0 or later. Once you set this parameter to 11.2.0.0, the change is irreversible.

Perform the following steps to set the COMPATIBLE initialization parameter:
1. Log into the database instance. In a multitenant environment, log into the PDB.
2. Check the current setting of the COMPATIBLE parameter.

For example:

Table R-1 SHOW PARAMETER COMPATIBLE

Name Type Value
compatible string 12.0.0.0
noncdbcompatible BOOLEAN FALSE

3. If you want to change the COMPATIBLE parameter, perform the following steps:
a. Locate the initialization parameter file for the database instance.

UNIX systems: This file is in the ORACLE_HOME/dbs directory and is named
initORACLE_SID.ora (for example, initmydb.ora).

b. In SQL*Plus, connect as a user who has the SYSDBA administrative privilege, and
then shut down the database.

For example:

CONNECT /AS SYSDBA

SHUTDOWN

c. Edit the initialization parameter file to use the correct COMPATIBLE setting.
For example:

COMPATIBLE =12.2.0.0

d. In SQL*Plus, ensure that you are connected as a user who has the SYSDBA
administrative privilege, and then start the database.

For example:
CONNECT /AS SYSDBA
STARTUP

e. If tablespace encryption is in use, then open the keystore at the database mount. The
keystore must be open before you can access data in an encrypted tablespace.

STARTUP MOUNT;

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY
password;

ALTER DATABASE OPEN;
e Step 2: Setting the tablespace TDE master encryption key

Make sure that you have configured the TDE master encryption key as shown in Step
4: Setting the software TDE master encryption key.

»  Step 3: Creating the Encrypted Tablespace
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After you have set the COMPATIBLE initialization parameter, you are ready to create
the encrypted tablespace.

Follow the instruction given in Running the Schema Creator Utility with Encryption
section for configuring the schema creator file to create tablespaces.

If you are enabling TDE in case of upgrade or you did not enable it during installation
and want to enable at a later point of time, see the following reference link for details
on manually creating encrypted tablespaces:

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_
config.htm#ASOAG9555

Running the Schema Creator Utility with Encryption
This section is applicable only if you want to enable TDE during installation.

Run the schema creator utility by including the encrypt=on option in the Tablespace tag in the
<<APP PACK>> SCHEMA _IN.xml file. You have to perform this procedure manually as it is
not a part of the <<APP PACK>> SCHEMA_IN.xmI.TEMPLATE originally.

Following is an example for OFS _AAAI_PACK_SCHEMA _IN.xml
<APPPACKSCHEMA>
<APP_PACK_ID>0FS_AAAIl_PACK</APP_PACK_I1D>

<JDBC_URL>jdbc:oracle:thin:@<DB_Server_1P>:1521:<DB_NAME></JDBC
URL>

<JDBC_DRIVER>oracle. jdbc.driver.OracleDriver</JDBC_DRIVER>
<HOST><OFSAA_Server_IP/HOST Name></HOST>

<SETUPINFO NAME="<PREFIX_ NAME>" PREFIX_SCHEMA NAME="'Y'/>
<PASSWORD APPLYSAMEFORALL="Y"" DEFAULT=""<PASSWORD>"'"'/>
<TABLESPACES>

<TABLESPACE NAME=""OFS_AAI_TBSP" VALUE="TS_USERS1"
DATAFILE="<ABSOLUTE PATH to TABLESPACE>/<TABLESPACE_DATA_FILE_
NAME>.dbf"* SIZE="500M" AUTOEXTEND="OFF" ENCRYPT="ON' />

</TABLESPACES>
<SCHEMAS>

<SCHEMA TYPE=""CONFIG" NAME="ofsaaconf' PASSWORD=""* APP_ID="0OFS_
AAI1" DEFAULTTABLESPACE=""##0FS_AAIl_TBSP##" TEMPTABLESPACE="TEMP"
QUOTA="unlimited" />

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm"™ PASSWORD=""" APP_ID=""0FS_
AAAI" DEFAULTTABLESPACE="##0FS_AAIl_TBSP##"" TEMPTABLESPACE="TEMP""
QUOTA=""unlimited” INFODOM=""OFSAAAI INFO"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm"™ PASSWORD=""" APP_ID=""0FS_
IPE" DEFAULTTABLESPACE=""##0FS_AAI_TBSP##" TEMPTABLESPACE="TEMP"
QUOTA=""unlimited” INFODOM=""OFSAAAI INFO"/>

</SCHEMAS>
</APPPACKSCHEMA>
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Testing the Encryption

Testing the Encryption

Test the encryption by checking if a tablespace is encrypted or not. Execute the following query
to check:

SELECT tablespace_name, encrypted FROM dba_tablespaces;

The following result is displayed, which indicates whether the TABLESPACE is encrypted or
not in the ENCRYPTED column:

Table R-2

TABLESPACE_NAME ENCRYPTED
SYSTEM No

SYSAUX No
UNDOTBS1 No

TEMP No

USERS No
ENCRYPTED_TS No

6 rows selected.

The above example indicates TABLESPACE ENCRYPTED_TS is created with Encryption
ON.

Configuring TDE in case of Upgrade

This section details the configurations required in case you want to enable TDE in OFSAA
applications after upgrade to OFSAA 8.0.6.0.0 version from a previous version. Additionally,
these configurations are required in case you did not enable TDE during the 8.0.6.0.0
installation and want to enable at a later point of time.

1. Create a new PDB (12c)/ instance (11g) on the same or different Database Server for TDE.
For more information, see Configuring a Software Keystore and Encrypted Tablespace
Creation.

2. Shutdown the OFSAAI Services

3. Export all Configuration, Atomic, and Sandbox Schemas as per the applications installed
in your OFSAA instance.

For example:

expdp SYSTEM/oracle@OFSA12C2DB DIRECTORY=data_pump_dir
DUMPFILE=0fsaaconf_ofsaaatm_%U.dmp filesize=2G
SCHEMAS=ofsaaconf,ofsaaatm LOGFILE=o0fsaaconf_ofsaaatm_exp.log

Note: The above command will create data dumps as files of 2GB size each
(multiples). Any other commands/ tools as appropriate may be used to
archive the schemas.

4. Import all schemas that are exported using the above command, into the new DB instance.

For example:
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10.

11.

12.

13.

impdp SYSTEM/oracle@OFSA12nDB DIRECTORY=data pump_dir
DUMPFILE=0fsaaconf_ofsaaatm_%U.dmp
SCHEMAS=o0fsaaconf,ofsaaatm LOGFILE=ofsaaconf_ofsaaatm imp.log

Note: Restoring the exported dumps creates Configuration and Atomic
Schema(s) with the same user credentials as that of the source, along with the
existing grants.

If schemas are restored using a tool/ mechanism other than as mentioned in
the steps 1 and 2, retain the user credentials of Configuration and Atomic
Schemas that are the same as in the Source environment, along with the
Schema grants.

Provide select grants on sys.V_$parameter to view Configuration and Atomic
Schemas of Target Environment database.

For example:

Login as sys user:

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaconf;
Grant succeeded

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaatm;
Grant succeeded

Update .profile for ORACLE_SID environment variable with new ORACLE_SID.

Update JDBC URL by executing Port Changer utility. For details on how to execute Port
Changer utility, see Changing IP/ Hostname, Ports, and Deployed Paths of OFSAA
Instance section.

Navigate to the $FIC_WEB_HOME directory and execute the following command to
trigger the creation of EAR/WAR file:

Jant.sh

The EAR/WAR file - <contextname>.ear/.war - is created in $FIC_WEB_HOME
directory.

On completion of EAR/WAR file creation, the message "BUILD SUCCESSFUL" will be
displayed.

Edit the existing Connection Pool settings to point to the new JDBC URL and verify
connections.

Clear the webserver cache and redeploy the application onto your configured web
application server.

Restart the OFSAA Services. For more information, refer to the Starting OFSAA
Infrastructure Services section.

Data Redaction

OFSAA is enhanced to enable masking of sensitive data and Personal Identification
Information (P1I) to adhere to Regulations and Privacy Policies. Oracle Data Redaction
provides selective, on-the-fly redaction of sensitive data in database query results before
display by applications so that unauthorized users cannot view the sensitive data. The stored
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data remains unaltered, while displayed data is transformed into a pattern that does not contain
any identifiable information.

Enabling Data Redaction in case of Upgrade

This section details the configurations required in case you want to enable Data Redaction in
OFSAA applications after upgrade to OFSAA 8.0.6.0.0 version from a previous version.
Additionally, these configurations are required in case you did not enable TDE during OFS
AAAI 8.0.6.0.0 installation and want to enable at a later point of time.

Perform the following steps:

1.
2.

Login as SYSDBA into the database.

Execute the file $FIC_HOME/utility/data_security/scripts/create_data_sec_roles.sgl only
once per database (PDB in the case of 12c).

Execute the following SQL statement to find out the list of atomic users from the table:

select v_schema_name from aai_db_detail where V_DB NAME <>
"CONFIG" AND V_DB_TYPE = "ORACLE*"

Execute the file $FIC_HOME/utility/data_security/scripts/grant_
data_sec_roles.sql forall atomic users found in the previous step.

From the Configuration window in the System Configuration module, select the Allow
Data Redaction checkbox.

Run the Data Redaction utility. For more details on how to run the utility, see the Data
Redaction section under Data Security and Data Privacy chapter in OFS Analytical
Applications Infrastructure Administration Guide 8.0.6.0.0.

R-106 OFS Insurance IFRS 17 Analyzer Installation and Configuration Guide


https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf

S

FAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions and error
codes noticed during OFSAAI installation.

»  Frequently Asked Questions
»  Error Dictionary

OFSAAL installer performs all the prerequisite validation check during installation. Any errors
encountered in the process is displayed with an appropriate Error Code. You can refer to the
Error Dictionary to find the exact cause and resolution to rectify the error.

Frequently Asked Questions

You can refer to the Frequently Asked Questions which has been developed with the interest to
help you resolve some of the OFSAAI Installation and configuration issues. This intends to
share the knowledge of problem resolution to a few of the known issues. This is not an official
support document and just attempts to share the knowledge of problem resolution to a few of
the known issues.

This section includes the following topics:
e OFSAAI FAQs
*  Application Pack 8.0.5.0.0 FAQs

*  Forms Framework FAQs

OFSAAI FAQs
What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in Figure 1-2, "Components of
OFSAAI".

What are the different modes of OFSAAI installation?
OFSAAI can be installed in two modes, Silent Mode, and GUI mode.
Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on
multi-tier. By default, they will be installed on the single-tier. However, OFSAA
Infrastructure can be deployed within the n-Tier architecture where the Database, Web
Server, and Web Application Server are installed on separate tiers.

Is JDK (Java Development Kit) required during the installation of OFSAA? Can it be
uninstalled after the OFSAA installation?
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JDK is not required during the installation of OFSAA and only a run time is needed for
details. Refer to the Hardware and Software Requirements, Java Runtime Environment
section.

Is JRE required during the installation of OFSAA? Can it be uninstalled after the OFSAAI
installation?

Only JRE (Java Runtime Environment) is required during the installation of OFSAA and
cannot be uninstalled as the JRE is used by the OFSAA system to work.

How do I know what is the Operating system, web servers, and other software versions that
OFSAA supports?

Refer to OFSAA Technology Stack Matrices.
What are the different files required to install OFSAAI?

The following files are required:

e setup.sh.

* envCheck.sh

»  preinstallcheck.sh

*  VeriInfo.txt

*  OFSAAInfrastructure.bin

« validatedXMLinputs.jar

*  MyResources_en_US.properties

e log4j.xml

e OFSAAI_PostlInstallConfig.xml

e OFSAAI_InstallConfig.xml

»  privileges_config_user.sql

e privileges_atomic_user.sqgl

What should I do if I get the following error message during installation, ""Execute
Permission denied"?

Please check whether all the files provided for OFSAAI installation has the execute
permissions.

To give execute permissions,
* Navigate to the path OFSAAT_80200 and execute the command
chmod 755
"Graphical installers are not.."”

If error resembles "Graphical installers are not supported by the VM. The console mode
will be used instead...” then check whether any of the X-windows software has been
installed.

Example: Hummingbird Exceed is started and configured to Graphical mode installation.

Note: Type 'xclock' from prompt and this should display clock in
graphical mode.

""No Java virtual machine could be..."
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If the error message reads "No Java virtual machine could be found from your PATH
environment variable. You must install a VM before running this program™, then

»  Check whether the "java path” is set in the PATH variable. See Table 3—-1, " Prerequisite
Information"section in this document.

»  Check whether sufficient temporary space is available.

»  Ensure that the movement of OFSAAI Installer text files to the target system is done
in the Text mode so that setup. sh file does not contain control line feed characters
("M).

What should I do if I get the following error message during installation, **OracleDriver
Files Not Found, Please Choose the Right Path To Continue™?

Check whether the provided path for Oracle Driver files is correct and whether the user has
permission to access the files.

What should I do if I get the following error message during installation, **User must have
CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE
SEQUENCE, CREATE PROCEDURE" even though the oracle schema user created has the
mentioned privileges?

OFSAAI installer validates the database details provided during installation, so ensure:

»  Whether the oracle schema user has the required set of privileges for a successful
installation.

»  Whether the oracle schema user has been created with quota privileges on tablespace
to create database objects.

See Table 3-1, " Prerequisite Information" section in this document.
The installation of OFSAAI was completed successfully! What next?

Post the successful completion of the OFSAALI installation, one has to perform the Post
Installation steps. See Chapter 6, "Post Installation Configuration”.

What is to be done when OFSAALI Installation is unsuccessful?

OFSAAL installer generates log file OFSAAInfrastructure_Install.log in the
Infrastructure Installation Directory. There is also another log file created in the path
configured in Log4j.xml. The logs of any of these reported Warnings or Non-Fatal
Errors/Fatal Errors/Exceptions should be brought to the notice of the OFSAAI Customer
Support. It is recommended not to proceed, until the reported problems are adequately
addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling
OFSAA Infrastructure in the OFS AAAI Installation and Configuration Guide Release
8.0.5.0.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same database
instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database
permissions) to the new Atomic schema.

* Log into the database as sys and connect as sysdba user.
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o Execute the file privileges_config user.sqgl available under SFIC_HOME
directory

»  Enter the database schema for which you want to grant privileges.
When should | run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFS AAI Administration
Guide available on OHC Documentation Library.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and
above.

What should I do if I get the following error message on the UNIX System terminal while
executing ./setup.sh, ""Insert New Media. Please insert Disk1 or type its location?

1. Log in as root user on the Unix machine where OFSAAI is getting installed.

2. Navigate to the path /etc/security/.

3. Editthe file 1imits.conf to add/edit a row for the UNIX user installing OFSAA:
<Unix User> soft nofile 9216

4. After saving the changes, log in as UNIX user with which OFSAALI is getting installed
and execute the command:

ulimit -n
The command should return the value 9216.
How do I verify if the system environment is ready for OFSAALI installation?

To verify the system environment meets the minimum requirements for the installation, a
Pre-Install Check utility is available within the Install Kit archive file. This utility can also
be obtained separately by contacting Oracle Support.

See Verifying System Environment section for additional information.
How do I know if the installation is completed successfully?

The OFSAA Infrastructure installation performs a post-install health check automatically
on the successful installation of the product. To rerun the post-install verification at a later
time, perform the following steps:

1. Navigate to the path $F1C_HOME (Product Installation Directory).
2. Execute the command:
./piverify.sh
What should I do if the installation in GUI mode is not invoked?

There is a set of configuration steps required to be performed during the installation in GUI
mode. Verify whether the steps mentioned under Configuration for GUI Mode Installation
section are done correctly.

What should I do if there are any exceptions or errors in installation and how to proceed?
1. Please backup the installation logs.
2. Share the backup logs with Oracle support.

What should I do if I get the following error message during OFSAAI installation on Solaris
11 system?:

"Error: OFSAAI-1108
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ORA-00604: error occurred at recursive SQL level 1
ORA-01882: timezone region not found™
Or

""Time zone cannot be set as null or 'localtime

This happens if the time zone is not set, that is NULL or it is set as "localtime’. Set the
environment variable TZ to a valid time zone region in the .profile file. For example,

TZ=Asia/Calcutta
export TZ
What should I do if the installation process is abruptly terminated or aborted?

If the installation is abruptly terminated, then the installation process will be incomplete.
To recover from this, follow these steps:

1. Drop the DB objects in the config schema created by the OFSAAI installation.

2. Openthe .profile and remove the entries made by the OFSAAI installation which
are made between the comment statements, #Beginning of entries by OFSAA
Infrastructure installation, and #End of entries by OFSAA Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSAAL installer.
4. Perform the OFSAAI installation again.

Does OFSAA support any other web server types, other than the ones stated in the tech
matrix and installation guide?

No, all the supported software and versions are stated in the OFSAA Technology Stack
Matrices.

What should I do if the database connection from the connection pool displays the following
error message, "'java.sgql.SQLRecoverableException: 10 Error: Connection reset™?

This happens while running several database intensive tasks in parallel. To correct this
error, add the line securerandom. source=file:/dev/./urandomn in the
java.security configuration file available in $JAVA_HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the
OFSAAI components are installed.

If the issue is not resolved even with the preceding settings, check the MTU(Maximum
Transmission Unit) settings on the Linux box. For details on MTU settings and updating
them, contact your system administrator.

What should I do when I get syntax errors/file not found error messages while invoking
setup.sh file from my install archive?

This could mostly happen:
*  When the installer was not unzipped rightly or corrupted during unzip.

» setup.sh file which resides within the install archive was not transferred in ASCII or
text mode, which could have corrupted the file.

To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA
Infrastructure components will be installed.
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2. Unzip the installer using the command:
unzip <OFSAAI_Installer>.zip

3. The corrupted setup. sh file would have introduced certain “M characters into the
file. You can remove *M characters from setup.sh file by following these steps:

a. Login to the server where the installer is copied.
b. Navigate to the directory OFSAAT_80200.
c. Openthe setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/4M//g

Note: To enter "M, hold the CTRL-key then press VV and M in succession.

e. Save the setup.sh file by typing: wq!
Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard
or enterprise edition. So, OFSAAI will work with standard edition as well.

We do not recommend the standard edition because it will not scale and does not support
partition pack, database security vault, or advanced analytics.

What should I do if | get the following error message while executing ./startofsaai.sh file on
the UNIX System terminal **./startofsaai.sh: /java: Execute permission denied"'?

»  Ensure the JAVA_BIN environment variable path is set on the "unix user" terminal from
where the startofsaai.sh file is invoked.

» Ensure that the .profile, where the environment/ path settings are made, has been
executed successfully.

What happens when the OFSAALI Application Server does not proceed even after providing
the system password?

Ensure that, the System Password provided when prompted should match with the "Oracle
Configuration password" provided during installation. Also, check whether the connection
to the "configuration schema" can be established through sqlplus.

Although the OFSAALI installation has been completed successfully, when OFSAAI servers
are started, and the application URL is accessed, it gives an error message ""the page cannot
be found or displayed™ or "'Could not retrieve the list of languages from Server. Please
contact the system administrator''. What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the server
startup parameters options, refer to the Starting Infrastructure Services section.

For more details on the issue, refer to the Revappserver log in $FIC_APP_
HOME/common/FICServer/logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before
installation? If yes, can it be revoked after completing the installation?

The "Oracle schema" user requires the necessary grants specified before, during, and after
the installation process. Grants provided should never be revoked as the application makes
use of these grants all the time.

Can we have a distributed OFSAAI Application Server for load balancing?
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OFSAAI Application server can be scaled out/distributed across different JVM's
(machines) based on the various services and Information Domains, in other words, Load
balancing could be achieved with the distribution of services.

Why do we need Ftpshare on all the layers? Can we have ftpshare on another machine other
than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in
Infrastructure are stored in the ftpshare directory. The ftpshare contains folders for each
Information Domain, with each Information Domain folders holding Erwin, log, and
scripts folder. The transfer of data among the Web, Application, and Database servers in
Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by
providing App server's FTP/SFTP credentials to the Web server and DB server users.

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is
installed.

Is it mandatory to provide the FTP or SFTP password?

Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare
directory and should be able to independently log in to the UNIX server.

What are the permissions required for ftpshare and when should | give them?

It is recommended to provide permissions on ftpshare in case of installations done across
different machines or VMs (multitier installation).

In the case of single-tier installation, 770 permissions can be provided if the UNIX users of
OFSAAI and web servers belong to the same Unix group.

And on any new file that is created in the ‘ftpshare' folder of any installation layer should
be granted specific/explicit permission.

Port Change utility could be used to have the Port number modified, which are currently
being used by the Infrastructure application. For more information, refer to the Changing
IP/ Hostname, Ports, and Deployed Paths of OFSAA Instance section.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup
OFSAAIL.

« SYSADMN
« SYSAUTH
* GUEST

Does OFSAAI Application support both FTP and SFTP?
OFSAAI supports both FTP and SFTP configuration.
Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the
OFSAAIL.

OFSAAI Configuration: Unable to save the server details?
»  Ensure the input User ID, Password, and Share Name are correct.
»  Ensure FTP/SFTP services are enabled.

» Have atest FTP/SFTP connection made and confirm if they are successful.
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What should I do if I get the following message while creating Information Domain, **Please
create a database and then create the information domain**?

Information Domain is mapped to only one Database; and thus before the creation of
Information Domain, at least one database details would need to exist.

What should I do if I get the following message during the startup of the backend engine
message server, "*ConnectToDatabase: FatalError, could not connect to the DB server*?

»  Verify whether a connection to the "configuration schema" can be established through
sglplus.

«  Verify the "configuration schema™ password is modified post-installation.

*  Ensure oracle database alias name created for oracle instance and oracle service name
are the same.

e On amulti-tier Installation mode, ensure TNSNAME and SID are the same in both the
Application and Database Layers.

What should I do if I get the following message during the startup of the backend engine
message server, *'Fatal Error, failed to get the user ID from LibSmsConnect™*?

Ensure Reveleus.sec file exists under the $FIC_HOME/conf directory where the Database
components are installed.

Does OFSAAI Application support LDAP authentication?
OFSAAI supports LDAP configuration and authentication.
Does OFSAAI support multiple languages?
Yes, OFSAAI supports multiple languages.
Does OFSAAI provide any data back-up features?

OFSAAI does not have a built-in backup facility. External Storage Infrastructure is
recommended for back-up.

What kind of security features does the OFSAAI provide?
OFSAAI provides security at:
»  Segment Level - Users can access only the segment they are mapped to.

«  Application Level - Users can operate only if they are mapped to appropriate role and
functions.

Does OFSAAI have the ability to enforce periodic password-change?

OFSAAI provides configurable parameters to define the number of days after which the
user password would expire and then the user is forced to change the password after the
expiration period.

What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and Lower
case characters and alphanumeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

OFSAAI now supports ERwin version 9.2 and 9.5 generated XMLs in addition to ERwin
4.1, ERwin 7.1, ERwin 7.3, and ERwin 9.0 formats.

Does OFSAAI provide the mechanism to upload Business Data model?

OFSAAI provides two mechanisms for business data model upload:
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»  Easy to use GUI based Model upload mechanism to upload the Business Data Model
through Unified Metadata Manager --> Import Model.

*  OFSAAI also provides a model upload utility "upload.sh" for uploading the business
data model through the command line parameter by executing this shell script file
under the path <FIC_HOME>/ficapp/common/FICServer/bin.

Refer the section Run Model Upload Utility of the OFS Analytical Applications Infrastructure
User Guide available on the OHC Documentation Library for details.

How do I apply the incremental change to the existing model when the Business Data model
changes?

A modified data model can be uploaded into the system and OFSAAI can compare the
changes within the data model concerning the one already present in the system and
enables propagation of incremental changes in a consistent manner.

What are the different types of uploading a business data Model?

OFSAAI supports uploading of the business data model from client desktop and also by
picking up the data model from the server location.

Can the OFSAAI "Configuration Schema' password be modified post-installation?

The OFSAAI "configuration schema" password can be modified post-installation.
OFSAAI application stores the password in the database and few configuration files, thus
any changes to the "configuration schema” password would necessitate updating in these.
Contact OFSAAI support for more details.

Can the OFSAAI "Atomic Schema' password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the
atomic schema password in the database and few configuration files, thus any change to
the atomic schema password would necessitate updating the password.

To change the Atomic Schema password, follow the steps:
1. Loginto OFSAA.

2. Navigate to System Configuration > Database Details window. Select the appropriate
connection, provide the modified password, and save.

3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator >
Define Sources window. Update the appropriate Source details.

a. If you are using Apache as Web server:

»  Update the <Context> -> Resource tag details in server .xm1 file from the
$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will
exist).

b. If you are using WebSphere as Web server:
* Log in to the WebSphere Administration Console from the left side menu.

* Navigate to Resources >JDBC >Data Sources. A list of data sources will be
populated on the right side.

»  Select the appropriate Data Source and edit the connection details. (In this case,
both Config and Atomic data sources need to be modified).

c. Ifyou are using WebLogic as Web server:

e Log in to the WebLogic Administration Console from the left side menu.
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» Under Domain Structure list box, expand the appropriate Domain and navigate to
Services > JDBC >Data Sources. A list of data sources will be populated on the
right side.

»  Select the appropriate Data Source and edit the connection details. (In this case,
both Config and Atomic data sources need to be modified).

4. Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs display the
message ORA-28000: the account is locked.

Does the upload of the Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the
client and server machines. Java memory setting varies with the data model size and the
available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in User
Interface, take more time to load than other screens?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is
continuously being updated/refreshed to cache metadata. This can be observed when you
are starting startofsaai.sh and if any of the log files (Ex: SMSService.log) in
DynamicServices.xml is being continuously refreshed for a longer time.

By default, the Metadata Logfile cache size is set to 1000. If in case the log is being
updated beyond this limit, retrospectively the preceding entries are overwritten. For
example, the 1001st entry is overwritten by deleting the first entry. This results in the
application window taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf,
depending on the currently logged count for the specific metadata.

1. Generate the Log report by executing the following query in the config schema.
select count(l), t.metadata_name, m.dsn_id
from metadata_master m, metadata_type_master t
where m.metadata_type = t.metadata_type
group by t.metadata_name, m.dsn_id

2. The preceding query returns a list of codes with their respective metadata count. You
can refer to the "metadata_type_master" table to identify the metadata name.

3. View the log report to identify the metadata which is being updated/refreshed beyond
the specified cache size limit. Accordingly, increase the cache size limit in
Dynamicservices.xml depending on the currently logged count for the specific
metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and the total measure
reported in the log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/lOFSAAI servers (Web and APP) and check the issue.
What configurations should I ensure if my data model size is greater than 2GB?

To upload a data model of size greater than 2GB in OFSAAI Unified Metadata Manager-
Import Model, you need to configure the required model size in struts.xml file
available in the path $FIC_WEB_HOME/webroot/WEB-INF/classes.
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Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can
approximately set the max size to 3GB (3221225472 bytes) as follows, to avoid size
constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring the struts.xml file, generate the application EAR/WAR file and
redeploy the application onto your configured web application server. For more
information on generating and deploying the EAR or WAR file, refer to Appendix C.

What should I do if my Hierarchy filter is not reflecting correctly after | make changes to the
underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying
Hierarchy has been changed. This can occur in hierarchy maintenance, where you have
moved a member to another hierarchy branch, and that member was explicitly selected in
the Filter and is now a child of a node that is already selected in the Filter.

Please refer Support Note for the workaround.

Can Il install an Application Pack on an existing Atomic schema/ Information Domain
created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information
Domain created manually. Application Packs can be installed only on Atomic
Schemas/Information Domain created using schema creator utility and/ or the Application
Pack installer.

What should I do if I get the following exception while trying to view the model outputs in
Model Outputs screen, **Exception ->Local Path/STAGE/Output file name (No such file or
directory)"?

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in
the webserver details window. This folder needs to be created under the local path on
every node, in case of web application server clustering.

What should I do if I get the following exception during OFSAA services startup, ""Exception
in thread ""main’ java.lang.UnsatisfiedLinkError: net (Not a directory)"?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to
point to a physical JRE installed.

What are the optimized memory settings required for the **"New'* model upload?

The following table lists the optimized memory settings required for the "New" model
upload.
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Table S-1 Optimized Memory Settings for New Model Upload

Model Upload Options

Size of Data Model
XML File

X_ARGS_APP ENV
Variable in OFSAAI
APP Layer

Pick from Server

106 MB

"-Xms1024m
-Xmx1024m

36 MB

"-Xms2048m
-Xmx2048m

815 MB

"-Xms4096m
-Xmx4096m

1243 MB

"-Xms6144m
-Xmx6144m

Model Upload Utility

106 MB

"-Xms1024m

-Xmx1024m"-Xms2048m

-Xmx2048m

336 MB

"-Xms4096m
-Xmx4096m

815 MB

"-Xms4096m
-Xmx4096m

1243 MB

"-Xms6144m
-Xmx6144m

Save New Erwin File In
Server

106 MB

"-Xms1024m
-Xmx1024m

336 MB

"-Xms2048m
-Xmx2048m

"-Xms4096m
-Xmx4096m

"-Xms6144m
-Xmx6144m

I did not enable the OFS Inline Processing Engine Application license during the installation.
However, | have enabled it post-installation, using the Manage OFSAA Product License(s) in the
Admin Ul. Are there any other additional configurations that | need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration
Guide available on OHC Documentation Library.

I get an error when | try to build an Oracle OLAP cube. What should I do?

Execute the following grant on the appropriate ATOMIC schema
grant olap_user to &database_username

How do you turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

1.

2
3.
4

Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.
In the DynamicServices.xml file, identify the section for <Service code="20">.
Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).

Repeat the same in the WEB layer too. Generate the application EAR/WAR file and
redeploy the application onto your configured web application server. For more
information on generating and deploying the EAR or WAR file, refer to the Appendix C
section.
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5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Starting
Infrastructure Services section.

Note: This setting help cache the Infodom metadata only for the infodoms
that get accessed after user login. Infodoms which are not accessed, are not
cached.

Sample code is as follows:

<SERVICE CODE="20"
CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"
SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" />

<PARAMETER NAME="BACKUP_XML" VALUE="1" />

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" />

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" />

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" />
<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" />

<PARAMETER NAME="DATASET CACHE_SIZE" VALUE="2000" />

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" />

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" />

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" />

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" />

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" />
</PARAMETERS>

</SERVICE>

While creating an Excel Mapping, after specifying the excel worksheet, the target table, and
mapping each column in the worksheet to a target table, I click SAVE and nothing happens.
But when | click CANCEL, a message pops up informing me that all changes will be
discarded", what is to be done.

Check if the version of Internet Explorer and JRE Plugin are as mentioned in the
Desktop Requirements section of this manual. If not, use the qualified versions as
mentioned.

Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.
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Can Atomic schema be shared?
Yes, it can be shared between two OFSAA instances.

While setting a firewall, which ports should be opened for communication between the Web
Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web
Application Server (WebLogic/Tomcat) for OFSAAI to operate properly?

The OFSAA Servlet port which is the same as webserver port should be open. Also, the
web application port should be open.

Can I modify the NLS LENGTH_SEMANTICS to BYTE from CHAR for the Database
where older versions of OFSAA is Installed?

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are
not intending to use multi-language support.

Can I install an already installed application in a different infodom?
No, it is not possible to install the same application in two different infodoms.
How can I configure the OFSAA application for High Availability?

OFSAA can have active-passive high availability. For more details, refer Configuration for
High Availability- Best Practices Guide.

During OFSAA installation should I provide a web application server's IP /Hostname and
port or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle HTTP
Server/ IBM HTTP Server are configured?

In case the webserver is configured, you should enter the Web Server IP Address/Hostname and
Port details during OFSAA installation. Here the Servlet port should be the same as the Web
Server port.

If Web Server is not configured, the Web Application Server's IP Address/ Hostname
and Port are required during the installation process. Here the Servlet port should
be the same as the Web application Server port.

Is "ReveleusAdminConsoleAgent™ applicable for OFSAAI 8.0.0.0.0 and higher versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is
a change in the way agent servers are managed through AGENTSTARTUP .SH &
AGENTSHUTDOWN . SH.

What should I do when the message server process does not open and I get the following error
message, ""CI18NProvider::CI18NProvider, Error, unable to connect to the config database'*?

This error is displayed due to the following reasons:
*  The Config Schema password is already expired.

» If the config schema password is going to expire soon and the message like "ORA-28002:
the password will expire within 6 days™ displays while connecting to config schema
through sqlplus.

»  The Config schema password is Modified.

To resolve the error, re-set the config schema password to the old password. Else, if the config
schema password is modified to something else then follow these steps:

1. Delete the $FIC_HOME/conf/Reveleus.SEC file.

2. Shutdown the OFSAAI App service: cd $FIC_APP_
HOME/common/FICServer/bin ./stopofsaai.sh
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3. Shutdown the OFSAAI App service: cd $FIC_APP_
HOME/Zcommon/FICServer/bin ./stopofsaai.sh

4, Start the Infrastructure Server in foreground directly on the server or through XWindows
software using the command: ./startofsaai .sh

5. Enter System Password.

6. Enter the new Config schema password. The service starts and initializes if it can
successfully connect to the DB and generates the Reve leus . SEC file.

7. Post successful startup of the service, if required, the Infrastructure server may be shut
down and restarted in the background using nohup mode.

What are the mechanism of Log File sizing and backup?

OFSAAI Log files created under $F1C_APP_HOME/common/FICServer/logs &
<OFSAAI_DEPLOYED_AREA>/<CONTEXT .war>/1ogs is configurable in
RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & the number of max
backup log files (MaxBackuplndex) retained is set to 5, both of which are configurable.
Increasing these parameters to a higher value should depend on the server HW configurations
and may reduce the performance.

To configure the Logs file size on the OFSAA Application server, follow these steps:
1. Navigate to $F1C_HOME/con¥ where OFSAA is installed.
2. Edit the following parameters in the file RevLog4 jConfig.xml

« <param name="file" : Enter the path where the Logs are to be generated.

e <param name="MaxFileSize" : Provide the required file size.

e <param name="MaxBackuplndex" : Provide the required number of backup files to be
created.

Example:

<appender name="REVSERVERAPPENDER"
class=""org.apache.log4j.RollingFileAppender'>

<param name="file" value="$FIC_
HOME/ficapp/common/FICServer/logs/RevAppserver.log/>

<param name="Append" value=""true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackuplndex' value="5" />

<layout class="org.apache.log4j.PatternLayout'>

<param name="‘ConversionPattern" value=""[REVELEUSLOG] %m%n'/>
</layout>

</appender>

To configure the Deployed area logs file, follow these steps:
1. Navigate to <EAR/WAR Deploy area>/conf folder.
2. Repeat step 2 from the preceding section.

Can we modify the Log file path?

Yes, the log file path is configurable, it can be configured in
RevLog4jConfig.xml _default log file path (file) is set by the installer. This can be
configured to another path.
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Can | point the environment with HTTP enabled to HTTPS after installation and vice versa?
For more details, see the HTTPS section in the OFSAAI Administration Guide.
What should I do if my HIVE connection fails with the following exception:
Java.sql .SQLException: [Cloudera][HiveJDBCDriver](500164)
Error initialized or created transport for authentication:

[Cloudera] [HiveJDBCDriver](500168) Unable to connect to server:
GSS initiate failed.

com.ibm.security.krb5.KrbException, status code: 37

message: PROCESS_TGS at
com.ibm.security.krb5.KrbTgsRep.<init>(KrbTgsRep. java:20)

This happens if there is a clock skew between the client and the KDC server. To resolve this,
there are two solutions:

e Solution 1:

Synchronize the clocks between the servers. For more information, refer
http://docs.oracle.com/cd/E19253-01/816-4557/setup-192/index.html

e Solution 2:

1. Set clockskew parameter on the server-side (KDC) krb5.conf file and replace the same
file in the HIVE_L1BRARY_PATH folder. Parameter value should be decided based
on the time difference between the two machines.

2. Get the epoch time on the two servers by firing “date +%s” on the command line.

3. Clockskew param value should be chosen as a value sufficiently larger than the
difference of the preceding two calculated values.

4.  Set “clockskew = <value>" in the /etc/krb5.conf on the KDC server.

5. Restart Kerberos services.
What should I do if my schema creator log has the following exception:
Failed to detect a valid hadoop home directory
java.lilo.IOException: HADOOP_HOME or hadoop.home.dir are not set.
at org.apache.hadoop.util.Shell.checkHadoopHome (Shell.java:302)
at org.apache.hadoop.util.Shell.<clinit>(Shell.java:327)

at org.apache.hadoop.util.StringUtils.<clinit>(StringUtils.java:79)
at
org.apache.hadoop.security.Groups.parseStaticMapping (Groups.java:13
0)

at org.apache.hadoop.security.Groups.<init> (Groups.java:94)
at org.apache.hadoop.security.Groups.<init> (Groups.java:74)

at
org.apache.hadoop.security.Groups.getUserToGroupsMappingService (Gro
ups.java:303)

at
org.apache.hadoop.security.UserGroupInformation.initialize (UserGrou
pInformation.java:283)
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at

org.apache.hadoop.security.UserGroupInformation.setConfiguration (Us
erGroupInformation.java:311)

at

at

HdfsDbUtil.connect (HdfsDbUtil.java:162)

SchemaParserUtil.validateHiveConnection (SchemaParserUtil.java:1359)

at

at

at

SchemaParserUtil.checkAllPreChecks (SchemaParserUtil.java:1011)
Main.execute (Main.java:317)
Main.main (Main.java:145)

This occurs when HADOOP_HOME environment variable is not set. You can ignore this
exception since we do not mandate to install HIVE where OFSAA is installed.

What should I do if the sliced data model upload takes a long time to complete?

If the metadata cache size is set to a lower value than the actual count of each metadata type
(hierarchy, dataset, dimension, etc), then it gets into performance degrade issues. We have to
increase the cache size for each metadata type according to the count in the environment.

The following are the parameters in DynamicServices.xml to be configured depends on the
metadata count in your environment.

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/>
<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/>
<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/>
<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/>
<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/>
Metadata count can be derived based on the following queries:

select count(1) from metadata_master where metadata_version=0 --- for all metadata

select count(1) from metadata_master where metadata_version=0 and metadata_type=1 --- for
measure

select count(1) from metadata_master where metadata_version=0 and metadata_type=2 --- for
Dimension

select count(1) from metadata_master where metadata_version=0 and metadata_type=3 --- for
HCY

select count(1) from metadata_master where metadata_version=0 and metadata_type=4 --- for
DATASET

select count(1) from metadata_master where metadata_version=0 and metadata_type=59 ---
for BP's

select count(1) from metadata_master where metadata_version=0 and metadata_type=54 ---
for Alias

select count(1) from metadata_master where metadata_version=0 and metadata_type=5 ---
for CUBES
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select count(1) from metadata_master where metadata_version=0 and metadata_type=856 ---
for Derived Entity

For LDAP authentication, which server connects with the LDAP server, the Application server
(where ofsaai is installed), or Web Application server (where EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP server.

The LDAP server in the setup listens on secure protocol Idaps (port 636). | have the root certificate
of the LDAP server for SSL, and would like to know where to offload this certificate?

You need to import the certificate into the JDK/JVM used by the Reveleus server in the ficapp
layer.

How to relocate the FTPSHARE folder?

You can run the PortC.jar utility. For more details, refer to Changing IP/ Hostname, Ports, and
Deployed Paths of OFSAA Instance section in the OFSAAI Admin Guide available on the
OHC Documentation Library.

How do we identify the list of ports that are used by/configured in an OFSAA environment?
1. Navigate to $FIC_HOME directory on Target.

The file PortsDef.log will be available in the $FIC_ HOME directory. It will contain the
port’s information.

What should I do if I get the following error message, ""Error while fetching open cursor value
Status: FAIL"?

This error occurs while executing envCheck . sh because the user does not have access to the
V$parameter. This error does not occur due to sysdba or non-sysdba privileges provided
they have access/grants to the V$parameter.

What should I do when an entity containing many attributes (>100 columns) is selected as a Source
entity and the Data Mapping (T2T definition) save operation takes longer than expected with the
hourglass in the Ul continuously rotating?

The workaround is:
1. Locate the webserver deployed area webroot/conf/excludeURLList.cfg file.
2. Modify the following entries:

* [SQLIA]./datalntegrator/to [ALL]./datalntegrator/

« [SQLIA]./ETLExtractionServiet to
[ALL] .ZETLExtractionServilet

3. Save the changes and restart the webserver.

4. Resave the definition.

Application Pack 8.0.5.0.0 FAQs
What is an Application pack?

An Application Pack is a suite of products. For more information, refer to About Oracle
Financial Services Analytical Applications (OFSAA) Application Packs.

Can | get a standalone installer for the OFSAA 8.0.5.0.0?
No. OFSAAI is part of every application pack and installs automatically.
How does OFSAA 8.0.5.0.0 Application pack relate to the OFSAA 7.x series?

8.0.5.0.0 is a new major release consolidating all products from the OFSAA product suite.
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Can existing OFSAA 7.x customers upgrade to OFSAA 8.0.5.0.0 Application Pack?

There is no upgrade path available. However, we will have a migration kit or path for every
product to an 8.0.5.0.0 application pack. Further details will be available with Oracle Support.

Does OFSAA 8.0.5.0.0 Application pack UPGRADE automatically existing environments?

No. Refer to Point 5. OFSAA 8.0.5.0.0 application pack has to be installed in a new
environment and subsequently migration path or migration kit needs to be run to migrate from
7.x to 8.0. Note that we will have a migration path only from the previously released version of
OFSAA products.

Where can | download OFSAA 8.0.5.0.0 Application Pack?

You can download the OFSAAI 8.0.5.0.0 Application Pack from Oracle Software Delivery
Cloud (OSDC).

What are the minimum system and software requirements for OFSAA 8.0.5.0.0 Application
Pack?

Refer to the Hardware and Software Requirements section.
Is my environment compatible with OFSAA 8.0.5.0.0 Application Pack?

Environment Check utility performs the task. It is part of the install and can also be run
separately.

Has OFSAA 8.0.6.0.0 Application Pack supports all Operating systems?

LINUX, AIX, SOLARIS. Refer to Technology Matrix for the technology matrix that OFSAA
suite products are/ will be qualified on.

How can I install the OFSAA 8.0.5.0.0 Application Pack?

Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation And
Configuration Guide published in OHC Documentation Library for the application pack
installers.

Does this installation require any Third-party Software?

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration
Guide published in OHC Documentation Library lists the third party software that needs to be
installed.

What languages are supported during the OFSAA 8.0.5.0.0 Application Pack installation?
US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent, GUI]

OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0.5.0.0 Application Pack support Multi-tier Installations?

OFSAA 8.0.5.0.0 does single-tier installation. For more information refer to the OFSAAI FAQs
section.

Does this Application Pack validate all Pre-requisites required for this installation i.e.,
Memory, Disk Space, etc.?

Yes. The pre-requisite checks are done by the respective application pack installer.

What happens if it aborts during the installation of any application within the Application
pack?

Customer needs to restore the system and retrigger the installation
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Does this Application pack 'Rolls Back® if any of the application installations fails due to
errors?

The rollback of installation is not supported.
Does the Application pack install all applications bundled?

All application pack system files are installed but there is an option to enable the licensed
products.

Can I re-install any of the Application Packs?

Yes. You can retrigger in case of failure.

Does this Application pack allow enabling or disabling any of the applications
installed?

Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in an Application pack, can I install any of the new
applications within the Application pack later?

No, installation is not required. Enabling the application is an option to use it later.
How many OFSAA Infrastructures can be installed in a single server?

There are no issue in installing separate OFSAAI installations, each with their own PFT/FTP
installations and separate associated database instances and separate Web Server installations
on the same server as long as adequate memory is allocated for each instance and as long as
each OFSAAI installation is installed using a separate UNIX user and profile. Care should be
taken if running multiple OFSAAI installations

on a single server. Adequate memory will be required for each installation as several OFSAAI
processes (model upload, DEFQ services, etc) take significant amounts of memory. So it
depends on your server’s memory.

Is it possible to Install OFSAA 8.0.5.0.0 Application pack on an existing *Infodom® where
another OFSAA 8.0.5.0.0 application is installed?

Yes. However, the Behavioral Detection Application Pack and Compliance Regulatory
Reporting Application pack are the exceptions. They need to be installed in a different
INFODOM.

Can I select an Infodom in Application pack during installation?
Yes. You can select or change the required infodom.
Can I install all Application Packs in a 'Single Infodom'?

Yes. But Behavioural Detection Application Pack and Compliance Regulatory Reporting
Application Pack are the exceptions. They need to be installed in a different INFODOM.

Is it possible to install applications on different Infodom within the Application pack? (That
is if you want to install LRM & MR in two infodoms)

Applications within the application pack have to be installed in the same information domain in
the same environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0?

You can install only one infodom during installation. But after installation, you can create
multiple infodoms.

Is the *‘Data Model" bundled specifically to an Application pack or an individual application?

A merged data model for all applications within the application pack is bundled and uploaded.
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Is it possible to install OFS Enterprise Modeling later?

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any
application pack that bundles Enterprise Modeling.

Does the Application pack create a sandbox automatically for the required applications?
Yes, Sandbox creation is part of the application install process.
Are upgrade Kits available for individual applications or the complete Application Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all
applications.

Can | upgrade AAI only?
Yes, you can upgrade AAI alone.

Can | upgrade one application within the Application Pack? i.e., LRM will be upgraded in
Treasury Application pack, but MR won't be upgraded.

No. Not possible Upgrade is applied across packs.

Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.

Can I uninstall the entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only the application and retain AAI in the installed environment?
No, you cannot uninstall only the application and retain AAI in the installed environment.
Does Application Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 application packs.

Can I install an Application Pack over another Application Pack (that is in the same infodom
or different infodom)?

Yes, you can install an Application Pack over another Application Pack in the same information
domain or different information domain. But Behavioural Detection

Application Pack and Compliance Regulatory Reporting Application Pack, Asset Liability
Management Application Pack, and Profitability Application Pack are the exceptions. They
need to be installed in a different INFODOM.

Can | use an existing manually created schema as an information domain for application
pack installation?

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.

While running the schema creator utility, I get an error **HostName in input xml is not
matching with the local hostname™?

One possible reason could be the machine is configured for zonal partitioning. Ensure all the
known IP Addresses of the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS 1A Application Pack version 8.0.6.0.0?
OFS 1A Application Pack supports Java 1.7.x and 1.8.x.
Is this release of the OFS 1A Application Pack version 8.0.5.0.0 supported on Java 8?

Yes. To install this release of the OFS I1A Application Pack version 8.0.5.0.0 on Java 8. For
more information, refer to specific notes mentioned in the sections Installer and Installation
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PrerequisitesConfigurations supported for Java 8, Configuring the Schema Creator Utility,
Installing in GUI Mode, and Installing in SILENT Mode.

What should be done if you encounter the following ""FATAL'" exception in the installation
log because of insufficient DB process value?

[FATAL] - =====Exception====

java.sgl.SQLRecoverableException: 10 Error: Got minus one from a read call

at oracle.jdbc.driver. T4CConnection.logon(T4CConnection.java:419)

at oracle.jdbc.driver.PhysicalConnection.<init>(PhysicalConnection.java:536)

at oracle.jdbc.driver. T4CConnection.<init>(T4CConnection.java:228)

at oracle.jdbc.driver. T4CDriverExtension.getConnection(T4CDriverExtension.java:32)
at oracle.jdbc.driver.OracleDriver.connect(OracleDriver.java:521)

Contact the DBA team to increase the DB process/sessions value accordingly, which depends
on the number of database process running at that particular point of time.

Can | upgrade the Oracle Database version from 11g to 12C on which OFSAA 8.0.5.0.0
version is installed?

Yes, you can upgrade. When the DB Server was Oracle 11g, the ojdbc jar used was ojdbc6.jar.
But, when the DB is upgraded to 12c, you need to upgrade the ojdbc6.jar to ojdbc7.jar.

Copy ojdbc7.jar from SORACLE_HOME/jdbc/lib to the following locations:
*  $FIC_HOME/utility/OFSAAGenerateRepository/lib/

»  $FIC_HOME/realtime_processing/WebhContent/WEB-INF/lib/

*  $FIC_HOME/ficdb/lib/

e $FIC_HOME/ficapp/icc/lib/

»  $FIC_HOME/ficapp/common/FICServer/lib/

»  $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

»  $FIC_HOME/ficweb/webroot/WEB-INF/lib/

e $FIC_HOME/ficdb/etl/classes/

What should I do when | get "[ERROR] - Error: APP Setup bin file failed.” message during
OFS_Application_PACK installation?

This is a generic error message that appears during application installation failure. You should
check the installation log files for more information about what failed the installation.
However, if the message is displayed and the log files are not generated, it could be that it is a
temp directory issue. The resolution is that your UNIX administrator has to disable the
NOEXEC option. The installers extract the installation files into the /tmp directory, and if
NOEXEC is enabled, the execution of binaries will not happen in the directory and the
installation fails. Re-run the installer after the configuration is changed. For detailed
information, see the support note at
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.

Forms Framework FAQs

What should I do when | have a large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export a large volume of
data.
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How do I export the columns added to the grid using the Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field Chooser
option.
‘Expand All/ Collapse All* button is not visible in the Hierarchy Browser window. What should |
do?
Expand All/ Collapse All button is disabled if the number of hierarchy nodes is more than 50

and if it is a non-custom hierarchy. Hierarchy with more than 50 nodes is considered as a large
hierarchy and the data will be fetched dynamically when you expand the parent node.

What is the difference between the two Searches available in the Hierarchy Browser window?

In the new Hierarchy Browser window introduced from 7.3.5.1.0 version, there are 2 search
options available as highlighted in the following figure:

(=) Hierarchy Browser - Windows Internet Explorer prmr...Eli‘ﬂ

¥ Society Details

EIN =

----- BANCO DEPOSITARIO BBWVA, 5.A

i ]
----- BBWVA SERVICIOS, 5.4

----- BBWVA SUIEA, 5.A. (BEWVA SWITZERLAND)

----- BBWVA & PARTHERS ALTERNATIVE INV AV, 5.4,

----- BBWVA ASESORIAS FINANCIERAS 5.A.

----- BBWVA ASSET MANAGEMENT (IRELAND) LIMITED

----- BBWVA ASSET MANAGEMENT ADMON.G.FONDOS, SA
----- BBWVA ASSET MANAGEMENT CONTINENTAL S.A. 5
----- BBWA ASSET MANAGEMENT, 5.A. SGIC

----- BBWVA AUTORENTING SPA

----- BBWA BANCO DE FINANCIACION 5.A.

----- BBWA BANCO FRANCES, 5.A.

----- BBWA BANCOMER GESTION, 5.4 DECV.

----- BBWVA BANCOMER OPERADORA, 5.4

----- BBWVA BANCOMER SERV ADMINISTRATIVOS, 5.A.
----- BBWA BANCOMER USA, INC.

Node HFind
Ok Cancel

» DB Search (Top search container): It will search the required node in the database and
displays the result as shown below. This search is performed on full hierarchy nodes.

» Ul search (Below the hierarchy): This search will find the required node in the Ul and
will show in the tree structure.
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Note: In case hierarchy nodes are more than 50 and if it is a non-custom
hierarchy, then the Ul search will not show the required node in tree
structure, until all the nodes are expanded and loaded manually in the UI.

What is a Custom Hierarchy?

Custom hierarchies will be having the parameter configuration customQuery as shown below
and the customized query will be taken from the HIERARCHY_FILTER_MASTER table.

Configuration in xml:
<CONTROL ID="1003" TYPE="41">
<CONTROLPROPS>
<EXTRAPARAMETERS>

<PARAMETER NAME="customQuery" VALUE="'Yes'/>
</EXTRAPARAMETERS>
</CONTROLPROPS>

</CONTROL>
For custom hierarchy, all the hierarchy nodes are loaded in Ul without any limit.

So, even if the hierarchy nodes are more than 50, the Ul search will show the required node in
the tree structure and ExpandAll and ExpandBranch images will be enabled.

Error Dictionary

This contents of this section have been created with the interest to help you resolve the
installation issues if any. There is a compilation of all the possible errors that might arise during
the installation process with the possible cause and the resolution to quickly fix the issue and
proceed further with the installation.

This section includes the following topics:
*  Accessing Error Dictionary

e Error Code Dictionary

Accessing Error Dictionary

Instead of scrolling through the document to find the error code, you can use the pdf search
functionality. In the "Find" dialog available in any of the Adobe Acrobat version that you are
using to view the pdf document, follow the below instructions to quickly find the error
resolution.

1.  With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on the window during Infrastructure installation.
4

Press Enter. The search results are displayed and highlighted as indicated below.

S-130 OFS Insurance IFRS 17 Analyzer Installation and Configuration Guide



Error Dictionary

Figure S-1 Error Code

Error code - OFSAAI-1003

Cause JAVA MHOAME 2en not fourd m PATH vanable
-

Resolution Impont <JAVA HOME »tn o PATH varable

| Exampls PATH = SIAVA_ HOMEn $PATH export PATH

View the details of the issues, its cause, and resolution specific to the error code. Repeat the
step to find an answer to any other errors that you notice during installation. If you are not able
to resolve the issue even after following the steps provided in the resolution, you can contact
support.oracle.com along with log files and appropriate screenshots.

Error Code Dictionary

Error code - OFSAAI-1001

Table S—2 Error code - OFSAAI-1001

Cause Unix shell is not a "korn" shell.
Resolution Change the shell type to "korn". Use chsh UNIX command to change the
SHELL type.

Shell type can also be changed by specifying shell path for the Unix user in
/etc/passwd file.

Note: chsh command is not available in Solaris OS.

Error code - OFSAAI-1002

Table S—3 Error code - OFSAAI-1002

Cause No proper arguments are available.
Resolution Provide proper arguments. Invoke Setup.sh using either SILENT or GUI
mode.

Example: . /Setup.sh SILENT Or ./Setup.sh GUI

Error code - OFSAAI-1004

Table S—4 Error code - OFSAAI-1004

Cause File .profile is not present in SHOME.

Resolution Create .profile in $HOME, i.e. in the home directory of a user.

Error code - OFSAAI-1005

Table S-5 Error code - OFSAAI-1005

Cause File OFsaaInfrastructure.bin is not present in the current folder.

Resolution Copy OFSAAInfrastructure.bin into installation Kit directory.
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Error code - OFSAAI-1006

Table S—6 Error code - OFSAAI-1006

Cause File CustReg.DAT is not present in the current folder.

Resolution Copy CustReg.DAT into the installation kit directory.

Error code - OFSAAI-1007

Table S—7 Error code - OFSAAI-1007

Cause File OFSAAT_InstallConfig.xml is not present in the current folder.

Resolution Copy OFSAAI_ InstallConfig.xml into installation kit directory.

Error code - OFSAAI-1008

Table S—-8 Error code - OFSAAI-1008

Cause File validateXMLInputs. jar is not present in the current folder.

Resolution Copy validateXMLInputs.jar into installation kit directory.

Error code - OFSAAI-1009

Table S-9 Error code - OFSAAI-1009

Cause File 1og4j.xml is not present in the current folder.

Resolution Copy log4j.xml into the installation kit directory.

Error code - OFSAAI-1010

Table S-10 Error code - OFSAAI-1010

Cause An Unknown error occurred.
Resolution Make sure to provide a proper argument (SILENT or GUI) to the Setup.sh
file.

Error code - OFSAAI-1011

Table S-11 Error code - OFSAAI-1011

Cause XML validation failed.

Resolution Check InfrastructurePreValidations.Log for more details.

Error code - OFSAAI-1012

Table S-12 Error code - OFSAAI-1012

Cause Property file with locale name does not exist.

Resolution Copy MyResources_en_US.properties to the setup kit directory and keep
en_US in LOCALE tag of OFSAAI_InstallConfig.xml.
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Error code - OFSAAI-1013

Table S-13 Error code - OFSAAI-1013

Cause File OFSAAT_InstallConfig.xml/OFSAAI_PostInstallConfig.xml not
found.
Resolution Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml to

the setup kit directory.

Error code - OFSAAI-1014

Table S—14 Error code - OFSAAI-1014

Cause

XML node value is blank.

Resolution

Make sure all node values except SMTPSERVER, PROXYHOST,
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD,
NONPROXYHOST or RAC_URL is not blank.

Error code - OFSAAI-1015

Table S-15 Error code - OFSAAI-1015

Cause

XML is not well-formed.

Resolution

Execute the command dos2unix OFSAAI_InstallConfig.xml to convert
a plain text file from DOS/MAC format to UNIX format.

OR

Make sure that OFSAAT_InstallConfig.xml is valid. Try to open the file
through Internet Explorer for a quick way to check validity. If it is not
getting opened, create new OFSAAI_InstallConfig.xml using the XML_
Utility.jar.

Error code - OFSAAI-1016

Table S-16 Error code - OFSAAI-1016

Cause

The user installation directory contains blank spaces.

Resolution

Provide an installation path that does not contain spaces. Check the tag
USER_INSTALL_DIR in OFSAAI InstallConfig.xml file. This path
should not contain any spaces.

Error code - OFSAAI-1017

Table S-17 Error code - OFSAAI-1017

Cause

The user installation directory is invalid.

Resolution

Provide a valid installation path. Check if you can create the directory
mentioned in the USER_INSTALL_DIR tag value of theOFSAAT_
InstallConfig.xml file.
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